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Contact Us!

Oracle8 Client, Release 8.0.5 for Windows NT

Part No. A64420-01

This document describes how to contact Oracle Corporation if you have issues with 
the documentation or software. 
 

How to Contact Oracle Technical Publications
Oracle Corporation welcomes your comments and suggestions on the quality and 
usefulness of this publication. Your input is an important part of the information 
used for revision.

■ Did you find any errors?

■ Is the information clearly presented?

■ Do you need more information? If so, where?

■ Are the examples correct? Do you need more examples?

■ What features did you like most about this manual?

■ Do you have suggestions for improvement? Please indicate the chapter, section, 
and page number (if available). 

You can send comments regarding documentation to ntdoc@us.oracle.com

Read the section... If You...

How to Contact Oracle Technical Publications Have issues with Documentation

How to Contact Oracle Support Services Have issues with Software

Oracle Web Sites and Resources Want a list of useful Oracle Web sites
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How to Contact Oracle Support Services
Please copy this page and distribute within your organization as necessary.

Oracle Support Services can be reached at the following telephone numbers. The 
hours of business are detailed in your support contract and the Desktop Customer 
Support Guide in your kit.

Please complete the following checklist before you call. If you have this information 
ready, your call can be processed much quicker.

❏ Your CPU Support Identification Number (CSI Number) if applicable.

❏ The hardware name on which your application is running. 

❏ The operating system name and release number on which your application is 
running.

Oracle Support Services In... Call...

United States of America (1) (650) 506-1500 for customers with support contracts

(1) (650) 506-5577 to obtain a support contract

Europe +(44) (1344) 860-160 or the local support center in your country.

All other locations Your local Oracle Sales Office in your country. Oracle Sales 
Offices and telephone numbers are listed in the Desktop 
Customer Support Guide booklet in your kit. They are also 
available at: 
http://www.oracle.com/support/html/suploc.html
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❏ The release numbers of the Oracle Server and associated products involved in 
the current problem. For example, Oracle8 Server release 8.0.5.0.0 and Oracle 
Replication Manager release 1.6.0.0.0.

❏ Are you using 16-bit or 32-bit Oracle software?

❏ The third-party vendor and version you are using.

❏ The exact error codes and messages. Please write these down as they occur. 
They are critical in helping Oracle Support Services to quickly resolve your 
problem.

❏ A description of the issue, including:

■ What happened? For example, the command used and its result.

■ When did it happen? For example, during peak system load, or after a 
certain command, or after an operating system upgrade.
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■ Where did it happen? For example, on a particular system, or within a 
certain procedure or table.

■ What is the extent of the problem? For example, production system 
unavailable, or moderate impact but increasing with time, or minimal 
impact and stable.

❏ Keep copies of any trace files, core dumps, and redo log files recorded at or near 
the time of the incident. Oracle Support Services may need these to further 
investigate your problem.

Oracle Web Sites and Resources
This section lists useful Oracle Web sites and resources.

  

Information Source Description

Oracle Corporation Home Page

http://www.oracle.com

This Web site is the starting point for general information on 
Oracle Corporation.

Oracle Education

http://education.oracle.com/

Customers come to Oracle Education with a variety of 
needs. You may require a complete curriculum based on 
your job role to enable you to implement new technology. Or 
you may seek an understanding of technology related to 
your key area of responsibility to help you meet technical 
challenges. You may be looking for self-paced training that 
can be used as an ongoing resource for reference and 
hands-on practice. Or, you may be interested in an overview 
of a new product upgrade. Whatever your training need, 
Oracle Education has the solution. 

Product Availability

infowin@us.oracle.com

Send an e-mail to request information on future product 
releases on Oracle for Windows NT.
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Oracle Support Services Web Page

http://www.oracle.com/support/

This site is the starting point for all support information. 
From this Web site, you can access information such as free 
installation support, support service descriptions, sales 
office phone numbers, documentation sales, as well as 
current interest items. Also, from this site, you can link to the 
major areas outlined below:

OracleMetaLink

http://support.oracle.com/

This site provides BRONZE, SILVER, and GOLD customers 
with the ability to resolve technical issues by accessing 
repositories of technical support solutions. This service has 
recently been enhanced to enable United States customers to 
track the progress of Technical Assistance Requests (TARs) 
being resolved by Oracle. You can register for MetaLink by 
navigating to:

http://support.oracle.com/ 

and choosing the Registration Page link.

Oracle Global Customer Service

http://support.oracle.com/client_
relations/

This is Oracle’s customer service department, which handles 
issues ranging from locating CPU Support Identification 
(CSI) numbers, and issuing product upgrades and returns, 
to providing product release information and conducting 
proactive customer visits. If you visit this site, you can 
receive answers to frequently asked questions and can 
register for the SupportNotes CD-ROM. 

Oracle SupportInSite 

http://support.oracle.com/insite/

Visit this site when you want a better understanding of 
Oracle Support Services’s resources, or when you want to 
find out how to enhance your experience with the support 
organization. You can find out how to locate information 
such as support bulletins, bug queries, solutions articles, and 
white papers. 

You can also find out about accessing TAR management 
reports and Fax on Demand services. In addition, 
SupportInSite is also available on CD-ROM and can be 
ordered through the Global Customer Service Web site.

Information Source Description
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US Customer Visit Program (CVP) This program was established to help Oracle customers 
understand and obtain maximum benefits from the support 
services they have purchased. The visit program includes 
presentations, demonstrations, helpful tips on working more 
effectively with Oracle Support Services, and a 
comprehensive overview of Oracle’s electronic support 
services. 

Interested customers should contact their Oracle account 
manager or license sales representative and instruct them to 
complete the "customer visit nomination" template in 
Oracle’s internal e-mail system. 

SupportNews

http://www.oracle.com/support/support
news/html/index.html

You can find out all the latest news and information about 
Oracle Support Services’s vast array of products, programs, 
and customer-oriented accomplishments by reading 
SupportNews. SupportNews is not a technical journal. This 
publication is a practical newsletter packed with informative 
articles written by expert Oracle staff and specialists. 
SupportNews is published quarterly and mailed to more 
than 41,000 customers across the United States of America. 
You can view the electronic version of SupportNews on the 
Web.

Virtual Support Analyst (VSA) This is an automated e-mail response system that allows 
access to Oracle Support Services’ databases through any 
e-mail server connected to the Internet. VSA is available to 
all United States Oraclemetals customers and is available 24 
hours a day, 7 days a week, 365 days a year. Once registered 
with your supported CSI Number, VSA enables you to do 
the following: 

■ Create, update, query, and close TARs 

■ Query bugs 

■ Query bulletins 

■ Request TAR Management Reports 

■ Request software updates 

For more information on VSA and instructions on how to 
register, send an e-mail to vsa@us.oracle.com. In the e-mail, 
enter: 

■ help 

■ topic: subscribe 

■ stop 

Information Source Description
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Before You Begin

This guide is your primary source of introductory, post-installation, configuration, 
and administration information for Oracle8 Client. 

Specific topics discussed are:

■ Prerequisites

■ Intended Audience

■ How This Guide Is Organized

■ Documentation and Code Conventions Explained
 xv



Prerequisites
This guide assumes that you are familiar with:

■ Windows NT and have installed and tested it on your personal computer (PC) 
and network hardware

■ Relational database management concepts

Intended Audience
This guide is necessary for anyone configuring or administering Oracle8 Client. 

How This Guide Is Organized
This guide is organized as follows:

Chapter 1, "Getting Started with Your Documentation"
Introduces you to the Oracle documentation set. Read this chapter before 
installing or using Oracle8 Client.

Chapter 2, "Introducing Oracle8 Client"
Describes the basic components of Oracle8 Client.

Chapter 3, "Database Tools Overview"
Provides a list of preferred and optional tools you can use to perform common 
database administration tasks.

Chapter 4, "Oracle Enterprise Manager Overview"
Provides an overview of Oracle Enterprise Manager, Oracle’s suite of products 
for managing Oracle databases over a distributed network.

Note: This guide describes only the features of the Oracle8 Client 
software that apply to the Windows NT, Windows 95, and 
Windows 98 operating systems. For information about Oracle8 
Client that is applicable to all operating systems, see the other 
documentation included in your package, listed in Chapter 1, 
"Getting Started with Your Documentation".
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Chapter 5, "Using Multiple Oracle Homes"
Describes the Oracle Multiple Homes feature of this release.

.Chapter 6, "Post-Installation Configuration Tasks"
Describes the configuration tasks you must perform before using products, such 
as Oracle Enterprise Manager, Net8, and Oracle8 ConText Cartridge.

Chapter 7, "Distributing and Managing Oracle Software"
Describes how to install Oracle8 Client products using Microsoft Systems 
Management Server (SMS).

Chapter 8, "Developing Applications"
Describes Windows NT-specific issues for application developers.

Appendix A, "Directory Structures"
Lists default directory structures for Oracle8 Client components installed on the 
Windows NT, Windows 95, and Windows 98 operating systems.

Appendix C, "Configuration Parameters and the Registry"
Describes the use of the registry for various Oracle8 Client components. 
Additionally, it lists the recommended values and ranges for configuration 
parameters.

Appendix D, "Messages and Codes"
Lists the error messages, causes, and corrective actions specific to installing and 
using Oracle8 Client.

Appendix E, "National Language Support"
Explains the NLS_LANG configuration parameter and its components, and lists 
available options.

Appendix F, "Troubleshooting"
Describes how to diagnose and troubleshoot common error messages.

Glossary
Provides brief descriptions of terms used throughout this guide.
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Documentation and Code Conventions Explained
The following conventions are used in this guide:

Convention Example Meaning

All uppercase plain C:\ORANT\DATABASE Indicates command names, SQL reserved 
words, and keywords, as in ALTER 
DATABASE. All uppercase plain is also 
used for directory names and file names.

Italic ■ Italic is used to indicate a variable:

filename

■ Italic is used for emphasis:

The WHERE clause may be used to 
join rows in different tables.

Indicates a value that you must provide. 
For example, if a command asks you to 
type filename, you must type the actual 
name of the file.

Italic is also used for emphasis in the text 
and to indicate the titles of other guides.

Square brackets [ ] Start > Programs > Oracle for Windows NT 
- [HOME_NAME] > Oracle Database 
Assistant

Encloses optional items. For example, you 
can start Oracle Installer from the default 
Oracle home or from another Oracle 
home indicated by [HOME_NAME] if you 
use multiple Oracle homes. 

Square brackets also indicate a function 
key, for example [Enter].

Choose Start > Choose Start > Programs > Oracle for 
Windows NT > Oracle Installer

How to start a program. For example, to 
start Oracle Installer, you must click the 
Start button on the taskbar and then 
choose Programs, Oracle for Windows 
NT, Oracle Installer. 

C:\> C:\ORANT\DATABASE Represents the Windows NT command 
prompt of the current hard disk drive. 
Your prompt reflects the subdirectory in 
which you are working. Referred to as the 
MS-DOS command prompt in this guide.

Backslash (\) before a 
directory name

\DATABASE Indicates that the directory is a 
subdirectory of the root directory.
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ORACLE_HOME Go to the ORACLE_HOME\DATABASE 
directory

SVRMGR> @%ORACLE_
HOME%\RDBMS80\ADMIN\CATALOG.SQL

ORACLE_HOME is represented as the 
hard drive letter and the top level 
directory where your Oracle software is 
installed, which may be:

■ C:\ORANT for Windows NT
■ C:\ORAWIN95 for Windows 95
■ C:\ORAWIN98 for Windows 98
■ C:\ORAWIN for Windows 3.1
or whatever you may have called your 
Oracle home.

In Server Manager commands, you may 
see %ORACLE_HOME%. Server 
Manager is able to locate your Oracle 
Home directory using the %ORACLE_
HOME% variable. This convention can be 
used in Server Manager, SQL*Plus, Export 
Utility, and Import Utility.

HOME_NAME OracleHOME_NAMETNSListener80 Represents the Oracle home name if you 
use multiple Oracle homes. This 
convention is not applicable for a single 
Oracle home.

The home name can be up to sixteen 
alphanumeric characters. The only special 
character allowed in the home name is the 
underscore. 

HOMEID HOME0, HOME1, HOME2 Represents a unique registry subkey for 
each Oracle home directory in which you 
install products. A new HOMEID is 
created and incremented each time you 
install products to a different Oracle home 
directory on one computer. Each 
HOMEID contains its own configuration 
parameter settings for installed Oracle 
products.

Convention Example Meaning
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Symbols period  .

comma  ,

hyphen  -

semicolon  ;

colon  :

equal sign  =

backslash  \

single quote  ‘

double quote  '

parentheses ()

Symbols other than brackets and vertical 
bars must be entered in commands 
exactly as shown.

Convention Example Meaning
 xx



Getting Started with Your Documen
1

Getting Started with Your Documentation

This chapter introduces you to the Oracle8 Client for Windows NT documentation 
set. Read this chapter before installing or using Oracle8 Client.

Specific topics discussed are:

■ Documentation Formats

■ What Documentation Did I Receive?

■ What Documentation Do I Read First?

■ Starting Oracle Information Navigator

■ Starting Adobe Acrobat Reader
tation 1-1



Documentation Formats
Documentation Formats
This table describes the format and availability of documents in your Oracle8 Client 
kit and the tools required to view them:

 

Document Format Document Availability Document Tools

HyperText Markup 
Language (HTML)

All Oracle documentation 
is available in HTML.

Use Oracle Information Navigator to view your HTML 
documentation set. For information on how to start Oracle 
Information Navigator, see section, "Starting Oracle 
Information Navigator" in this chapter.

Portable Document 
Format (PDF)

All Oracle documentation 
is available in PDF.

Use Adobe Acrobat Reader to view your PDF documentation 
set. For information on how to start Adobe Acrobat Reader, 
see section, "Starting Adobe Acrobat Reader" in this chapter.

Printed Oracle8 Client for Windows 
NT

Oracle8 Client Installation 
for Windows NT

Net8 Getting Started for 
Windows NT and Windows 
95/98

Certain printed guides are also included in your kit. To order 
printed guides, contact Oracle Documentation Sales at the 
following locations:

■ Telephone (1) (800) 252-0303 in the United States of 
America.

■ Visit: 
http://www.oracle.com/documentation/sales/
1-2 Oracle8 Client



What Documentation Did I Receive?
What Documentation Did I Receive?
Your documentation set consists of two types of documentation:
  

 

Documentation Type Describes...

Operating System-specific Installation, configuration, and use of Oracle8 Client products in a 
Windows NT, Windows 95, or Windows 98 environment. Operating 
system-specific documents are occasionally referred to in the generic 
documentation set. These documents are easy to identify because they 
always mention their specific operating system in their title.

Generic Oracle8 Client, Net8 networking information, and Application 
Programming Interfaces information that is uniform across all operating 
system platforms. The vast majority of documents in your 
documentation set belong to this category. While reading through the 
generic documentation set, you are occasionally asked to refer to your 
platform-specific or operating system-specific documentation for 
procedures specific to the Windows NT, Windows 95, or Windows 98 
operating systems.

To easily identify where these generic documentation references are 
described in your operating system documentation, see the index of this 
guide for the following entry:

generic documentation references

All generic documentation references described in this guide appear 
under this index entry.

IMPORTANT: Documentation may be included in your package 
detailing products that you did not buy or license, or whose 
functionality is not included in the current release. The presence 
of such documentation does not mean that these products are 
included in your package or that you are licensed to use them.
Getting Started with Your Documentation 1-3



What Documentation Did I Receive?
Online Documentation Set
Your online Oracle documentation set is divided into the following categories:

■ Installation

■ Oracle8 Database

■ Oracle8 Database

■ SQL*Plus

■ Network

■ Oracle Enterprise Manager

■ Application Development

■ Legato Storage Manager

■ Oracle Web Publishing Assistant

■ Task Page-Find out how to do common Oracle tasks!

Installation
Oracle8 Client Installation for Windows NT 

Oracle8 Database
Oracle8 Client Getting Started (this guide)

Getting to Know Oracle8 and the Oracle8 Enterprise Edition, Release 8.0 

Oracle8 Concepts

Oracle8 Administrator’s Guide 

Oracle8 Backup and Recovery 

Oracle8 Distributed Database Systems 

Oracle8 Migration

Oracle8 Replication 

Oracle Server Manager User’s Guide

Oracle8 Tuning

Oracle8 Utilities

Oracle8 Error Messages
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What Documentation Did I Receive?
Oracle8 Reference

Oracle8 SQL Reference

PL/SQL User’s Guide and Reference

Oracle8 Cartridges
Oracle8 ConText Cartridge QuickStart

Oracle8 ConText Cartridge Administrator's Guide

Oracle8 ConText Cartridge Application Developer's Guide

Oracle8 ConText Cartridge Workbench User’s Guide 

SQL*Plus
SQL*Plus Getting Started for Windows NT and Windows 95/98

SQL*Plus Quick Reference

SQL*Plus User’s Guide and Reference

Network

Net8  

Net8 Getting Started for Windows NT and Windows 95/98

Net8 Administrator’s Guide 

Oracle Cryptographic Toolkit Programmer's Guide

Oracle Security Server Guide 

Oracle Advanced Networking Option Administrator’s Guide 
Getting Started with Your Documentation 1-5



What Documentation Did I Receive?
Oracle7 Networking  

Oracle Network Products Getting Started Release 2.3.4 for Windows Platforms

Oracle Names Administrator’s Guide

Oracle Network Manager Administrator’s Guide

Oracle Network Products Troubleshooting Guide

Understanding SQL*Net    

Oracle Enterprise Manager
Oracle Enterprise Manager Administrator's Guide 

Oracle Enterprise Manager Application Developer’s Guide 

Oracle Enterprise Manager Concepts Guide 

Oracle Enterprise Manager Configuration Guide 

Oracle Enterprise Manager Messages Manual 

Oracle SNMP Support Reference Guide

Application Development
Oracle Call Interface Getting Started for Windows NT and Windows 95/98
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What Documentation Do I Read First?
Task Page-Find out how to do common Oracle tasks!
The Task Page provides easy access to step-by-step instructions on performing 
many Oracle tasks. Tasks are grouped according to job function at the highest 
level, then into sub-categories as appropriate. Find the task you are interested in 
under the appropriate job category. You can access the Task Page from the 
Oracle Information Navigator welcome page. See section, "Starting Oracle 
Information Navigator" for more information.

What Documentation Do I Read First?
This table lists the recommended order in which to start reading through your 
documentation set in order to quickly install and configure Oracle8 Client.      

Read Documents in This Order... For Information On...

1. Customer Support Information Booklet How to obtain Customer Support information. 
This document is also available online at:

http://support.oracle.com/support_
guide/.

2. Oracle8 Client Release Notes Release 8.0.4 for Windows 
NT

Important last minute installation and 
configuration information.

3. Oracle8 Client Installation for Windows NT Installation instructions included in the CD-ROM 
insert.

4. Oracle8 Client Getting Started for Windows NT Post-installation, database migration, database 
upgrade, and configuration information for 
Oracle products.

5. Net8 Getting Started for Windows NT and Windows 
95/98

Oracle8 Enterprise Edition client/server 
networking environment, basic database network 
concepts, network protocols, and Oracle Protocol 
Adapters.

6. Oracle8 Concepts Basic database concepts.

7. Oracle8 Administrator’s Guide Basic database administration.

8. Oracle Enterprise Manager Concepts Guide Instructions on using Oracle Enterprise Manager.

9. The remaining documentation in an order 
appropriate to your needs.
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Starting Oracle Information Navigator
   Starting Oracle Information Navigator

Use Oracle Information Navigator to view your HTML documentation set. Oracle 
Information Navigator enables you to search your entire documentation set for 
information on specific topics.

To start Oracle Information Navigator:

1. Install Oracle Documentation from the CD-ROM.

Oracle Information Navigator is automatically installed along with your Oracle 
Documentation.

2. Use one of the following Java-enabled browsers: 

■ Netscape Navigator Version 3.0 or later

Visit http://www.netscape.com

■ Microsoft Internet Explorer Version 3.0 or later

Read Documents in This Order... For Information On...

1. Customer Support Information Booklet How to obtain Customer Support information. 
This document is also available online at 
http://support.oracle.com/support_
guide/.

2. Oracle8 Client Release Notes Release 8.0.4 for Windows 
NT

Important last minute installation and 
configuration information.

3. Oracle8 Client Installation for Windows NT Installation instructions included in the CD-ROM 
insert.

4. Oracle8 Client Getting Started for Windows NT (this 
guide)

Post-installation, database migration, database 
upgrade, and configuration information for Oracle 
products.

5. Net8 Getting Started for Windows NT and Windows 95/98 Oracle8 Enterprise Edition client/server 
networking environment, basic database network 
concepts, network protocols, and Oracle Protocol 
Adapters.

6. Oracle8 Concepts Basic database concepts.

7. Oracle8 Administrator’s Guide Basic database administration.

8. Oracle Enterprise Manager Concepts Guide Instructions on using Oracle Enterprise Manager.

9. The remaining documentation in an order appropriate 
to your needs.
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Starting Oracle Information Navigator
Visit http://www.microsoft.com

Oracle Information Navigator can only work with a Java-enabled browser. If 
you do not use these browsers, you cannot view documentation from the 
WELCOME.HTM page that is accessed when you choose Start > Programs > 
Oracle for Windows NT - [HOME_NAME] > Oracle Documentation.

You can still view online documentation by going to \DOC\INDEX.HTM 
located at the top of your CD-ROM, or to ORACLE_HOME\DOC\INDEX.HTM 
if you installed the documentation onto your computer.

3. Choose Start > Programs > Oracle for Windows NT - [HOME_NAME] > Oracle8 
Documentation.

Your Web browser is automatically started, and a welcome page appears.

Oracle Information Navigator appears.

4. Click the icon to access help for instructions on using Oracle Information 
Navigator.  
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Starting Adobe Acrobat Reader
Starting Adobe Acrobat Reader
Use Adobe Acrobat Reader to view and print your PDF documentation set. 

To start Adobe Acrobat Reader:

1. Insert the Oracle8 Client CD-ROM into the mapped CD-ROM drive.

The operating system automatically detects the CD-ROM. The Oracle8 Client 
Autorun dialog box appears and prompts you to make a selection:

■ Begin Installation

■ Browse Information

■ Explore CD

2. Click Explore CD.

3. Go to the \ACROREAD directory. 

4. Double-click on Ar32e30 to install the free Adobe Acrobat Reader.

A wizard helps you quickly install Adobe Acrobat Reader.

5. Choose Start > Programs > Adobe Acrobat Reader 3.0 after installation is 
complete to start Adobe Acrobat Reader.

6. Choose Open from the File Menu and navigate to the \PDFDOC directory on 
the CD-ROM to read the PDF documents.

Notes: Some notes on using Oracle Information Navigator:

■ The Java components of Oracle Information Navigator do not 
work on Windows 3.1. You can still access the Oracle online 
documentation, however, you will not be able to use the Oracle 
Information Navigator. To use the Oracle Information 
Navigator, use a 32-bit Microsoft operating system such as 
Windows NT, Windows 95, or Windows 98.

■ Changes to Microsoft’s Internet Explorer release 3.02 to address 
security issues may prevent Oracle Information Navigator from 
starting and displaying properly. This does not affect your 
access to Oracle online documentation.
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7. Read PDF directly from the CD-ROM, or copy the files to your hard disk. 

Notes: Some notes on using Adobe Acrobat Reader:

■ After several documents are opened in Adobe Acrobat Reader, 
you may receive an error message when trying to open an 
additional document, stating that the document does not exist. 
This error occurs because memory is low. To solve the problem, 
close open documents that you are not using, and continue.

■ You must use Adobe Acrobat Reader Version 3.0 to view the 
PDF documentation set.
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Introducing Oracle8 Client

This chapter introduces you to Oracle8 Client.

Specific topics discussed are:

■ New Products and Features in This Release

■ What Products are on the CD-ROM?
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New Products and Features in This Release
 Overview
Oracle8 Client software operates on a personal computer (PC), running on the 
following Microsoft operating systems:

■ Windows NT Workstation 4.0

■ Windows NT Server 4.0

■ Windows NT Server, Enterprise Edition

■ Windows 95

■ Windows 98

New Products and Features in This Release
This section describes the new products and features of Oracle8 Clientrelease 8.0.5 
specific to Windows NT. The following are new to this release:

■ New Names for Upgrading and Downgrading Scripts

■ Upgrading and downgrading scripts are no longer of the form CAT*.SQL. The 
new names are of the form U*.SQL for upgrading and D*.SQL for 
downgrading. The new naming conventions enable direct migration paths from 
one release to another without having to go through multiple upgrade paths in 
case there are releases in between yours and the one to which you are 
upgrading or downgrading.

See Getting to Know Oracle8 and the Oracle8 Enterprise Edition, Release 8.0 for the list of 
newOracle8 Client products and features common to all operating systems.

New Names for Upgrading and Downgrading Scripts
Upgrading and downgrading scripts are no longer of the form CAT*.SQL. The new 
names are of the form U*.SQL for upgrading and D*.SQL for downgrading. The 
new naming conventions enable direct migration paths from one release to another 
without having to go through multiple upgrade paths in case there are releases in 
between yours and the one to which you are upgrading or downgrading.

Task Page
The Task Page provides easy access to step-by-step instructions on performing 
many Oracle tasks. Tasks are grouped according to job function at the highest level, 
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What Products are on the CD-ROM?
then into sub-categories as appropriate. Find the task you are interested in under 
the appropriate job category. You can access the Task Page from the Oracle 
Information Navigator welcome page. See section, "Starting Oracle Information 
Navigator" in Chapter 1, "Getting Started with Your Documentation" for more 
information.

What Products are on the CD-ROM?
Although the Oracle8 Client for Windows NT CD-ROM in your kit contains many 
Oracle products, you may install and use only those products for which you have 
purchased licenses. For additional licensing information, refer to the Global License 
Terms booklet in your kit. Oracle Support Services does not provide support for 
products where licenses have not been purchased. 
 

When you run Oracle Installer, a dialog box displays several product installation 
options. If you choose Oracle8 Client, a group of products are automatically 
installed. If you choose Custom Installation, you can selectively install products. 
Available options depend upon the operating system you are using:
      

IMPORTANT: If you purchased Oracle Web Application Server, 
install the Oracle Web Application Server CD-ROM first. 

If you attempt to install the Oracle Web Application Server 
CD-ROM after installing Oracle8 Client, dialog boxes appear 
requesting if you want to downgrade the software components. 
Select No to those messages. 

If You Are Using... You Will See These Installation Options

Windows NT Oracle8 Client

Database Administrator

Application User

Custom Installation

Windows 95

Windows 98

Oracle8 Client

Database Administrator

Application User

Custom Installation
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Oracle Products for Windows 3.1x
Oracle products for Windows 3.1x are provided for backward compatibility with 
Oracle7. Note that there are no Oracle8 components available on Windows 3.1x. 
When you run Oracle Installer, a dialog box displays several product installation 
options. If you choose Oracle7 Application User, a group of products is automatically 
installed. If you choose Custom Installation you can selectively install products.    

Oracle Products for Windows NT, Windows 95 and Windows 98
The products in the following table are listed according to the installation option, of 
which they are a part, for each operating system (OS).

  

Operating System Installation Option

Windows 3.1x Oracle7 Application User

Custom Installation

Oracle8 Client for Windows NT, Windows 95 and Windows 
98

Installation Options Available on Each OS

Oracle8 Client on 
Windows NT and 
Windows 95/98

Custom Installation 
on Windows NT and 
Windows 95/98

Oracle Installer 3.3

A graphical user interface (GUI) application that lets you 
quickly install, update, and remove Oracle products.

Yes Yes

Oracle Online Documentation 8.0

Available in HTML, viewable using a web browser. PDF is 
also available but is not installable with any installation 
option. You can find the PDF documentation on the CD-ROM 
disc in the \PDFDOC directory. The Adobe Acrobat Reader is 
located in the \ACROREAD directory.

Yes Yes

Required Support Files 8.0

Required Support Files release 8.0 can be installed from each 
installation option. 

Yes Yes
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Required Support Files 7.3.4

Required Support Files release 7.3 are supplied for third party 
applications linked with them.

No Yes

JDK 1.0 JDBC Thin Driver 8.0

JDK 1.1 JDBC Thin Driver 8.0

Appropriate for use by Java applets that can be downloaded 
in a web browser. The JDBC Thin Client Driver provides a 
direct connection from the web browser to the database by 
emulating SQL*Net and TTC (the wire protocol used by 
Oracle Call Interface [OCI]) on top of Java sockets. This driver 
works for Oracle7 version 7.2 and later.

No Yes

JDK 1.0 JDBC OCI Driver 8.0

JDK 1.0 JDBC OCI Driver 8.0

The OCI based drivers are used by Java applications. The OCI 
JDBC Drivers call OCI directly from Java to connect to the 
database.

No Yes

Java Runtime Environment 1.1

A set of files distributed by Sun that allows Java applications 
to run. It is required by many of the Oracle Assistants.

Yes Yes

Assistant Common Files 8.0

Files for Oracle Java products.

Yes Yes

Oracle Web Publishing Assistant 8.0

Enables you to query the database and publish the data 
retrieved to a web page at specified time intervals.

Yes

NT only

Yes

NT only

Oracle INTYPE File Assistant 8.0

Provides an easy and intuitive GUI to generate input files 
necessary for the OTT. This wizard is used in conjunction with 
Oracle development environments to build rapid 
object-oriented applications.

Yes Yes

Oracle Net8 Assistant 8.0

Provides fast and simple configuration of Net8 products.

Yes Yes

Oracle8 Client for Windows NT, Windows 95 and Windows 
98

Installation Options Available on Each OS

Oracle8 Client on 
Windows NT and 
Windows 95/98

Custom Installation 
on Windows NT and 
Windows 95/98
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Oracle8 Utilities 8.0

A suite of products used for database administration. Oracle8 
Utilities include ORADIM80, Server Manager, Export Utility, 
Import Utility, SQL*Loader, DBVERIFY, NT Backup Manager, 
NT Recovery Manager, TKPROF, Migration Utility, OCOPY80, 
and the Password Utility. 

Yes Yes

Oracle7 Utilities 7.3

A suite of products used for database administration. Oracle7 
Utilities include NT Instance Manager, ORADIM73, Server 
Manager, Export Utility, Import Utility, SQL*Loader, 
DBVERIFY, NT Backup Manager, NT Recovery Manager, 
TKPROF, Enterprise Backup Manager, OCOPY80, and the 
Password Utility. 

No Yes

Oracle8 ConText Cartridge Workbench 2.4

A suite of products used in conjunction with Oracle8 ConText 
Cartridge to enhance viewing, storage, and manipulation of 
text data. If you select Oracle8 ConText Cartridge Workbench, 
the following components are installed.

No Yes

Oracle8 ConText Cartridge System Administration 2.4

A GUI application that can be used to perform system 
and text administration tasks.

No Yes

Oracle8 ConText Cartridge Viewer 2.4

A document viewer supplied as a custom control (OCX), 
which can be embedded in any application developed in 
an environment, such as Visual Basic and Visual C++, that 
supports custom controls.

No Yes

Oracle8 ConText Cartridge Viewer Cartridge 2.4

A Java web server cartridge that packages data for 
viewing using the web browser plugin, and provides 
generic facilities for downloading large data types from 
the database to a web browser.

No Yes

Oracle8 ConText Cartridge I/O Utility 2.4

A stand-alone executable that can be used to load text to a 
database column, load text from a column into a file, 
execute SQL and PL/SQL code, and call other executables 
from the MS-DOS command prompt.

No Yes

Oracle8 Client for Windows NT, Windows 95 and Windows 
98

Installation Options Available on Each OS

Oracle8 Client on 
Windows NT and 
Windows 95/98

Custom Installation 
on Windows NT and 
Windows 95/98
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Oracle8 ConText Configuration Manager 2.4

A web application for administering Oracle8 ConText 
Cartridge and managing the text objects in the Oracle8 
ConText Cartridge data dictionary on non-Windows 
platforms, including network computers (NCs).

No Yes

TextServer3 Migration Tool

This is not an installable product. The TextServer3 
Migration Tool is a PL/SQL package that must be created 
after Oracle ConText Cartridge and the Oracle ConText 
Cartridge Workbench (as well as SQL*Net and SQL*Plus) 
have been installed. See Oracle8 ConText Cartridge 
Workbench User’s Guide for details on how to install and 
use the Migration Tool.

No No

Oracle8 ConText Cartridge Demos 2.3

A sample application illustrating the text querying and 
retrieval capabilities of Oracle8 ConText Cartridge and 
Oracle8 Enterprise Edition. 

No Yes

Oracle8 Open Database Connectivity Driver (ODBC) Driver 
8.0

Provides support for ODBC connections from Windows NT, 
Windows 95, and Windows 98 client systems to Oracle8 
databases. The Oracle8 ODBC Driver complies with 
version 3.00 of the Microsoft ODBC specification and 
supports all ODBC Core and the following Level 1 and Level 2 
calls:

■ SQLBrowseConnect

■ SQLColumnPrivileges

■ SQLDescribeParam

■ SQLForeignKeys

■ SQLMoreResults 

■ SQLPrimaryKeys 

■ SQLProcedureColumns

■ SQLProcedures 

■ SQLTablePrivileges

Yes Yes

Oracle8 Client for Windows NT, Windows 95 and Windows 
98

Installation Options Available on Each OS

Oracle8 Client on 
Windows NT and 
Windows 95/98

Custom Installation 
on Windows NT and 
Windows 95/98
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Oracle Call Interface 8.0

An application programming interface (API) for accessing an 
Oracle database from a C or C++ program. You make calls 
directly to the OCI functions from within your C or C++ 
program to direct the execution of your SQL statements.

Yes Yes

Oracle Objects for Object Linking and Embedding (OLE) 2.3

Provides a custom control (OCX or ActiveX) combined with 
an OLE in-process server that lets you plug native Oracle8 
Enterprise Edition functionality into your Windows 
applications.

Yes Yes

SQL*Plus 3.3

Enables you to use the SQL and PL/SQL database languages 
in the Windows NT, Windows 95, and Windows 3.1 
environments. SQL*Plus has both a command line and 
graphical user interface.

Yes Yes

Oracle WebServer Manager 1.0

Performs the most common web administrative tasks through 
web pages. Web administrative tasks include creating, 
modifying, deleting, Database Connection Descriptors 
(DCDs).

No Yes

Oracle Security Server Manager 2.0

Provides complete management of subjects, certificates, 
attributes, and applications.

No Yes

Oracle Enterprise Manager 1.6

Combines a graphical console, agent processes, and common 
services to provide an integrated, comprehensive systems 
management platform for managing distributed databases 
and networks.

Yes Yes

Oracle Administrator Toolbar 1.6

Enables you to execute commands and run applications in 
Oracle Enterprise Manager.

Yes Yes

Oracle8 Client for Windows NT, Windows 95 and Windows 
98

Installation Options Available on Each OS

Oracle8 Client on 
Windows NT and 
Windows 95/98

Custom Installation 
on Windows NT and 
Windows 95/98
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Oracle Enterprise Manager Software Development Kit 
(SDK) 1.6

Provides sample source files, libraries, and header files for 
integrating new applications into the Oracle Enterprise 
Manager Console.

Yes Yes

Oracle Enterprise Manager DB Admin Applications 1.6

Installed as part of Oracle Enterprise Manager.

No No

Oracle Replication Manager 1.6

Simplifies the complex tasks of managing and maintaining 
multiple copies of data in a distributed environment. The 
application provides immediate local access to data and 
allows local systems to function automatically, even when 
networks or other systems in the environment fail.

Yes Yes

NT only

Oracle Object Type Translator (OTT) 8.0

OTT (executable name OTT80.EXE) is used to create C-struct 
representations of Abstract Data Types that have been created 
and stored in an Oracle8 database. To take advantage of 
objects, run OTT against the database, and a header file is 
generated that includes the C-structs.

Yes No

Oracle INTYPE File Assistant 8.0

Only installed if OTT is installed. This assistant is used in 
conjunction with Oracle development environments to 
build rapid object-oriented applications.

Yes No

Oracle Net8 Easy Config 8.0

Used to configure simple network configurations.

Yes Yes

Net8 Products 8.0

Net8 establishes and maintains a connection between the 
client application and the server and exchanges messages 
between them. Net8 is a software layer that is required to 
communicate between Oracle clients and servers. It provides 
both client-server and server/server communications across 
any network. It enables client tools to access, modify, share, 
and store data on Oracle8 Enterprise Edition servers over a 
network. See Net8 Getting Started for Windows NT and Windows 
95/98 for detailed information on each Net8 product.

Yes Yes

Oracle8 Client for Windows NT, Windows 95 and Windows 
98

Installation Options Available on Each OS

Oracle8 Client on 
Windows NT and 
Windows 95/98

Custom Installation 
on Windows NT and 
Windows 95/98
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Net8 Client 8.0

Net8 client software.

Yes Yes

Oracle Net8 Protocol Adapters 8.0

Oracle Net8 Protocol Adapters are responsible for mapping 
Transparent Network Substrate (TNS) functionality to 
industry-standard protocols used in the client/server 
connection. Each protocol adapter is responsible for mapping 
the equivalent functions between TNS and a specific protocol. 
See Net8 Getting Started for Windows NT and Windows 95/98 for 
detailed information on each protocol adapter.

Yes Yes

Oracle TCP/IP Protocol Adapter 8.0

Enables client/server conversation over a network using 
TCP/IP and SQL*Net. This combination of Oracle 
products enables an Oracle application on a client to 
communicate with remote Oracle databases through 
TCP/IP (if the Oracle database is running on a host 
system that supports network communication using 
TCP/IP).

Yes Yes

Oracle SPX Protocol Adapter 8.0

Enables client/server conversation over a network using 
SPX/IPX and SQL*Net. This combination of Oracle 
products enables an Oracle application on a client to 
communicate with remote Oracle databases through 
SPX/IPX (if the Oracle database is running on a host 
system that supports network communication using 
SPX/IPX).

Yes Yes

Oracle Named Pipes Protocol Adapter 8.0

Enables client/server conversation over a network using 
Named Pipes and SQL*Net. This combination of Oracle 
products enables an Oracle application on a client to 
communicate with remote Oracle databases through 
Named Pipes (if the Oracle database is running on a host 
system that supports network communication using 
Named Pipes).

Yes Yes

Oracle8 Client for Windows NT, Windows 95 and Windows 
98

Installation Options Available on Each OS

Oracle8 Client on 
Windows NT and 
Windows 95/98

Custom Installation 
on Windows NT and 
Windows 95/98
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Oracle LU6.2 Protocol Adapter 8.0

IBM’s Advanced Program-to-Program Communication 
(APPC) architecture. APPC is the IBM peer-to-peer 
(program-to-program) protocol for a System Network 
Architecture (SNA) network. SNA is an IBM reference 
model similar to the Open Systems Interconnect (OSI) 
model of the International Standards Organization (ISO).

Yes

NT only

Yes

NT only

SQL*Net Products 2.3

A software layer that is required to communicate between 
Oracle clients and servers. It provides both client-server and 
server/server communications across any network. It enables 
client tools to access, modify, share, and store data on Oracle8 
Enterprise Edition servers over a network. See Net8 Getting 
Started for Windows NT and Windows 95/98 for detailed 
information on each SQL*Net product.

No Yes

SQL*Net Client 2.3

SQL*Net client software.

No Yes

Oracle Protocol Adapters 2.3

Oracle Protocol Adapters are responsible for mapping 
Transparent Network Substrate (TNS) functionality to 
industry-standard protocols used in the client/server 
connection. Each protocol adapter is responsible for mapping 
the equivalent functions between TNS and a specific protocol. 
See Net8 Getting Started for Windows NT and Windows 95/98 for 
detailed information on each protocol adapter.

No Yes

Oracle TCP/IP Protocol Adapter 2.3

Enables client/server conversation over a network using 
TCP/IP and SQL*Net. This combination of Oracle 
products enables an Oracle application on a client to 
communicate with remote Oracle databases through 
TCP/IP (if the Oracle database is running on a host 
system that supports network communication using 
TCP/IP).

No Yes

Oracle8 Client for Windows NT, Windows 95 and Windows 
98

Installation Options Available on Each OS

Oracle8 Client on 
Windows NT and 
Windows 95/98

Custom Installation 
on Windows NT and 
Windows 95/98
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Oracle SPX Protocol Adapter 2.3

Enables client/server conversation over a network using 
SPX/IPX and SQL*Net. This combination of Oracle 
products enables an Oracle application on a client to 
communicate with remote Oracle databases through 
SPX/IPX (if the Oracle database is running on a host 
system that supports network communication using 
SPX/IPX).

No Yes

Oracle Named Pipes Protocol Adapter 2.3

Enables client/server conversation over a network using 
Named Pipes and SQL*Net. This combination of Oracle 
products enables an Oracle application on a client to 
communicate with remote Oracle databases through 
Named Pipes (if the Oracle database is running on a host 
system that supports network communication using 
Named Pipes).

No Yes

Oracle LU6.2 Protocol Adapter 2.3

IBM’s Advanced Program-to-Program Communication 
(APPC) architecture. APPC is the IBM peer-to-peer 
(program-to-program) protocol for a System Network 
Architecture (SNA) network. SNA is an IBM reference 
model similar to the Open Systems Interconnect (OSI) 
model of the International Standards Organization (ISO).

Yes

 NT only

Yes

NT only

Oracle8 Client for Windows NT, Windows 95 and Windows 
98

Installation Options Available on Each OS

Oracle8 Client on 
Windows NT and 
Windows 95/98

Custom Installation 
on Windows NT and 
Windows 95/98
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Database Tools Overview

Oracle8 Client for Windows NT includes various tools to perform database 
functions. This chapter describes the preferred tools to perform common database 
administration tasks.

Specific topics discussed are:

■ Choosing a Database Tool

■ Starting Database Tools

■ Using SQL*Loader

■ Using Windows NT Tools
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Choosing a Database Tool
Database tools is a collective term for tools, utilities, and assistants that you can use 
to perform database administration tasks. Some database tools perform similar 
tasks, though no one database tool performs all database administration tasks. The 
following sections indicate which database tools can be used on particular 
operating systems and the preferred tools to use for common database 
administration tasks.

Database Tools and Operating System Compatibility
This table lists database tools and the operating system(s) on which each can be 
used: 
 

Database Tools Windows NT Windows 95 and Windows 98

Oracle8 Utilities

Server Manager (SVRMGR30)1 Yes Yes

Export (EXP80) Yes Yes

Import (IMP80) Yes Yes

SQL*Loader (SQLLDR80) Yes Yes

Recovery Manager (RMAN80) Yes Yes

Password Utility (ORAPWD80)2 No No

TKPROF (TKPROF80) Yes Yes
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Preferred Database Tools
This table lists the various database tools you can use to perform common database 
administration tasks. Oracle Corporation recommends you use the tools listed in 
the "Preferred Database Tools" column of the table. After choosing a tool to perform 

Windows NT Tools

User Manager Yes No

Control Panel Yes No

Event Viewer Yes No

Performance Monitor Yes No

Oracle Enterprise Manager

Backup Manager Yes Yes

Data Manager Yes Yes

Instance Manager Yes Yes

Oracle Software Manager Yes Yes

Schema Manager Yes Yes

Security Manager Yes Yes

SQL Worksheet Yes Yes

Storage Manager Yes Yes

Oracle Assistants (wizards)

Oracle Net8 Assistant Yes Yes

Oracle Net8 Easy Config Yes Yes

SQL*Plus Yes Yes
1 The ORADEBUG utility can be used through Server Manager. 
2 ORAPWD80 does not work on password files for remote databases.

Database Tools Windows NT Windows 95 and Windows 98
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a task, go to the section, "Starting Database Tools" in this chapter for instructions on 
how to start the tool.
   

Database Administration Task Preferred Database Tool Other Database Tools

Create a database Oracle Database Assistant ■ ORADIM80 and Server Manager 
(SVRMGR30) together

■ SQL Worksheet

Delete a database Oracle Database Assistant ORADIM80 and Server Manager (SVRMGR30) 
together

Delete a database service Oracle Database Assistant ORADIM80

Start a database Instance Manager1 ■ ORADIM80 and Server Manager 
(SVRMGR30) together

■ SQL Worksheet

Shut down a database Instance Manager ■ ORADIM80 and Server Manager 
(SVRMGR30) together

■ Control Panel

■ SQL Worksheet

Migrate a database Oracle Data Migration Assistant Migration Utility (MIG80)

Upgrade a database Run provided scripts in Server 
Manager

Oracle Data Migration Assistant2

Export data Data Manager Export Utility (EXP80)

Import data Data Manager Import Utility (IMP80)

Load data Data Manager SQL*Loader (SQLLDR80)

Back up database Backup Manager3 ■ Recovery Manager (RMAN80)

■ NT Backup Manager

■ OCOPY80

Recover database Backup Manager ■ Recovery Manager (RMAN80)

■ NT Recovery Manager

■ OCOPY80

Authenticate Database Administrators 
and users

Security Manager ■ Server Manager (SVRMGR30)

■ SQL*Plus

■ Windows NT operating system

■ SQL Worksheet

Grant database roles Security Manager User Manager

Create database objects4 Schema Manager ■ Server Manager

■ SQL*Plus
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1 Instance Manager can start up and shut down a database and perform other limited functions. This tool cannot be used to 
create databases services, or create and delete databases.

2 Oracle Data Migration Assistant can only be used to upgrade release 8.0.x databases to release 8.0.5. It cannot be used to 
upgrade an earlier Oracle7 database release to a later Oracle7 database release. See your Oracle7 for Windows NT 
documentation for information on how to upgrade from one Oracle7 database to another.

3 Do not back up files while you are shutting down the database, otherwise your backup will be invalid. You cannot use an 
invalid backup to restore files at a later date.

4 See Oracle8 Administrator’s Guide for guidelines on creating databases objects. In particular, see Appendix A, "Space 
Estimations for Schema Objects" which provides equations for estimating the space requirements for clusters, nonclustered 
tables, and indexes. Windows NT uses the same fixed header, transaction header, and row header constants described in that 
guide. 
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Starting Database Tools
This section describes how to start each of the database tools in the following 
categories:

■ Starting Database Tools in Multiple Oracle Homes

■ Starting Oracle8 Utilities

■ Starting Windows NT Tools

■ Starting Oracle Enterprise Manager

■ Starting Oracle Assistants

■ Starting SQL*Plus

You will be referred back to this section for database tool startup procedures as you 
use this guide.

Starting Database Tools in Multiple Oracle Homes
If you are using multiple Oracle homes functionality, the command to start a tool 
includes [HOME_NAME] where [HOME_NAME] indicates the name of a different 
Oracle home. For example:

Start > Programs > Oracle for Windows NT - [HOME_NAME] > Oracle Database 
Assistant

If you want to start Oracle Database Assistant from an Oracle home called PROD, 
choose Start > Programs > Oracle for Windows NT - PROD > Oracle Database 
Assistant.
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Taskbar pathname for first 
Oracle8 database 
installation. No home name 
is required and none 
appears in the pathname. 

Taskbar pathname for 
second Oracle8 database 
installation. The home 
name of PROD appears in 
the pathname. 
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Starting Oracle8 Utilities
This table describes how to start each Oracle8 Utility, and where to go for further 
information on using these products: 
   

Oracle8 Utilities To Start... For More Information, See...

Export Utility 
(EXP80)

Enter the following at the MS-DOS command prompt 
followed by your user name and password:

C:\> EXP80

EXP80 starts and prompts you for parameters. To 
obtain a list of these parameters, enter the following 
at the MS-DOS command prompt:

C:\> EXP80 HELP=Y

Note: When running the Export utility, the default 
values for the following parameters under Windows 
NT are:

BUFFER 4 KB

RECORDLENGTH 2 KB

Note: To export an entire database, you must use the 
user name SYSTEM. Do not use INTERNAL or SYS.

■ Oracle8 Utilities, which 
describes how to use the Export 
utility

■ Oracle8 Error Messages for 
information on error messages

Import Utility 
(IMP80)

Enter the following at the MS-DOS command prompt 
followed by your user name and password:

C:\> IMP80

IMP80 starts and prompts you for parameters. To 
obtain a list of these parameters, enter the following 
at the MS-DOS command prompt:

C:\> IMP80 HELP=Y

Note: When running the Import utility, the default 
values for the following parameters under Windows 
NT are:

BUFFER 4 KB

RECORDLENGTH 2 KB

■ Oracle8 Utilities, which 
describes how to use the 
Import utility

■ Oracle8 Error Messages for 
information on error messages

Server Manager 
(SVRMGR30)

Enter the following at the MS-DOS command prompt:

C:\> SVRMGR30

Note: Server Manager is available only as a command 
line tool.

■ Oracle Server Manager User’s 
Guide

■ Chapter 7, "Administering a 
Database", for examples of 
starting and stopping the 
database with Server Manager
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Starting Windows NT Tools
This table describes how to start each Windows NT tool, and where to go for more 
information on using these products: 

 

SQL*Loader 
(SQLLDR80)

Invoke SQL*Loader at the MS-DOS command prompt 
followed by certain keywords. Enter the following 
and SQL*Loader displays a Help screen with the 
available keywords and default values:

C:\> SQLLDR80

■ Oracle8 Utilities, which 
describes how to use the 
SQL*Loader utility

■ Oracle8 Error Messages for 
information on error messages

■ section, "Using SQL*Loader" in 
this chapter

TKPROF 
(TKPROF80)

Enter the following at the MS-DOS command prompt:

C:\> TKPROF80

Oracle8 Tuning

Windows NT 
Tools

To Start... For More Information, See...

Control Panel Choose Start > Settings > Control Panel ■ section, "Control Panel" in 
this chapter

■ Chapter 7, "Administering a 
Database"

■ Your Microsoft Windows NT 
documentation

Event Viewer Choose Start > Programs > Administrative Tools > Event 
Viewer

■ section, "Event Viewer" in 
this chapter

■ Chapter 9, "Monitoring a 
Database"

■ Your Microsoft Windows NT 
documentation

Performance 
Monitor

Choose Start > Programs > Administrative Tools > 
Performance Monitor

■ section, "Performance 
Monitor" in this chapter

■ Your Microsoft Windows NT 
documentation

Oracle8 Utilities To Start... For More Information, See...
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Starting Oracle Enterprise Manager
You can start Oracle Enterprise Manager tools:

■ as separate applications

■ from the Oracle Enterprise Manager Console

To start an Oracle Enterprise Manager tool separately:

1. Choose Start > Programs > Oracle Enterprise Manager > tool. 

For example, Start > Programs > Oracle Enterprise Manager > Instance 
Manager.

The Login Information dialog box appears.

2. Enter the connect information in the Login Information dialog box. 
    

Registry ■ Enter the following at the MS-DOS command 
prompt:

C:\> REGEDT32

The registry editor window appears.

■ Enter the following at the MS-DOS command 
prompt:

C:\> REGEDIT

The registry editor window appears.

■ section, "Registry" in this 
chapter

■ Appendix C, "Configuration 
Parameters and the 
Registry"

■ Your Microsoft Windows NT 
documentation

User Manager Choose Start > Programs > Administrative Tools > User 
Manager

■ section, "User Manager" in 
this chapter.

■ Chapter 8, "Authenticating 
Database Users with 
Windows NT"

■ Your Microsoft Windows NT 
documentation

Additional Information: See section, "Oracle Enterprise Manager" 
in Chapter 6, "Post-Installation Configuration Tasks" for 
information on configuration tasks you must perform before using 
Oracle Enterprise Manager and information on how to connect to 
an Oracle8 database.

Windows NT 
Tools

To Start... For More Information, See...
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To start an Oracle Enterprise Manager tool from the Console:

1. Choose Start > Programs > Oracle Enterprise Manager > Oracle Enterprise 
Manager.

The Login Information dialog box appears.

2. Log on when prompted.

3. You can now either:

■ Select the database you want to administer in the Navigator tree or in the 
Map window, then choose the tool from the Console Tools menu or in the 
Launch Palette.

■ Select the database you want to administer in the Navigator tree, then 
choose the tool from the Related Tools menu of the context-sensitive menu.

■ Choose the application from the Console Tools menu or from the Launch 
Palette, then enter the connect information in the Login Information dialog 
box.

  

Note: When you select a database before starting a tool, you are 
connected to the database according to the preferred credentials 
that have been set up for the database or the credentials you used to 
log on to the Console. If connection to the database fails for any 
reason, the Login Information dialog box appears.
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This table describes how to start each Oracle Enterprise Manager tool through the 
Console, and where to go for further information on using these tools. 

Oracle Enterprise 
Manager Tool

Choose Tools > Applications > For More Information, See...

Backup Manager Oracle Backup Manager Oracle Enterprise Manager 
Administrator’s Guide

Data Manager Oracle Data Manager Oracle Enterprise Manager 
Administrator’s Guide

Instance Manager Oracle Instance Manager Oracle Enterprise Manager 
Administrator’s Guide

Oracle Net8 
Assistant

Oracle Net8 Assistant Net8 Administrator’s Guide and

Net8 Getting Started for Windows 
NT and Windows 95/98

Oracle Software 
Manager

Oracle Software Manager Oracle Enterprise Manager 
Administrator’s Guide

Replication 
Manager

Oracle Replication Manager Oracle Enterprise Manager 
Administrator’s Guide

 Storage Manager Oracle Storage Manager Oracle Enterprise Manager 
Administrator’s Guide

Schema Manager Oracle Schema Manager Oracle Enterprise Manager 
Administrator’s Guide

Security Manager Oracle Security Manager Oracle Enterprise Manager 
Administrator’s Guide

SQL Worksheet Oracle SQL Worksheet

The new worksheet is connected to the database you 
have selected in the Navigator tree list or in the map 
window.

Oracle Enterprise Manager 
Administrator’s Guide
3-12 Oracle8 Client



Starting Database Tools
Starting Oracle Assistants
This table describes how to start each assistant, and where to go for further 
information on using these products:

   

Starting Oracle8 Performance Monitor
This table describes how to start Oracle8 Performance Monitor, and where to go for 
further information on using this product:

 

Assistant Choose Start > Programs > Oracle for Windows NT -  
[HOME_NAME] >

For More Information, See...

Oracle Net8 
Assistant

Oracle Net8 Assistant ■ Net8 Getting Started for 
Windows NT and Windows 
95/98

■ Net8 Administrator’s Guide

Oracle Net8 Easy 
Config

Oracle Net8 Easy Config ■ Net8 Getting Started for 
Windows NT and Windows 
95/98

■ Net8 Administrator’s Guide

Oracle8 
Performance 
Monitor

Choose Start > Programs > Oracle for Windows NT - 
[HOME_NAME] > Oracle8 Performance Monitor

section, "Using Oracle8 Performance 
Monitor" in Chapter 9, "Monitoring 
a Database"
Database Tools Overview 3-13



Starting Database Tools
Starting SQL*Plus
This table describes how to start SQL*Plus, and where to go for further information 
on using this product:

SQL*Plus To Start... For More Information, See...

Enter either of the following at the MS-DOS 
command prompt:

C:\> SQLPLUS

Starts the line mode version of SQL*Plus

or

C:\> PLUS80W

Starts the GUI version of SQL*Plus

or

C:\> PLUS80

Starts the line mode version of SQL*Plus

or

Choose Start > Programs > Oracle for 
Windows NT - [HOME_NAME] > SQL Plus 
8.0

Starts the GUI version of SQL*Plus

■ SQL*Plus Getting Started for Windows 
NT and Windows 95/98

■ SQL*Plus User’s Guide and Reference

■ SQL*Plus Quick Reference
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Using SQL*Loader
This section describes Windows NT-specific information for using SQL*Loader 
(SQLLDR80).

Windows NT Processing Options
These are the possible values for the Operating System Dependent (OSD) file 
processing specifications string option, referred to in the "SQL*Loader Control File 
Reference" chapter of Oracle8 Utilities. 
  

Direct Path Option
SQL*Loader includes a direct path option that bypasses Oracle8 Client redo log and 
data verification features, thereby decreasing loading time. Use the direct path 
option with data files known to be error free.

Processing Option Description

""1 

1 Two double quote characters with no space in between.

Stream record format in which each record is terminated by a newline character. The 
maximum record size is 48 KB.

"FIX  n" Fixed record format in which each record is exactly n bytes long. If the record is 
terminated by a newline character, the newline character must be the nth byte.

"VAR xxxx" Load variable length records. Specify the OSD "VAR recsizehint" in the control file for 
this option to take effect. The xxxx gives an estimate of the average record size to 
SQL*Loader so that it can approximate buffer sizes accurately and not waste 
memory. The default length is eighty characters. The xxxx does not specify how 
many leading bytes of length are included in each record. It only acts as a hint to 
SQL*Loader. Each record must always be preceded by five ASCII bytes containing 
the length of the remainder of the record. For example, a record must look like the 
following: 

00024This is a 24 byte string 

Any whitespace, carriage returns, or linefeeds at the end of the record are ignored 
unless specifically included in the byte count in the length field. 
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Control File Conventions
When preparing a SQL*Loader control file (.CTL), you must follow certain syntax 
and notational conventions. When specifying datatypes in the SQL*Loader control 
file, note that the default sizes of native datatypes are specific to Windows NT. You 
cannot override these defaults in the control file. 
 

    

Using Windows NT Tools
The following Windows NT tools can be used to administer an Oracle8 database:

■ Control Panel

■ Event Viewer

■ Performance Monitor

■ Registry

■ User Manager

Control Panel
The Control Panel enables you to modify system options such as computer services. 
A service is an executable process registered in the registry and administered by 
Windows NT. The registry automatically tracks and records security information 
for each service you create. 

Native Datatypes Default Field Length

DOUBLE 8

FLOAT 4

INTEGER 4

SMALLINT 2

Additional Information: For a complete list of options and 
instructions on using SQL*Loader, see Oracle8 Utilities. The 
directory ORACLE_HOME\RDBMS80\LOADER contains a 
number of examples on the use of SQL*Loader.
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Which Oracle8 Services Appear in the Control Panel?
When you install the Oracle8 database and other products, Oracle services are 
created and displayed in the Services dialog box:

 

Use the Services dialog box to start, stop, pause, or continue each of the Oracle 
services available on the computer, and to pass startup parameters to the service.

Oracle services are the same as Windows NT services. In order to connect to and use 
an Oracle instance, an Oracle service is created during the database creation process 
and associated with the Oracle8 database 

Once a service is created with your Oracle8 database, the service can run even while 
no user is logged on. This is because your Oracle8 database starts each instance as a 
service. This feature enables you to maintain workstation security while running 
your Oracle8 database.

You can now have multiple, active Oracle home directories on a single computer. 
This affects the naming conventions for Oracle services. See section, "Managing 
Oracle Services" in Chapter 7, "Administering a Database" and Chapter 5, "Using 
Multiple Oracle Homes" for additional information.
  

Additional Information: See Chapter 7, "Administering a 
Database", for specific instructions on using the Control Panel to 
start and stop Oracle8 database services. See also "Step 1: Start 
Oracle Services on Managed Oracle8 Database" in Chapter 6, 
"Post-Installation Configuration Tasks", for specific instructions on 
using the Control Panel to start the Oracle Intelligent Agent service.
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Event Viewer
Event Viewer enables you to monitor events in your system. An event is an 
important occurrence in the system or application (such as your Oracle8 database) 
that requires user notification. While messages for major events can display 
on-screen as you work at your computer, events not requiring your immediate 
attention are recorded by Windows NT in the Event Viewer log file. You can then 
view this information at your convenience.

What Oracle8 Database Events Are Monitored?
Event Viewer can be used to monitor Oracle8 database events, such as:

■ initialization of the System Global Area (SGA) for the active instance

■ initialization of the Program Global Area (PGA) for the background processes 
of the active instance

■ connection to the Oracle8 database with the CONNECT INTERNAL command
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In addition, the operating system audit trail is logged to Event Viewer. The figure 
below shows Event Viewer displaying Oracle8 database events. Double-click an 
entry to find out specific information about an event. 

  

Performance Monitor
Performance Monitor measures computer performance. This tool enables you to 
view the performance of processors, memory, cache, threads, and processes. 
Performance information provided includes device usage, queue lengths, delays, 
throughput measurements, and internal congestion measurements. This 
information is provided in the form of charts, alerts, and reports.

Additional Information: See Chapter 9, "Monitoring a Database", 
for specific instructions on accessing and using Event Viewer to 
monitor Oracle8 database events.
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What Oracle8 Database Information is Monitored?
If you install Oracle8 Performance Utility from your CD-ROM, you can use 
Performance Monitor to monitor key Oracle8 database information, such as:

■ Library Cache

■ Buffer Cache

■ Data Dictionary Cache

■ Redo Log Buffer Cache

■ Thread Activity

You can use your findings to improve database performance. The figure below 
shows Performance Monitor monitoring Oracle8 database objects listed at the 
bottom of the screen:

     

        

Additional Information: See Chapter 9, "Monitoring a Database", 
for specific instructions on accessing and using Performance 
Monitor to monitor Oracle8 database performance.

Counters Objects
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Registry
The Oracle8 database stores its configuration information in a structure known as 
the registry. You can view and modify this configuration information through the 
registry editor. The registry contains configuration information for your computer, 
and must not be accessible for editing by inexperienced users. Only experienced 
administrators should view and change this information.

The registry editor displays configuration information in a tree-like format 
consisting of four keys (or folders). These keys are shown in the tree view in the 
left-hand window. In the right-hand window, the parameters and values assigned 
to that key are displayed. 

What Database Parameters Are Configured?
When you install products from your   CD-ROM, configuration parameters are 
automatically entered in the registry. These parameters are read each time your 
Windows NT computer is restarted and whenever an Oracle product is launched. 
These parameters include settings for:

■ Oracle home directory

■ Language

■ Company name

■ Oracle home subdirectories for individual products

■ Individual products such as SQL*Plus

■ services
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The figure below shows some of the Oracle8 database configuration parameters in 
the registry: 

         

         

Additional Information: See Appendix C, "Configuration 
Parameters and the Registry" for definitions of Oracle8 database 
configuration parameters and specific instructions on using the 
registry to modify Oracle8 database configuration parameters.
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User Manager
User Manager enables you to manage Windows NT computer security and create 
user accounts. 

What Oracle8 Database Tasks Can User Manager Perform?
With User Manager, you can:

■ Grant Oracle8 database roles

■ Use operating system authentication for user accounts

■ Create an NT user account that enables you to make secure client connections to 
without a password

The figure below shows User Manager: 

              

            

Additional Information: See Chapter 8, "Authenticating Database 
Users with Windows NT" for specific instructions on using User 
Manager to perform Oracle8 database administration.
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Oracle Enterprise Manager Overview

This chapter provides an overview of Oracle Enterprise Manager, Oracle’s suite of 
products for managing Oracle8 databases over a distributed network.

 Specific topics discussed are:

■ Oracle Enterprise Manager Overview

■ Oracle Enterprise Manager Components
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Oracle Enterprise Manager Overview
Oracle Enterprise Manager enables database administrators (DBAs) to manage 
databases distributed across a network from a centralized Console. Database 
management is performed through an easy-to-use graphical user interface (GUI). 
From the Console, you can:

■ Administer, diagnose, and tune multiple databases distributed across a 
network. 

■ Distribute software to multiple servers and clients.

■ Accommodate growing distributed environments by easily scaling upwards to 
maintain performance and automate routine tasks.

■ Automate remote task execution by scheduling jobs on multiple databases 
simultaneously or at varying time intervals.

■ Schedule and run tasks such as remote database backups or report execution at 
off hours, providing the kind of "lights out" management vital in a large, 
distributed environment.

■ Remotely monitor critical database and system events that you define, have 
detected events represented graphically on the Console (or be notified through 
e-mail or paging), and specify for corrective actions to be performed in response 
to an event.

■ Run integrated third-party applications and tools.

■ Accommodate both large database configurations and environments with 
numerous databases.

■ Administer multiple databases simultaneously in separate windows.

■ Localize task execution, so that tasks are completed even during network 
downtime. Messages are queued locally and saved until they can be delivered, 
even if a network connection is down.

■ Allow DBAs single logon access to particular databases by storing their 
privileges in a credentials file used to manage connections. When connecting to 
a database from the Console, credentials are transparently passed, so you do 
not have to log in repeatedly.
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Oracle Enterprise Manager Components
This section describes the components that enable Oracle Enterprise Manager to 
manage your distributed database network:

■ Oracle Enterprise Manager Console Features

■ Common Services for Managing Databases

■ Integrated Applications

Oracle Enterprise Manager Console Features
The Oracle Enterprise Manager Console provides a central point of control through 
a GUI that provides drag and drop systems management. The Oracle Enterprise 
Manager Console consists of:

■ Menus that primarily manipulate objects in the Console windows

■ Toolbars that provide graphic icons that represent most menu items

■ Tools palette for executing applications and utilities

■ Four windows that provide a general view of the system being managed and an 
interface to the Oracle Enterprise Manager common services (described later in 
this chapter) 

The menus, toolbars, and tools palette are context-sensitive. Integrated applications 
can also be launched from the Console. The menu options that display depend on 
which Console window is active. The tools available in a palette depend upon the 
type of service selected in the Navigator or Map windows. Press F1 to view the 
options.
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This figure shows the four Console windows:

See Oracle Enterprise Manager Administer’s Guide for information on using the 
Console menus, toolbars, tools palette, and windows. Brief descriptions of the four 
windows are provided in the following table.

Navigator Window Map Window

Job Scheduling Window Event Management Window
4-4 Oracle8 Client



Oracle Enterprise Manager Components
Window Description

Navigator The Navigator Window provides a hierarchical tree view of the network’s nodes and 
services, and any objects they contain. This enables easy object manipulation of all 
objects in the system. (Objects include nodes, databases, listeners, users, roles, and 
profiles. A node contains databases and listeners. A database contains users, roles, and 
profiles.)

Each type of object in the Navigator tree list is identified by an icon and a name. An 
object in the tree can also be copied by dragging and dropping it. For example, you can 
drag and drop users from one database to another.

Map The Map Window provides a customized, graphical representation of key objects (such 
as databases) created by an administrator to manage and monitor a subset or group of 
objects in the system. Objects can be grouped based on any criteria, simplifying all 
operations performed on the group members. 

The map is useful for environments with many databases and for visually representing 
problems detected by the Event Management System.

Job Scheduling The Job Scheduling Window enables you to automate repetitive tasks and provide the 
kind of “lights out” management vital in a large, distributed environment. 

You can schedule or cancel a job and view its status, or review historical information 
about jobs. You can also create and manage job scripts. See “Job Scheduling System” for 
additional information.

Event Management The Event Management Window enables you to create and register event sets, modify or 
cancel registrations, view the status of services being monitored, view summary 
information about events that have occurred, and further manage event information. 

You can choose to have the events of interest represented graphically on the Console 
when they are detected. The system can also notify you through e-mail or numeric and 
alphanumeric paging. The Oracle Enterprise Manager Console provides support for 
paging and e-mail when a preregistered event is encountered. The Console currently 
supports alphanumeric paging systems that use the Telocator Alphanumeric Paging 
(TAP) protocol for automatic paging and both the Simple Mail Transfer Protocol (SMTP) 
and Mail Application Programming Interface (MAPI) for e-mail notification.
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Common Services for Managing Databases
Oracle Enterprise Manager has the following set of common services that help you 
manage Oracle8 databases throughout the network:

■ Oracle Intelligent Agent and Communication Daemon

■ Service Discovery

■ Job Scheduling System

■ Event Management System

■ Repository

■ Security

The figure below shows how these common services work together to perform 
distributed database management across a network. Each common service is then 
described.

Oracle
Enterprise
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Applications

Integrated
Third Party

Applications

Integrated
Customer

Applications

Oracle Enterprise Manager Console

Job
Scheduling

System

Event
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System
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Discovery Utilities
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Daemon
Agents

Repository
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Oracle Intelligent Agent and Communication Daemon
The Oracle Enterprise Manager uses Oracle Intelligent Agent and the 
communication daemon to manage Console tasks such as scheduling and running 
remote jobs, and monitoring events on remote sites. The Oracle Enterprise Manager 
is installed on a Windows NT, Windows 95, or Windows 98 Console workstation. 
Oracle Intelligent Agent is installed on each node with an Oracle8 Client for 
Windows NT database to be managed.

The communication daemon runs on the Console and communicates with Oracle 
Intelligent Agent to manage jobs and events. 

Oracle Intelligent Agent is effective, nonintrusive, and functions as the executor of 
jobs and events sent by the Console through the communication daemon. High 
availability is ensured since Oracle Intelligent Agent can function regardless of the 
status of the Console or network connections. Oracle Intelligent Agent is 
responsible for managing and completing tasks requested from the Console 
workstation by the Oracle Enterprise Manager. Once installed, Oracle Intelligent 
Agent:

■ listens for and responds to job requests initiated from the Oracle Enterprise 
Manager Console workstation 

■ schedules job requests (requests can include detecting and correcting abnormal 
conditions, performing standard database administration procedures, and 
monitoring events)

■ executes the job request
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Service Discovery 
The communication daemon uses the dynamic discovery feature to identify nodes 
and services on the network. The figure below illustrates this process:

Job Scheduling System
The Job Scheduling System enables you to schedule and manage job tasks on 
remote sites. The Job Scheduling System, communication daemon, and Oracle 
Intelligent Agents work together to schedule and execute jobs. Use the Job 
Scheduling System to perform asynchronous tasks on multiple sites without having 
to maintain connections to all those sites. In addition, jobs can run simultaneously 
on different nodes in the system. See the Oracle Enterprise Manager Administrator’s 
Guide for information on scheduling and managing jobs. 

The process for scheduling a job is:

1. From the Console Job system, submit a job that you have set up.

2. The communication daemon sends the job information to the appropriate 
intelligent agent(s). 

3. If a site or its agent is down, the communication daemon queues the job. Once 
the site can be contacted, the daemon submits the queued job to the agent.

4. The agent executes the job on schedule.

5. The agent returns any related job messages back to the daemon for display in 
the Console.

Communication Daemon

Network

Intelligent
Agent

Network

Console

Topology

Manager

Oracle
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The Job Scheduling System, communication daemon, and Oracle Intelligent Agents 
work together to schedule and execute the job. You can use the Job Scheduling 
System to perform asynchronous tasks on multiple sites without having to maintain 
connections to all those sites. In addition, jobs can run simultaneously on different 
nodes in the system.

The features of the Job Scheduling System are described in the table below: 

Feature Description

Variety of predefined job 
tasks

Schedule and run jobs on remote sites throughout the network, 
including: 

■ Backing up a database

■ Starting up or shutting down databases or listeners

■ Running SQL scripts or operating system programs

You can also submit your own custom jobs to the Job 
Scheduling System.

Stored and forwarding job 
scheduling

Submit a job once, regardless of the number of nodes on which 
the job runs or how often it must be executed. Oracle 
Enterprise Manager ensures that the job is run on schedule on 
all specified databases, and keeps a history of the job and 
record of the job’s status. You can view information about the 
job in the Job Scheduling Window. (This is because the task of 
submitting and managing jobs is centralized in the Console.)

To schedule a job, you do not need to connect to the node on 
which the job runs. Instead, submit the job from the Console 
and specify the nodes or services on which it runs.

When you submit a job to one or more destinations, it is 
possible that any one of those sites may be down. If a site or its 
Oracle Intelligent Agent is down, the communication daemon 
queues job requests not delivered to the sites. Once the site can 
be contacted, the daemon submits the queued job to the agent.

"Lights out" management Automate repetitive and periodic tasks and problem 
correction. If the job has to be executed periodically, the agents 
reschedule the job without your intervention. Messages about 
a job’s status are reported back to the Console.

When you register an event to be monitored by Oracle 
Enterprise Manager, you can specify a fixit job, which is 
executed to correct the problem if the event occurs.
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Cross-operating system job 
scripts

Jobs are implemented as Tool Command Language (Tcl) 
scripts. Tcl is a scripting language used to write both job and 
event scripts. Oracle has also extended Tcl (OraTcl) to include 
database-specific commands. With OraTcl, you can:

■ Invoke operating system facilities, such as programs or 
shell scripts

■ Execute SQL and PL/SQL scripts

■ Start up and shut down Oracle databases

■ Communicate with Oracle Intelligent Agent

Although you submit a job from the Console, the job scripts 
reside on the agent nodes. Because the manner in which a job is 
implemented can depend on the operating system, each agent 
keeps its own set of job scripts.

This enables you to submit a job, such as backing up a 
database, without worrying about the specifics of the operating 
system. For example, you can select a group of databases 
residing on Windows NT computers, and send one backup job 
request to back up the databases. The agents on those nodes 
run backup job scripts that are specific to their operating 
systems.

Composite jobs Combine two or more predefined jobs (such as backing up a 
database and then running a script) into one composite job. Each 
of the predefined jobs contained in the composite job is called a 
task.

Composite jobs can contain test conditions based on the 
success of a task. For example, if a composite job consists of 
two tasks, starting up a database and then running a SQL 
script, you can specify that the script be run only if the 
database was successfully started.

Feature Description
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Scalability Run jobs efficiently on multiple remote nodes. When you 
submit a job to run on a remote node, all the information 
needed to run the job is transferred to the agent servicing the 
node. When the job is executed, it is run by the agent on that 
node, minimizing network traffic between the remote node 
and the Console and daemon. The only communication 
between the agents and the Console and daemon are the initial 
transmission of job information and any subsequent messages 
about job status changes.

Because jobs are run independently by agents, you can submit 
any number of jobs on multiple nodes without affecting the 
Console. For example, you can submit several jobs and then 
immediately start another task without waiting for the agents 
to schedule the jobs.

In addition, because there is an Oracle Intelligent Agent 
residing on each managed node, jobs can be run on multiple 
nodes simultaneously. For example, you can submit a job to 
run a report on multiple databases worldwide. The job is 
scheduled and run independently by the agent that services 
each database. Therefore, the jobs can be executed by their 
respective agents at the same time.

Security Jobs are normally run with your preferred credentials; 
therefore, you cannot run jobs to perform functions that you 
could not perform if you were logged into the computer 
directly.

Because jobs are categorized by service types, such as database 
or node, the Job Scheduling System knows which credentials to 
pass to the agent.

■ If the job runs on a node, the Job Scheduling System 
passes either your preferred credentials for the node or, if 
none are specified, the user name and password used 
when logging into the Console.

■ If the job runs on a service, such as a database, the Job 
Scheduling System also passes your preferred credentials 
to the service.

A job can also be run with the agent’s credentials. This 
flexibility enables a site to easily incorporate the Job 
Scheduling System’s authentication methods with existing 
security policies.

Feature Description
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Event Management System
The Event Management System enables you to monitor specific events at remote 
sites throughout the network, such as problems on a node or database. The process 
to register an event set is:

1. From the Console, register a predefined event set or a set that you created.

2. The communication daemon sends the event information to the appropriate 
intelligent agent(s). 

3. The agent does the monitoring and alerts you if the event occurs.

4. Optionally, you can specify a fixit job to execute if the event occurs.

When an event occurs, you can be notified in various ways, such as e-mail or 
paging. Also, events are logged in the repository and can be viewed in the Console.

The features of the Event Management System are described in the table below: 

Feature Description

Proactive Events 
Management

Automate problem detection and correction in response to an 
event. This ensures that a problem is corrected before it 
noticeably impacts end-users. You can also specify a fixit job to 
be run in response to a particular event. For example, you can 
have the Event Management System monitor the tablespace 
TEMP in the database HR_DB and generate an alert if TEMP 
runs out of free space. You can also have a data file 
automatically added to TEMP if this event occurs.

Unsolicited Error 
Detection

Detect events with tools and applications independent of 
Oracle Intelligent Agents. These tools and applications can be 
integrated into the Event Management System and 
communicate directly with Oracle Intelligent Agents. For 
example, a third-party application can detect an event on a 
node and report that event to Oracle Intelligent Agent on that 
node. Oracle Intelligent Agent then sends the message back to 
the Console.

Event Scripts As with jobs, events are OraTcl scripts stored on the Oracle 
Intelligent Agent node. Event scripts can save state 
information. Saving a state between executions of an event 
script enables Oracle Intelligent Agent to remember if it has 
already detected a certain event and eliminate redundant event 
messages to the Console. This also enables event scripts to 
maintain a history of a database and adjust to typical behavior.

Note: Unlike job scripts, event scripts are run with the 
permissions of Oracle Intelligent Agent.
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Scalability The Event Management System allows one person to monitor a 
large system. If you are responsible for 100 databases, you 
cannot connect to each database every day to check on 
performance. Using the Event Management System, you can 
effectively monitor all databases 24 hours a day, and be alerted 
if a problem is detected.

The Event Management System also enables you to focus on 
select systems and events. This control is vital in a large 
system. Rather than monitor all sites or a large number of sites, 
you can pinpoint only those services you want to monitor.

An administrator can monitor a large number of sites with 
minimal performance impact on the Console. Because Oracle 
Intelligent Agents perform the monitoring independent of the 
Console, an administrator can monitor many sites without 
slowing other tasks.

Predefined Event Sets Standard pre-defined event sets are provided. Advanced event 
sets are included with the optional Diagnostics Pack. 

The standard pre-defined events are the fault management 
events:

■ Database up/down

■ Listener up/down

■ Node up/down

Pre-defined event sets included with the Diagnostics Pack are:

■ Space management and resource usage events, such as a 
disk becoming too full or a tablespace running out of 
extents

■ Performance management events, such as a CPU load 
being abnormal or a database system statistic being too 
high

See the Oracle Enterprise Manager Performance Monitoring and 
Planning Guide and Chapter 9, "Monitoring a Database".

Optimized Intelligent 
Agents

The optimized intelligent agent has been optimized to monitor 
large numbers of systems and events efficiently. Event tests are 
generally executed by the agent process directly and can be run 
quickly.

Feature Description
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Repository
The Oracle Enterprise Manager Repository is a database accessible from the 
Console. The repository:

■ consists of database tables

■ holds information used by Oracle Enterprise Manager

■ can be installed in any accessible Oracle database in the system

You can have more than one repository in your system. A user is associated with 
one repository.

The repository provides a centralized location for storing information about the 
state of the environment managed by Oracle Enterprise Manager from the 
perspective of each Console user. It contains information on: 

■ configurations 

■ jobs and events 

■ historical collections 

■ tuning recommendations 

■ preferred credentials for each user 

■ other information associated with each Oracle Enterprise Manager Console 
login. 

See the Oracle Enterprise Manager Administrator’s Guide for information on creating 
your own repository.

Security
Access to Oracle Services on the network is controlled by a set of user-defined, 
preferred credentials for the available nodes and services. Oracle Enterprise 
Manager caches the user authentication information in encrypted form in the 
repository and provides it as part of the connection request from the Oracle 
Enterprise Manager Console or Console-launched applications. 

To access services, you must log in to the Console by using an authorized user name 
and password. Oracle Enterprise Manager manages the connections made on your 
behalf and ensures that others cannot perform operations they are not privileged to 
perform.
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Integrated Applications
Oracle Enterprise Manager has an open architecture that enables software to be 
integrated with the Console. The design of these integrated applications:

■ executes tasks quickly

■ performs multiple tasks concurrently

■ administers multiple databases simultaneously in separate windows

■ centralizes DBA tasks in a single locale

This section describes the following integrated application features:

■ Database Administration Applications

■ Common Features

■ Integrating Additional Applications

Database Administration Applications
Oracle Enterprise Manager includes a standard set of integrated database 
administration (DBA) applications that automate and simplify DBA tasks. These 
applications can be launched directly from the Console or the Administration 
Toolbar. In addition, third-parties can write applications that integrate into the 
Console, use the available common services, and launch from the Console. The 
applications available are described in the following table:   

DBA Application Description

SQL Worksheet Enables you to enter SQL statements, PL/SQL code, and DBA commands 
dynamically, and run scripts that are stored as files. SQL Worksheet maintains a 
history of the commands entered, enabling you to edit and re-execute an earlier 
command without retyping it. You can drag a SQL file and drop it into a worksheet to 
load it. You can have multiple SQL Worksheets open at a time, each separate from 
others. Therefore, you can commit or roll back work in each worksheet 
independently.

Instance Manager Enables you to start up and shut down databases, examine and edit initialization 
parameters, manage in-doubt transactions, and manage user sessions. 

Storage Manager Enables you to perform DBA tasks associated with managing database storage. These 
tasks include managing tablespaces and rollback segments, and adding and renaming 
data files. You can also launch database tools and utilities from Storage Manager.
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Backup Manager Enables you to perform tablespace backups, create backup scripts guided by a backup 
wizard, and administer redo logs. The Backup Manager manages the following 
groups:

■ database

■ tablespace

■ data files

The Backup Manager simplifies backups through the use of a backup wizard. The 
Backup Wizard enables you to specify the:

■ status of the database required to complete the backup 

■ particular tablespaces of the database to be backed up

■ backup method to be used

■ name of the file that contains the backup job script you are creating using the 
Tablespace Backup Wizard

Security Manager Enables you to create, alter, and drop users, roles, and profiles, and add multiple 
privileges and roles for database users. Security Manager controls the security of 
Oracle databases. Profiles and roles assigned to a set of users are in constant change; 
Security Manager simplifies making changes by providing security lists that an 
administrator uses to determine which profiles and roles have been assigned to a set 
of users. Use property sheets to determine the security parameters for each database. 
Required changes can be made quickly.

Schema Manager Enables you to create, edit, and examine status, owner, creation date, and last date 
modified information for the following schema objects:

■ clusters

■ database links

■ functions and procedures

■ indexes

■ packages and package bodies

■ refresh groups

■ sequences

■ snapshots and snapshot logs

■ synonyms

■ tables

■ triggers

■ views

DBA Application Description
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See the Oracle Enterprise Manager Administrator’s Guide for information on using 
these tools.

Data Manager Enables you to automate (through wizards) the transfer of data to and from an Oracle 
database. Data Manager also provides job tasks that can be submitted with the Job 
Scheduling System. The Data menu of Data Manager includes Export, Import, and 
Load wizard options for:

■ Exporting data to a file. This option transfers data from an Oracle database to an 
Oracle binary operating system file. The file can then be used with the import 
operation. 

■ Importing data from a file. This option transfers data to an Oracle database that 
has been exported from another Oracle database.

■ Loading data from an external file. This option loads data from operating system 
files, such as text files, to an Oracle database.

Oracle Software 
Manager

Enables you to manage software from a central location across the enterprise with: 

■ An integrated toolset for managing software in a distributed fashion 

■ A next generation architecture that offers network scalability through an 
advanced client-agent-server paradigm 

■ An easy-to-use GUI that allows administrators to easily run software 
configuration jobs and track assets across the entire network 

The Oracle Enterprise Manager/Oracle Software Manager (OSM) network comprises 
one or more Oracle Enterprise Manager/OSM installations, each administering host 
servers that contain Oracle Intelligent Agents. Oracle Intelligent Agent can have 
clients that are administered as part of the network.

OSM uses a lightweight store-and-forward messaging system that keeps network 
traffic to a minimum. In the event of network problems, any message that is waiting 
to be sent, either from the Console or Oracle Intelligent Agent, is held until the 
network is back online. Communications between the Console and agents are not 
resource intensive; they require only one connection per agent. If a host becomes 
unavailable, the connection is freed.

Oracle Net8 Assistant Enables you to administer configuration of Net8 products.

Replication Manager Enables you to administer advanced replication environments that support an 
update-anywhere data model.

DBA Application Description
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Common Features
The integrated database administrator applications share some common features:

Integrating Additional Applications
Additional systems management applications are available for Oracle Enterprise 
Manager. These applications are available from Oracle Corporation and third-party 
software developers.

Examples of Oracle applications integration into Enterprise Manager are:

■ Oracle Media Server

■ Oracle Web Application Server

Feature Description

Tree Lists All tools have a tree list of managed objects similar to the Navigator tree list in the 
Console. For example, in the Security Manager, the tree list has containers for users, 
roles, and profiles. These containers can be expanded or collapsed by clicking the + 
or - icons to the left of the container.

Multi-column Lists A multi-column list is displayed when you select a group container. Each row in the 
list provides a quick view of summary information about objects in the selected 
container. Additionally, you can select and alter items through their respective 
property sheets.

Property Sheets A property sheet is a dialog box used to specify options when you are creating or 
altering a composite instance, such as a user or tablespace. A property sheet consists 
of one or more pages that are labeled with page tabs. By default, one page is open 
when the sheet is entered, but all pages show page tabs. To access another page, 
select its page tab.

Record and Play Back The integrated applications also provide a "record and play back" mechanism that 
makes it easy to record a task and perform it at multiple locations. For example, if 
you want to assign several privileges to a set of users who exist on ten databases, 
use the Security Manager and the logging mechanism to record the granting of the 
privileges, then use the Job Control System to perform the assignment at the ten 
databases.

Basic/Advanced User 
Modes

Advanced Mode displays additional property sheets that enable you to access an 
application’s advanced database administration features.
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Using Multiple Oracle Homes

This chapter describes how you work with multiple Oracle homes.

Specific topics discussed are:

■ Multiple Oracle Homes Overview

■ What Is Different About a Multiple Oracle Home Environment?

■ Which Products Are Multiple Oracle Home Enabled?

■ Product Installation Recommendations

■ Working with Multiple Oracle Homes 
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Multiple Oracle Homes Overview 

An Oracle home corresponds to the environment in which Oracle products run. 
This environment includes:

■ location of installed product files

■ PATH variable pointing to the products’ binary files

■ registry entries 

■ service names

■ program groups

Oracle homes also have a name, and a language associated with them. You specify 
the name, location, and language of an Oracle home at installation.

Releases of Oracle for Windows NT and Windows 95 prior to release 8.0.4 
supported single Oracle homes, allowing you to install and run Oracle products in a 
single Oracle home. Different releases of Oracle products could be installed in the 
same Oracle home provided they had different second-digit release numbers. For 

Warning: If you quit Oracle installer after you have entered the 
name and location for an Oracle home (for example, you need to 
quit Oracle Installer because you have insufficient disk space in 
the location specified), you will not be able to specify a different 
location for that home until you identify and delete the HOMEID 
key and the IDx key that corresponds to that Oracle home from 
the registry. To do this:

1. Read the value of the ORACLE_HOME_NAME parameter for 
each HOMEID subkey in the HKEY_LOCAL_MACHINE\
SOFTWARE\ORACLE key until you find the value that 
matches the name of the Oracle home you need to delete. 

2. Delete the HOMEID subkey you have just identified. 

3. Delete the appropriate IDx subkey located in the HKEY_
LOCAL_MACHINE\SOFTWARE\ORACLE\ ALL_HOMES 
key where x has the same value as the ID in HOMEID. For 
example, if the HOMEID subkey for the home name you 
want to delete is HOME1, then the appropriate IDx subkey is 
ID1.

For more information on the registry keys and subkeys, see 
Appendix C, "Configuration Parameters and the Registry". 
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example, you could install release 7.2 products and release 7.3 products in the same 
Oracle home. However, you could not install multiple third-digit releases of the 
same products. For example, you could not install release 7.3.2 and release 7.3.3 
releases of the same Oracle products on the same computer; one installation would 
overwrite the other.

The Multiple Oracle homes feature enables you to install one or more releases of 
Oracle products on the same computer in multiple Oracle homes. For example, with 
multiple Oracle homes, you can install release 8.0.5 and 8.0.4 products in different 
Oracle homes on the same computer. You can still install different releases of Oracle 
products in the same Oracle home provided they have different second-digit release 
numbers.

Why Use Multiple Oracle Homes?
The main benefit of using multiple Oracle homes is that you can run multiple 
releases of the same products concurrently. For example, you can test an 8.x.x 
database patch, before you run your production database 8.x.x against it.

When using third-party tools on your computer, if one tool is certified against 
release 8.x.1.x while another tool is certified against release 8.x.2.x, you may want to 
use the multiple Oracle homes feature so that you can install each third-party tool in 
a separate home.

When Should I Not Use Multiple Oracle Homes?
If you have previously installed release 8.0.x software and have no reason to keep 
the old release, overwrite the existing release by installing the 8.0.5 products in the 
home used for the previous release. 

Warning: Multiple Oracle homes functionality only works with 
releases 8.0.4 and higher. If you have, for example, release 7.3.3 
products already installed on your computer, you cannot install 
release 7.3.4 products in a separate Oracle Home. However, you 
can install release 8.0.5 or 8.0.4 in the same home in which release 
7.3.3 or 7.3.4 is installed and the version 7 release will be left 
intact.
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What Is Different About a Multiple Oracle Home Environment?
 If you decide to use multiple (versus single) Oracle homes, note these differences: 

Which Products Are Multiple Oracle Home Enabled?
The products included on your CD-ROM are classified as follows:

■ Multiple Oracle Home Enabled

■ Multiple Oracle Home Compliant

■ Non-Multiple Oracle Home

Multiple Oracle Home Enabled
You can install products multiple times in multiple Oracle homes. Products are 
multiple Oracle home enabled unless they are listed in section, "Multiple Oracle 
Home Compliant Products" or section, "Non-Multiple Oracle Home Products".
   

Element First Oracle Home Each Additional Oracle Home

Service Names OracleTNSListener80 Includes the Oracle home name in service 
names, for example:
OracleHOME_NAMETNSListener80

Program 
Groups

Oracle for Windows NT Appends the Oracle home name to the 
program group, for example: Oracle for 
Windows NT - HOME_NAME

Registry 
Entries

Located in HKEY_
LOCAL_
MACHINE\SOFTWARE\
ORACLE

Subkeys for each Oracle home added below 
the HKEY_LOCAL_MACHINE\
SOFTWARE\ORACLE subkey (HOME0, 
HOME1, HOME2, and so on). For more 
information on the registry keys and subkeys, 
see Appendix C, "Configuration Parameters 
and the Registry".

SID for starter 
database

ORCL Only the first starter database on your 
computer is called ORCL. Additional starter 
databases use the naming convention ORCx or 
ORxx where x is a number appended to ensure 
the SID is unique.

Note: Oracle Intelligent Agent is a multiple Oracle homes enabled 
product. However, although it can be installed multiple times, only 
one version can be running at a time.
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Multiple Oracle Home Compliant
You can install products into any Oracle home, but only once per computer. When 
installing any of these products, if other releases are detected on your computer, 
you are prompted to:

■ continue installation without installing the product.

■ quit the installation so that you can delete the existing release before proceeding 
to install the new release.

Multiple Oracle Home Compliant Products
When installing groups of products, if any of the products listed below are included 
in the group and already exist on the computer, they will not be installed. You must 
first deinstall pre-existing copies of these products (which may break other 
applications) before you can install them in a different home. 

■ Oracle Enterprise Manager

■ Oracle Enterprise Manager SDK

■ Oracle Enterprise Manager DB Admin Applications

■ Oracle Administrator Toolbar

■ Oracle Web Server Manager

■ Oracle Security Server Manager

■ Oracle SNMP Support

■ Oracle File Packager

■ Open Database Connectivity Driver (ODBC)

■ Oracle Objects for OLE

■ Oracle SNMP Agent

■ Oracle Migration Assistant for Microsoft Access

■ Oracle8 ConText Cartridge System Administration

■ Oracle8 Performance Monitor

■ All products that are dependent on any of the products listed above
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Non-Multiple Oracle Home
You can only install these products into an old-style Oracle home (pre-8.0.4 Oracle 
home).

Non-Multiple Oracle Home Products
All Oracle release 8.0.3 products and all Oracle7 Products are non-multiple Oracle 
home products.

Product Installation Recommendations

Installing Release 8.0.5 or 8.0.4 Components into an 8.0.3 Oracle Home
Do not install release 8.0.4 or 8.0.5 components into an 8.0.3 Oracle home (or release 
8.0.5 components into an 8.0.4 Oracle home) unless you are upgrading the database. 
If you do, Required Support Files release 8.0.4 and 8.0.5 overwrite the Required 
Support Files of the previous database installation, breaking the previous database. 
Instead, install release 8.0.5 and 8.0.4 components into separate Oracle homes than 
the 8.0.3 Oracle home if you want to maintain multiple versions. The following is an 
example scenario.

I am not ready to upgrade my local release 8.0.4 database yet, but I want to use Oracle 
Enterprise Manager 1.6 included on the release 8.0.5 for Windows NT CD-ROM. I 
installed Oracle Enterprise Manager release 1.6 into the Oracle home where release 8.0.4 
resides, but now my 8.0.4 database no longer works. What is wrong? 

Products that depend on Required Support Files release 8.0.5 or 8.0.4, for example, 
Oracle Enterprise Manager release 1.6, cannot be installed into an Oracle home 
where a release 8.0.3 database already exists. Required Support Files release 8.0.5 
overwrites Required Support Files release 8.0.3 and break the release 8.0.3 database.

If you want to install Oracle Enterprise Manager release 1.6 in the same Oracle 
home as your database, you need to upgrade your database to release 8.0.5. If you 
do not want to upgrade your database, Oracle Corporation suggests installing 
Oracle Enterprise Manager into a new Oracle home to avoid the Required Support 
Files release 8.0.5 overwriting the Required Support Files release 8.0.3. Since Oracle 
Enterprise Manager can only be installed in one Oracle home, you must deinstall it 
first before installing into a new Oracle home.
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Working with Multiple Oracle Homes
Unless you specify otherwise at installation time, the Oracle home in which you 
installed products most recently is the first directory listed in your PATH (primary 
home). As such, it has priority over the other Oracle home entries in your PATH. If 
you invoke a product from the MS-DOS command prompt, the release of the 
product invoked will be that stored in the Oracle home listed first in your path, 
unless you specifically invoke a different release of the product by:

■ specifying the full pathname to the release of the product you want to use at the 
command line

■ changing your PATH so that the first entry points to the binary files for the 
product release you want to use. See the section, "Changing the Value of PATH" 
for more information.

■ changing to the directory that contains the executable you want to use

Changing the Value of PATH
You can change the value of PATH:

■ using Oracle Home Selector.

■ at the system level. The new value you assign to PATH exists until you change 
the value of PATH again.

■ at the command line. The value of PATH reverts to its previous value when you 
quit the session.

Note: The first two methods of changing the value of PATH are 
only valid if you are a member of the Administrators group. After 
you have changed the value of PATH, you must open a new 
MS-DOS window to make it active. The change is not reflected in 
already opened MS-DOS windows.
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To change the value of PATH using Oracle Home Selector:

Oracle Home Selector is a graphical user interface (GUI) tool that enables you to 
edit your environment path to make an appropriate Oracle home directory your 
primary home. This tool can only be used when you have multiple, active Oracle 
home directories on a single computer. 

1. Choose Start > Programs > Oracle for Windows NT - [HOME_NAME] > Oracle 
Home Selector.

The Oracle Home Selector window appears.

2. Select the Oracle home that you want as the primary Oracle home from the 
drop-down list.

To change the value of PATH at the system level:

On Windows NT:

1. Choose Start > Settings > Control Panel.

The Control Panel window appears.

2. Double-click the System icon.

The System Properties window appears.

3. Click the Environment tab.

The System Variables appear.

4. Edit the value of the PATH in the Value field and click OK to exit.

On Windows 95:

1. Open the AUTOEXEC.BAT file.

2. Edit the value of the PATH statement.

3. Reboot your computer.

On Windows 98:

1. Open the AUTOEXEC.BAT file.

2. Edit the value of the PATH statement.

3. Reboot your computer.
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To change the value of PATH at the command line:

At the command prompt enter:

C:\> PATH PATHNAME;%PATH%

where PATHNAME is the full path to the binary files for the products you want to 
use. This change is valid for the current session only. If you want to change the 
value of your PATH more permanently, use the Oracle Home Selector or change the 
value of PATH at the system level. Both methods are described above.
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Post-Installation Configuration Tasks

This chapter describes post-installation configuration tasks for Oracle8 Client.

Specific topics discussed are:

■ What Must You Configure?

■ Net8

■ Oracle Enterprise Manager

■ Oracle8 ConText Cartridge Workbench
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What Must You Configure?

Net8
Net8 is the Oracle network software that enable applications running on Windows 
NT and Windows 95 client workstations to access, modify, share, and store data on 
Oracle8 databases. An easy-to-use network configuration tool, Oracle Net8 Easy 
Config, enables you to configure Windows NT and Windows 95 clients to 
communicate with Oracle8 databases. Use Oracle Net8 Easy Config to create and 
modify server and client configuration files.
 

Additional Information: See in Chapter 2, "Introducing Oracle8 
Client" for information on how this product is installed. See also 
Net8 Getting Started for Windows NT and Windows 95/98 for 
instructions on using Oracle Net8 Easy Config.
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Oracle Enterprise Manager 
Before describing how to configure Oracle Enterprise Manager, the key components 
are briefly described.

Oracle Enterprise Manager Console  Oracle Enterprise Manager works with Oracle 
Intelligent Agent (installed in the Oracle8 database to be managed) to perform 
remote database management from a single console computer. Oracle Enterprise 
Manager is installed on a console computer, a Windows NT or Windows 95 client.

Oracle Intelligent Agent and Managed Oracle8 Databases  Oracle Intelligent Agent runs on 
the Oracle8 database to be managed. This Oracle8 database is the one you use for 
your production work. Oracle Intelligent Agent manages and completes tasks on 
the Oracle8 database that are requested from the Oracle Enterprise Manager 
Console computer. Oracle Intelligent Agent:

■ listens for and responds to job requests initiated by the Oracle Enterprise 
Manager Console computer 

■ schedules job requests (requests can include detecting and correcting abnormal 
conditions, performing standard database administration procedures, and 
monitoring events)

■ executes job requests

Oracle8 Repository Database  The Oracle Enterprise Manager Console uses an Oracle8 
database as a repository for storing key configuration information. The Oracle8 
repository database can be installed on:

■ the same computer as the Oracle Enterprise Manager Console if it is a Windows 
NT computer

■ a separate Windows NT computer to which a Windows 95 or Windows NT 
Oracle Enterprise Manager Console can remotely connect

The sole responsibility of the repository database is to act as the Oracle Enterprise 
Manager’s storage resource. The Oracle8 repository database is:

■ a separate database from the managed Oracle8 database that you use for your 
production work

■ installed on a separate computer from the managed Oracle8 database

Do not create a repository and a production database in the same Oracle8 database. 
If you do, you will not be able to perform many database administration tasks, such 
as starting or shutting down the database. 
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Set up your Oracle Enterprise Manager Console, managed Oracle8 database(s), and 
Oracle8 repository environment in either of two ways:

The Oracle Enterprise Manager Console 
remotely manages the Oracle8 databases on 
Server 1 and Server 2. The Console is running 
on a Windows NT, WIndows 95, or Windows 98 
computer.

Console and Repository on separate computers

The repository is a separate Windows NT 
computer with an Oracle8 database installed 
that is only being used as a repository. 
Oracle Intelligent Agent does not need to be 
running.

Console and Repository on same computer

This computer runs a production Oracle8 
database containing Human Resources data. 
The repository is not created in this database 
and Oracle Intelligent Agent is running.

 
This computer runs a production Oracle8 
database containing Manufacturing data. The 
repository is not created in this database and 
Oracle Intelligent Agent is running.

The Oracle Enterprise Manager Console remotely 
manages the Oracle8 databases on Server 1 and 
Server 2. The Console is running on a Windows NT 
computer with an Oracle8 database installed that is 
only being used as a repository. Oracle Intelligent Agent 
does not need to be running.

Managed
Server 1

Managed
Server 2

Oracle Enterprise Manager Console Oracle8 repository database

Oracle Enterprise Manager Console and Oracle8 
repository database

This computer runs a production Oracle8 
database containing Human Resources 
data. The repository is not created in this 
database and Oracle Intelligent Agent is 
running.

 

This computer runs a production Oracle8 
database containing Manufacturing data. The 
repository is not created in this database and 
Oracle Intelligent Agent is running.

Managed
Server 1

Managed
Server 2

Environment 1: 

Environment 2: 
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Oracle Enterprise Manager setup involves configuring the computers on which 
your Oracle Enterprise Manager, managed Oracle8 database(s), and Oracle8 
repository database are installed. This table describes the tasks that must be 
performed to configure the two Oracle Enterprise Manager environments 
illustrated previously and the computers on which to perform these tasks. Each task 
is then fully described in the sections that follow. Use this table as a reference as you 
perform your configuration tasks. 

     
Perform This Task... On Managed Oracle8 

databases?
If Console and Repository 
are on same computer?

If Console and Repository 
are on separate computers?

Step 1: Start Oracle 
Services on Managed 
Oracle8 Database

Yes No No

Step 2: Create a 
Repository User Account

No Yes Yes, but only perform this task 
on the computer on which 
you create the repository 

Step 3: Create a Windows 
NT User Account on 
Managed Oracle8 
Database Server

Yes No No

Step 4: Create Network 
Configuration Files

No No Yes

Step 5: Create the 
Repository and Discover 
Services

No Yes Yes, but only perform this task 
on the computer on which 
you create the repository 
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Step 1: Start Oracle Services on Managed Oracle8 Database
Ensure that the Oracle8 database services OracleServiceSID, OracleTNSListener80 
(or OracleHOME_NAMETNSListener80 if using an Oracle home directory with a 
home name), and OracleAgent are started. Oracle Intelligent Agent automatically 
locates the services on the computer where it resides and passes this information to 
the Oracle Enterprise Manager Console.

To start Oracle Services:

1. Go to the Oracle8 database to be managed.

2. Start the Oracle services listed above in either of two ways:

■ From the MS-DOS command prompt, enter:

C:\> NET START SERVICE_NAME

■ From the Control Panel’s Services window, select the service, and click Start.

3. Continue to "Step 2: Create a Repository User Account".

      

Step 2: Create a Repository User Account
You need to have a user account with database administrator (DBA) privileges set 
up on the Oracle8 repository database. Oracle Enterprise Manager places the 
repository in the default tablespace of the user account to which you are connected 
when creating the repository. Because of this, Oracle Corporation recommends that 
you create a new user account so that the repository can be created in its own 
tablespace. It is also recommended that you create a new tablespace and the 
newly-created user be customized to use this tablespace as their default tablespace. 

Note: Oracle Intelligent Agent automatically creates SNMP_RO 
and SNMP_RW. These are used instead of the SNMP.ORA file of 
some previous releases. If you want to use an SNMP.ORA file that 
you configured with a previous release instead of SNMP_RO and 
SNMP_RW, set the following line to TRUE in the SNMP.ORA file.

nmi.register_with_names=true 

If you set this line to FALSE, Oracle Intelligent Agent uses SNMP_
RO and SNMP_RW. 
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To create a repository user account on the Oracle8 repository database:

1. Go to the computer on which the Oracle8 database that will become your 
repository is installed.

2. Start Server Manager:

C:\> SVRMGR30

3. Connect to the Oracle8 repository database:

SVRMGR> CONNECT SYSTEM/PASSWORD

where PASSWORD is MANAGER for the SYSTEM user account by default. If 
you have changed this password, substitute MANAGER with the correct 
password.

4. Create a special tablespace for the Oracle Enterprise Manager repository: 

SVRMGR> CREATE TABLESPACE REPOSIT_TABLESPACE DATAFILE                  
’ORACLE_HOME\DATABASE\DATAFILE’ SIZE XM;

where: 

■ REPOSIT_TABLESPACE is the tablespace name 

■ ‘ORACLE_HOME\DATABASE\DATAFILE’ is the complete path (including 
drive letter) to the data file (single quotes are required)

■ X is the tablespace size in megabytes (20 MB is a good starting place)

5. Create a user account and password where the user’s default tablespace is the 
one created in step 4: 

SVRMGR> CREATE USER USERNAME IDENTIFIED BY PASSWORD DEFAULT TABLESPACE 
REPOSIT_TABLESPACE;

6. Grant the SYSTEM privileges to this user account: 

SVRMGR> GRANT DBA TO USERNAME;

7. Exit Server Manager:

SVRMGR> EXIT

Exiting Server Manager closes the database connection.

8. Follow Steps 3-6 for additional repository user accounts.

9. Continue to "Step 3: Create a Windows NT User Account on Managed Oracle8 
Database Server".
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Step 3: Create a Windows NT User Account on Managed Oracle8 Database Server
After a repository user account is created, an NT user account must be created on 
the managed Oracle8 database server.

To create a user account on the managed Oracle8 database server:

1. Go to the Oracle8 database to be managed.

2. Choose Start > Programs > Administrative Tools > User Manager.

The User Manager window appears: 

3. Choose New User from the User menu.
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The New User dialog box appears: 

4. Enter the appropriate information in the dialog box:

a. Enter a user name in the Username field.

b. Enter the same password in both the Password and Confirm Password 
fields.

The user name and password that you enter here do not need to match 
those that you created in "Step 2: Create a Repository User Account".

c. Make sure the User Must Change Password at Next Logon check box is not 
checked and Password Never Expires check box is checked.

d. Make the user a member of the Administrator’s group by clicking Groups.
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The Group Memberships dialog box appears:

e. Select Administrators from the Not member of list box and click <- Add.

Administrators is added to the Member of list box.

f. Click OK to close the Group Memberships dialog box and return to the New 
User dialog box.

5. Click OK in the New User dialog box to accept the user information.

The user is added and the User Manager window reappears.

6. Select the newly created user and choose User Rights from the Policies menu.

The User Rights Policy dialog box appears:   

7. Click the Show Advanced User Rights check box and select Log on as a batch job 
from the Right drop-down list box.

8. Select Users from the Grant To list box.
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If Users does not exist, create it:

a. Click Add.

The Add Users and Groups dialog box appears: 

b. Select the name of the local host computer from the List Names From 
drop-down list box.

c. Select Users from the Names list box and click Add.

d. Click OK.

Users appears in the Grant To list box.

9. Click OK in the User Rights Policy dialog box.

The User Manager window reappears.

10. Click Exit from the User menu.

11. Repeat Steps 1-9 for any other repository user accounts you created.

12. Continue to "Step 4: Create Network Configuration Files".
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Step 4: Create Network Configuration Files
If Oracle Enterprise Manager is installed on the same computer as the repository 
database, you do not need to configure your network. If Oracle Enterprise Manager 
is installed on a Windows 95 or Windows NT client console separate from the 
computer on which the repository database is installed, you must configure the 
client computer so it can connect to the Oracle8 repository database:

To create network configuration files:

1. Use Oracle Net8 Easy Config to configure your network. See Net8 Getting 
Started for Windows NT and Windows 95/98 for instructions on using Oracle Net8 
Easy Config.

2. Continue to "Step 5: Create the Repository and Discover Services".

Step 5: Create the Repository and Discover Services
Before you can use Oracle Enterprise Manager, you need a repository. The 
repository is a set of base tables in a database that contains status and environment 
information for your managed databases. A separate repository must be created for 
each user wanting to use Oracle Enterprise Manager. 

The Oracle Enterprise Manager Console workstation must also discover network 
services, such as databases, listeners, and nodes, to populate the Oracle Enterprise 
Manager Navigator tree. In addition to discovery, Oracle Enterprise Manager must 
also be able to manage these services for the Job Scheduling and Event Management 
systems. This can be achieved with the Discovery Wizard.

When the agent starts up and is explicitly requested by the Oracle Enterprise 
Manager with the Navigator Discovery feature, the agent passes information from 
the Oracle Enterprise Manager Console to populate the Navigator tree.

To create a repository:

1. Go to the computer on which the Oracle8 database that will become your 
repository is installed. 

2. Choose Start > Programs > Oracle Enterprise Manager > Enterprise Manager.
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The Oracle Enterprise Manager Repository Login Information dialog box appears:

3. Enter the following information and click OK:

■ Repository user name and password you created earlier in "Step 2: Create a 
Repository User Account"

■ Net8 service name (or database alias) of the repository database; it is only 
necessary to enter a service name if you are connecting from a client console 
to the Oracle8 repository database on a different computer

The Oracle Repository Manager window appears, prompting you to build the 
repository:

4. Click OK. 

The repository is built. A dialog box asking if you want a quick tour of Oracle 
Enterprise Manger appears.

5. Click Continue to dismiss this dialog box.
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The Discover New Services Wizard appears: 

6. Follow the wizard instructions to discover services.
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Services are discovered when you see the dialog box below with a status of 
Discovered:

If the services are not discovered, click Help for troubleshooting hints. The 
wizard can be restarted by selecting Service Discovery under Navigator in the 
main menu.

7. Click Close.
Post-Installation Configuration Tasks 6-15



Oracle Enterprise Manager
The Oracle Enterprise Manager Console appears: 
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Oracle8 ConText Cartridge Workbench
Oracle8 ConText Cartridge Workbench consists of administrative tools and 
application development tools for Oracle8 ConText Cartridge.

Specific topics discussed in this section are:

■ Upgrading Oracle8 ConText Cartridge Workbench

■ Configuring Oracle8 ConText Cartridge Viewer Cartridge

■ Configuring Oracle8 ConText Cartridge Configuration Manager

■ Configuring Oracle8 ConText Cartridge Workbench Demo

Upgrading Oracle8 ConText Cartridge Workbench
To upgrade from previous releases of Oracle8 ConText Cartridge Workbench, install 
the current release of Oracle8 ConText Cartridge Workbench in the same Oracle 
home directory as the previous release using Oracle Installer. Oracle Installer 
automatically upgrades all Workbench files to the current release.

Configuring Oracle8 ConText Cartridge Viewer Cartridge
Chapter 3 of the Oracle8 ConText Cartridge Workbench User’s Guide describes how to 
configure Oracle8 ConText Cartridge Viewer Cartridge.

Configuring Oracle8 ConText Cartridge Configuration Manager
Chapter 2 of the Oracle8 ConText Cartridge Workbench User’s Guide describes how to 
configure Oracle8 ConText Cartridge Configuration Manager.

Configuring Oracle8 ConText Cartridge Workbench Demo
Appendix C of the Oracle8 ConText Cartridge Application Developer’s Guide describes 
how to configure the CTXQUERY demo.
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Distributing and Managing Oracle Software

This chapter describes how to distribute and manage Oracle8 Client products across 
a network.

Specific topics discussed are:

■ Overview

■ Systems Management Server
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Systems Management Server
Overview
Microsoft Systems Management Server (SMS) enables you to distribute and manage 
Oracle software across a network. This chapter provides a brief overview of SMS 
features, including installation, configuration, and usage instructions (where 
necessary).

Systems Management Server
SMS manages networked PCs running Windows operating systems. Specifically, 
SMS provides:

■ PC hardware and software inventory 

■ Software distribution

■ PC troubleshooting 

SMS is a component of Microsoft Backoffice, and is sometimes used in companies 
running their businesses on Windows NT.

Oracle8 Enterprise Edition SMS Support 
Oracle products for Windows 95, Windows 98, and Windows NT support remote 
installation and software inventory and auditing capabilities through SMS release 
1.2. SMS integration with Windows 3.1 and Windows for Workgroups is not 
currently supported. Oracle Corporation provides customizable package definition 
files (.PDFs) that SMS administrators can use to distribute and maintain Oracle 
products in Windows NT, Windows 95, and Windows 98 networks. These packages 
contain the same products as the corresponding packages in a traditional 
installation.

Attention: SMS .PDF files are not the same as Adobe Acrobat .PDF 
files. Adobe Acrobat .PDF files contain only documentation, do not 
contain products, and cannot be used to distribute and maintain 
Oracle products.
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Distributing Oracle Software with SMS
To distribute Oracle software with SMS:

 

1. Open the Packages window from the SMS Administrator’s console. 

2. Select New from the File menu.

3. Select Import in the dialog box that appears in order to specify the .PDF 
package that describes the Oracle software package to SMS.

4. Navigate to the SMS directory at the root of the Oracle8 Enterprise Edition for 
Windows NT CD-ROM.

5. Select the appropriate PDF package:

6. Select Workstations to see more properties of the package.

Note: You must be an SMS administrator to perform these 
procedures.

Package Enables You to...

ServerNT.PDF Install and de-install Oracle8 server software. This package 
includes Recovery Manager, which requires Legato Storage 
Manager (LSM) for Oracle to be installed. LSM is not automatically 
installed by SMS. You must manually install LSM by executing 
SETUP.EXE from the Legato directory at the root of the for 
Windows NT CD-ROM.

Client32.PDF Install and de-install Oracle8 client software.

Deinstal.PDF De-install any Oracle8 software package. You can use this option if 
you have the software installed but have not already created an 
install/de-install package with SMS, or if you have deleted the 
install/de-install package. Job sending time is greatly reduced.
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7. Select the source directory for the package as follows:

 

One or more command line options listed for the package appear. They are 
defined in the .PDF file and must not be modified.

8. Click Close to exit the window. 

9. Click OK to exit the Package Properties window. 

SMS creates the package.

10. Create a Run Command on Workstation job to distribute the new Oracle8 
Enterprise Edition product package. You can choose the appropriate command 
line option for the package during job creation (for example, Oracle8 
Client/DBA for Win95 or Oracle8 Client/AppUser for Win95). Consult your 
SMS documentation for more information about creating jobs.

11. Restart all client and server machines after installing Oracle software with SMS.

For... Set the Source Directory...

ServerNT.PDF or Client32.PDF (the 
two install/de-install packages)

To the root directory of the Oracle8 Enterprise 
Edition for Windows NT CD-ROM

Deinstal.PDF (the de-install only 
package)

To the SMS directory located at the root of the 
Oracle8 Enterprise Edition for Windows NT 
CD-ROM

Attention: Setting the source directory is important, as installation 
command lines specified in the .PDF file are interpreted relative to 
the source directory.

Note: When you schedule an SMS job to distribute software, the 
source directory that was specified during package creation must 
be accessible to SMS. If you specified the Oracle8 Enterprise Edition 
for Windows NT CD-ROM as the source, be sure the CD-ROM is 
loaded into your CD-ROM drive during job creation.
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De-installation Issues 
Before running an Oracle de-installation job on an SMS client machine, be sure that 
all Oracle applications and services are stopped. De-installation will fail if services 
are running.

Note: Oracle documentation distributed in an SMS package points 
to the initial installation location in order to save client disk space. 
This location is the SMS_PKGD directory of the SMS distribution 
server. As a result, the client machine requires a drive mapping to 
the initial installation location for access to documentation files. On 
Windows 95, Windows 98, and Windows NT 4.0, this drive 
mapping occurs automatically when the documentation icon is 
selected. 
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Developing Applications

This chapter describes Windows NT-specific issues for application developers. 

Specific topics discussed are:

■ Compiling and Linking the Oracle XA Library

■ Accessing Web Data with Intercartridge Exchange

Compiling and Linking the Oracle XA Library
The XA Application Program Interface (API) is typically used to enable an Oracle8 
database to interact with a transaction processing (TP) monitor, such as:

■ BEA Tuxedo 

■ IBM Transarc Encina

■ IBM CICS

The Oracle XA Library is automatically installed as part of Oracle8 Enterprise 
Edition. The following components are created in your Oracle home directory:
  

You can also use TP monitor statements in your client programs. The use of the XA 
API is also supported from both Pro*C/C++ and Oracle Call Interface (OCI). In 

Component Location

XA80.DLL ORACLE_HOME\BIN

XA80.LIB ORACLE_HOME\RDBMS80\XA

XA.H ORACLE_HOME\RDBMS80\XA
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either case, the XA80.DLL must be contained in the execution path of the calling 
program.

Compiling and Linking a Pro*C/C++ Program
To compile and link a Pro*C /C++ program:

1. Precompile PROGRAM.PC using Pro*C to generate PROGRAM.C.

2. Compile PROGRAM.C, making sure to include ORACLE_HOME\ 
RDBMS80\XA in your path.

3. Link PROGRAM.OBJ with the following libraries:   

4. Run PROGRAM.EXE. (XA80.LIB makes the function calls to XA80.DLL.) 

Library Located in...

XA80.LIB ORACLE_HOME\RDBMS80\XA

OCI.LIB ORACLE_HOME\OCI80\LIB\MSVC

or

ORACLE_HOME\OCI80\LIB\BORLAND

SQLLIB80.LIB ORACLE_HOME\PRO80\LIB\MSVC

or

ORACLE_HOME\PRO80\LIB\BORLAND
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Compiling and Linking an OCI Program
To compile and link an OCI program:

1. Compile PROGRAM.C by using Microsoft Visual C++ or Borland C, making 
sure to include ORACLE_HOME\RDBMS80\XA in your path.

2. Link PROGRAM.OBJ with the following libraries:

3. Run PROGRAM.EXE. 

XA and TP Monitor Information
See the following general information about XA and TP monitors: 

■ Distributed Transaction Processing: The XA Specification published by 
X/Open, (now part of OpenGroup). Visit: 
http://www.rdg.opengroup.org/public/pubs/catalog/full_
lst.htm 

■ Transaction Processing XPG4 X/Open CAE Specification XO/CAE/91/300 or C193 
2/92

■ Your specific TP monitor documentation

For more information about the Oracle XA Library, see the chapter "Oracle XA" 
of the Oracle8 Application Developer’s Guide.

Accessing Web Data with Intercartridge Exchange
■ Configuring Intercartridge Exchange

■ Using Intercartridge Exchange

■ UTL_HTTP Exception Conditions

■ Exceptional Conditions and Error Messages

■ Troubleshooting

Library Located in...

XA80.LIB ORACLE_HOME\RDBMS80\XA

OCI.LIB ORACLE_HOME\OCI80\LIB\MSVC

or

ORACLE_HOME\OCI80\LIB\BORLAND
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Configuring Intercartridge Exchange
You must add a parameter to the registry before using ICX.

To configure ICX:

1. Start the registry editor from the MS-DOS command prompt:

C:\> REGEDT32

The Registry Editor window appears.

2. Add HTTP_PROXY to the registry subkey of the Oracle home directory that 
you are using. The location in which to add this parameter is determined by 
how many Oracle home directories are on your machine:

a. Choose Add Value from the Edit menu.

The Add Value dialog box appears.

b. Enter HTTP_PROXY in the Value Name field and REG_SZ in the Data Type 
field:

c. Click OK.

If You Have... Add HTTP_PROXY to...

One home directory HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE

Additional directories HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE\ 
HOMEID

where ID is incremented for each additional Oracle home 
directory on your computer.
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d. Enter www-proxy.your-site in the String field:

where marketing.com is only an example of a Web site. Enter your real Web 
site.

Using Intercartridge Exchange
ICX enables you to use a stored package called UTL_HTTP to make hypertext 
transfer protocol (HTTP) calls from PL/SQL, SQL, and Server Manager statements. 
UTL_HTTP can:

■ access data on the Internet 

■ call Oracle Web Application Server Cartridges 

UTL_HTTP contains two similar entry points, known as packaged functions, that 
make HTTP callouts from PL/SQL and SQL statements:

■ UTL_HTTP.REQUEST

■ UTL_HTTP.REQUEST_PIECES

 Both packaged functions:

■ take a string universal resource locator (URL) of a site

■ contact that site

■ return the data (typically HTML) obtained from that site

The declarations to use with both packaged functions are described in the following 
sections.

Packaged Function UTL_HTTP.REQUEST
UTL_HTTP.REQUEST takes a URL as its argument and returns up to the first 2000 
bytes of data retrieved from the given URL. 

UTL_HTTP.REQUEST is specified as:

FUNCTION REQUEST (URL IN VARCHAR2) RETURN VARCHAR2;
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To use UTL_HTTP.REQUEST from Server Manager, enter:

SVRMGR> SELECT UTL_HTTP.REQUEST(’HTTP://WWW.ORACLE.COM/’) FROM DUAL;

which outputs:

UTL_HTTP.REQUEST(’HTTP://WWW.ORACLE.COM/’)                         

------------------------------------------------------

<html>

<head><title>Oracle Corporation Home Page</title>

<!--changed Jan. 16, 19

1 row selected.

Packaged Function UTL_HTTP.REQUEST_PIECES
UTL_HTTP.REQUEST_PIECES takes a URL as its argument and returns a PL/SQL 
table of 2000 bytes of data retrieved from the given URL. The final element may be 
shorter than 2000 characters. The UTL_HTTP.REQUEST_PIECES return type is a 
PL/SQL table of type UTL_HTTP.HTML_PIECES. 

UTL_HTTP.REQUEST_PIECES, which uses type UTL_HTTP.HTML_PIECES, is 
specified as:

type html_pieces is table of varchar2(2000) index by binary_integer;

function request_pieces (url in varchar2, 

   max_pieces natural default 32767)

return html_pieces;

A call to REQUEST_PIECES can look like the example below. Note the use of the 
PL/SQL table method COUNT to discover the number of pieces returned, which 
may be zero or more:

declare pieces utl_http.html_pieces;

begin 

  pieces := utl_http.request_pieces(’http://www.oracle.com/’); 

   for i in 1 .. pieces.count loop

     .... -- process each piece

   end loop;

end;
8-6 Oracle8 Client



Accessing Web Data with Intercartridge Exchange
The second argument to UTL_HTTP.REQUEST_PIECES, (MAX_PIECES) is 
optional. MAX_PIECES is the maximum number of pieces (each 2000 characters in 
length, except for the last, which may be shorter) that UTL_HTTP.REQUEST_
PIECES returns. If provided, that argument is likely a positive integer. 

For example, the following block retrieves up to 100 pieces of data (each 2000 bytes, 
except perhaps the last) from the URL. The block prints the number of pieces 
retrieved and the total length, in bytes, of the data retrieved. 

set serveroutput on

/

declare 

  x utl_http.html_pieces;

begin

  x := utl_http.request_pieces(’http://www.oracle.com/’, 100);

  dbms_output.put_line(x.count || ’ pieces were retrieved.’);

  dbms_output.put_line(’with total length ’);

  if x.count < 1 

  then dbms_output.put_line(’0’);

  else dbms_output.put_line

((2000 * (x.count - 1)) + length(x(x.count)));

  end if;

end;

/

which outputs:

Statement processed.

4 pieces were retrieved.

with total length 

7687

The elements of the PL/SQL table returned by UTL_HTTP.REQUEST_PIECES are 
successive pieces of data obtained from the HTTP request to that URL. 
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UTL_HTTP Exception Conditions
This section describes the exceptions that can be raised by packaged functions UTL_
HTTP.REQUEST and UTL_HTTP.REQUEST_PIECES.

UTL_HTTP.REQUEST
The PRAGMA RESTRICT_REFERENCES enables exceptions (errors) to be 
displayed:

create or replace package utl_http is

function request (url in varchar2) return varchar2;

pragma restrict_references (request, wnds, rnds, wnps, rnps);

UTL_HTTP.REQUEST_PIECES
The PRAGMA RESTRICT_REFERENCES enables exceptions (errors) to be 
displayed:

create or replace package utl_http is

type html_pieces is table of varchar2(2000) index by binary_integer;

function request_pieces (url in varchar2, 

       max_pieces natural default 32767)

return html_pieces;

pragma restrict_references (request_pieces, wnds, rnds, wnps, rnps);

Exceptional Conditions and Error Messages
This table describes possible error messages that can display:
      

If... Then...

Initialization of the HTTP callout subsystem fails 
for environmental reasons such as lack of 
available memory 

Exception UTL_HTTP.INIT_FAILED is raised:

init_failed exception;

The HTTP call fails because of failure of the 
HTTP daemon or because the argument to 
REQUEST or REQUEST_PIECES cannot be 
interpreted as a URL because it is NULL or has 
non-HTTP syntax

Exception UTL_HTTP.REQUEST_FAILED is raised:

request_failed exception;
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Troubleshooting
Do not expect UTL_HTTP.REQUEST or UTL_HTTP.REQUEST_PIECES to succeed 
in contacting a URL unless you can contact that URL by using a browser on the 
same computer (and with the same privileges, environment variables, etc.). If UTL_

No response is received from a request to the 
given URL because no site corresponding to that 
URL was contacted

A formatted HTML error message may be returned:

<HTML>

<HEAD>

<TITLE>Error Message</TITLE>

</HEAD>

<BODY>

<H1>Fatal Error 500</H1>

Can’t Access Document: 
http://home.nothing.comm.

<P>

<B>Reason:</B> Can’t locate remote host:  
home.nothing.comm.

<P>

<P><HR>

<ADDRESS><A HREF="http://www.w3.org">

CERN-HTTPD3.0A</A></ADDRESS>

</BODY>

</HTML>

Note: The first two exceptions in the table above, unless explicitly 
caught by an exception handler, are reported by this generic 
message:

ORA-06510: PL/SQL: unhandled user-defined 
exception

that shows them as "user-defined" exceptions, although they are 
defined in this system package.

If any other exception is raised during the processing of the HTTP 
request (for example, an out-of-memory error), then function UTL_
HTTP.REQUEST or UTL_HTTP.REQUEST_PIECES reraises that 
exception.

If... Then...
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exception or returns an HTML-formatted error message, yet you believe that the 
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Directory Structures

This appendix describes the default directory structures created when the Oracle8 
database is installed on a Windows NT server and or client computer.

Specific topics discussed are:

■ Client Directory Structure
res A-1
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Client Directory Structure
Oracle Installer places all client products by default into subdirectories of ORACLE_
HOME. 

The subdirectories of a basic Oracle8 Enterprise Edition client installation are shown 
below. If you installed additional products, other subdirectories are created:

  

Directory Name Contents

\BIN Executables, help files, and library files

\CLRN80 Oracle8 Client Release Notes

\CORE40 Oracle8 database message files

\DBS Oracle Toolkit II message files, SQL scripts, and 
other utility files

\JDBC JDBC Drivers

\JRE11 Files and subdirectories that allow Java 
applications to run. It is required by many of the 
Oracle Assistants. \JRE11 contains the following 
subdirectories:

 \BIN Java executable files.

 \CLASSES Oracle Assistants executable files

 \LIB Library files

\MSHELP Windows help files

\NET80 Message files and subdirectories for Net8 products. 
\NET80 contains the following subdirectories:

Additional Information: See Net8 Getting Started 
for Windows NT and Windows 95/98 for additional 
information on the \NET80 directory and its 
subdirectories.

\ADMIN Configuration files used by Net8 for Windows 
NT

\AGENT Oracle Enterprise Manager intelligent agent

\DOCS Readme files

\ERROR Error files placed here by default

\LOG Log files placed here by default
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\MESG Message files

\NAMES SQL scripts used to set up Oracle Names

\NET8ASST Oracle Net8 Assistant files

\TNSAPI TNS API library file

\TRACE Trace files placed here by default

\NLSRTL33 NLS message files. \NLSRTL33 contains the 
following subdirectory:

\DATA Loadable NLS files

\OCI80 Oracle Call Interface (OCI) files. \OCI80 contains 
the following subdirectories:

\INCLUDE Header files

\LIB Borland C++ and Microsoft Visual C++ files

\SAMPLES Sample files

\ORAINST Files used by Oracle Installer. \ORAINST contains 
the following subdirectory:

\NLB .NLB files

\OTRACE80 Oracle Trace files. \OTRACE80 contains the 
following subdirectories:

\ADMIN Oracle Trace administration files, including 
SQL scripts

\INCLUDE Oracle Trace header files

\LIB Oracle Trace library file

\OWAST Oracle Web Publishing Assistant files

\PLSQL80 Message files, SQL scripts, and demonstration files 
for PL/SQL

\PLUS80 SQL*Plus SQL and message files. \PLUS80 
contains the following subdirectory:

\HELP SQL*Plus help files

\PRO80 Oracle8 database message files for Pro*C/C++

Directory Name Contents
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\RDBMS80 Oracle8 Enterprise Edition message, resource, and 
README files. \RDBMS80 contains the following 
subdirectories:

\ADMIN Oracle8 database SQL scripts. Use SQL scripts 
to create data dictionary tables/views, and 
other views used by Oracle software. For more 
information on these scripts, see the chapter 
"SQL Scripts" in Oracle8 Reference.

\AQ Advanced Queuing demos

\EXTPROC External procedures demos

\LOADER Sample files for SQL*Loader

\RMAN Recovery Manager files

\TRACE Informational trace and alert files generated 
by Oracle8 Enterprise Edition

\XA Oracle XA Library files

\SYSMAN Oracle Enterprise Manager files. \SYSMAN 
contains the following subdirectories:

\ADMIN Files and tools

\BMP Bitmap image files

\DOC Documentation

\OLE2 Objects for OLE files

\QTOUR Quick Tour files

\SCRIPTS Scripts

\SDK SDK files

\TEMP Temporary files placed here

Directory Name Contents
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Oracle8 Database Specifications for

Windows NT

 uses initialization parameters to enable various features of the database every time 
an instance is started.

Specific topics discussed are:

■ Initialization Parameter File Overview

■ Initialization Parameters

■ Calculating Database Limits

■ Calculating Index Size

■ Setting Resource Costs
 NT B-1
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Initialization Parameter File Overview
An initialization parameter file is an ASCII text file containing parameters. By 
changing the parameters and values in an initialization file, you can specify, for 
example:

■ the amount of memory the database uses

■ whether to archive filled online redo logs

■ which control files currently exist for the database

Every database instance has a corresponding initialization parameter file and 
ORACLE_SID registry parameter that points to the system identifier (SID) for the 
instance.

The initialization parameter file name takes the form INITSID.ORA, where SID is 
the name of the database instance. For example, the initialization parameter file for 
the first starter database on your computer is named INITORCL.ORA. For each 
subsequent starter database installed on the same computer, the last letter of ORCL 
is replaced by a number and automatically incremented (that is for an initialization 
parameter file for a second starter database, the SID is ORC1, for a third starter 
database, the SID is ORC2, and so on).

A single instance might also have several initialization parameter files, each having 
some differences that affect system performance. 

   

Location of the Initialization Parameter File
By default, Oracle8 uses the initialization parameter files located in ORACLE_
HOME\DATABASE, unless you specify a different initialization file with the PFILE 
option at database startup. 

Editing the Initialization Parameter File
To customize Oracle8 database functions, you may need to edit the initialization 
parameter files. Use any ASCII text editor to modify the file.

Additional Information: See Oracle8 Reference for a complete list 
and descriptions of all initialization parameters.
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Sample File
A sample file called INITSEED.ORA is located in the ORACLE_HOME\DATABASE 
directory. If you want to use this file as part of database creation:

1. Rename the file INITSID.ORA where SID is the system identifier of the 
database instance you want to create.

2. Edit this file to reflect the correct location of your database files and the name of 
your database.

If you installed a starter database, the initialization parameter file INITSID.ORA 
used by the starter database is also located in ORACLE_HOME\DATABASE. You 
can use either INITSEED.ORA or INITSID.ORA as a model for creating a new 
Oracle8 database initialization parameter file.

The annotated, sample initialization parameter file contains alternative values for 
the initialization parameters. These values and the annotations are preceded by 
comment signs (#), which prevent them from being processed. To activate a 
particular parameter, remove the preceding # sign. When you no longer want to use 
a particular parameter, edit the initialization parameter file to add a comment sign.

For example, several initialization parameters are specified with three different 
values to create small, medium, or large System Global Areas (SGAs), respectively. 
The parameter that creates a small SGA is active in the following example:

  db_block_buffers = 200 # SMALL 
# db_block_buffers = 550 # MEDIUM 
# db_block_buffers = 3200 # LARGE 
To create a medium-sized SGA, comment out the small parameter definition and 
activate the medium parameter definition. Edit the initialization parameter file as 
follows:

# db_block_buffers = 200 # SMALL 
  db_block_buffers = 550 # MEDIUM 
# db_block_buffers = 3200 # LARGE 
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Initialization Parameters
Oracle8 Reference includes descriptions of all initialization parameters and 
instructions for setting and displaying their values. The following table describes 
initialization parameters and default values for. 

       
Initialization Parameter Name Default Value Range of Values

AUDIT_TRAIL NONE NONE (FALSE), 
DB (TRUE), OS

BACKGROUND_DUMP_DEST %RDBMSnn%\TRACE\ Any valid directory 

COMPATIBLE 8.0.0.0.0 Default release to current 
release

COMMIT_POINT_STRENGTH 1 0 - 255 

CONTROL_FILES %ORACLE_HOME%\DATABASE\ 
CTL1%ORACLE_SID%.ORA

Any valid path and 
filename 

DB_BLOCK_BUFFERS 200 200 to 3200

DB_BLOCK_SIZE 2048 512 - 163841

DB_FILES 1024 65,536 files2

DB_FILE_MULTIBLOCK_ READ_ COUNT3 8 1 - 314 

DB_FILE_SIMULTANEOUS_ WRITES 4 1 - 24 

DB_NAME ORCx Any valid database name 
limited to a maximum of 
eight characters.

DISTRIBUTED_TRANSACTIONS 5 * TRANSACTIONS 0 - TRANSACTIONS 

DML_LOCKS 300 20 to unlimited

LOG_ARCHIVE_BUFFER_ SIZE 127 1 - 127 

LOG_ARCHIVE_BUFFERS 4 1 - 8

LOG_ARCHIVE_DEST %ORACLE_HOME%\DATABASE\ARCHIVE Any valid directory

LOG_ARCHIVE_FORMAT "%%ORACLE_SID%%T%TS%S.ARC" A valid filename format 

LOG_ARCHIVE_START None TRUE or FALSE

LOG_CHECKPOINT_ INTERVAL 10,000 2 - Unlimited 

LOG_FILES 255 2 - 255 

LOG_SMALL_ENTRY_MAX_ SIZE 80 0 - Unlimited 

MAX_DUMP_FILE_SIZE 10240 0 to 4,000,000
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MTS_DISPATCHERS Unspecified5 User specific

MTS_MAX_DISPATCHERS 5 User specific

MTS_MAX_SERVERS 20 User specific

MTS_SERVERS 0 User specific

MTS_SERVICE SID SID

NLS_LANGUAGE AMERICAN Any valid language

NLS_SORT (Language dependent) (Language dependent)

NLS_TERRITORY AMERICA Any valid territory

OPEN_CURSORS 50 1 - Unlimited

OS_AUTHENT_PREFIX OPS$ Any character string 

PROCESSES 59 3 - Unlimited 

REMOTE_LOGIN_ PASSWORDFILE SHARED SHARED, EXCLUSIVE, 
NONE

SNAPSHOT_REFRESH_PROCESSES 0 0 to 10

SEQUENCE_CACHE_ENTRIES 10 10 to 32000

SHARED_POOL_SIZE 11,534,336 300 KB - Unlimited 

SORT_AREA_SIZE 65536 0 - Unlimited 

SORT_READ_FAC 20 0 - Unlimited 

SORT_SPACEMAP_SIZES 512 0 - Unlimited 

TEXT_ENABLE TRUE TRUE or FALSE

TEMPORARY_TABLE_LOCKS 69 0 - Unlimited 

TIMED_STATISTICS FALSE TRUE or FALSE

TRANSACTIONS_PER_ROLLBACK_SEGMENT 11 1 - 255 

USER_DUMP_DEST %RDBMSnn%\TRACE Any valid directory 

1 The Range of Values for DB_BLOCK_SIZE on a 7.3.x database is 512 to 8192.
2 See section, "Calculating Database Limits" for more information.
3 DB_FILE_MULTIBLOCK_READ_COUNT is used to determine the number of blocks that are read in one batch. For 

example, if DB_BLOCK_SIZE is equal to 8 KB and DB_FILE_MULTIBLOCK_READ_COUNT is equal to 16, then the amount 
of I/O data that is read at once is (8 * 16) 128 KB. Ensure that the I/O data size you define does not exceed the MAX_IO_
SIZE limit of 1 MB for release 8.0.5. MAX_IO_SIZE is not a configurable parameter. Note that if the values you set for DB_
BLOCK_SIZE and DB_FILE_MULTIBLOCK_READ_COUNT exceed 1 MB, you do not receive an error message, but the I/O 
data size value defaults to 1 MB. See the chapter "Initialization Parameters" in Oracle8 Reference for more information on DB_
FILE_MULTIBLOCK_READ_COUNT and MAX_IO_SIZE.

4 Depends on value for DB_BLOCK_SIZE parameter.
5 To use MTS, manually set this parameter to the following value: "(PRO=TCP)".

Initialization Parameter Name Default Value Range of Values
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Initialization Parameters Without Windows NT-Specific Values
Oracle8 Reference describes the default values for many initialization parameters as 
being operating system-specific. Parameters with Windows NT-operating system 
specific settings are described in the previous section. However, not all the 
parameters that Oracle8 Reference describes as having operating system-specific 
values affect Windows NT. In these cases, Windows NT uses either the default value 
set in the Oracle8 kernel or does not use the parameter. This table describes these 
initialization parameters:

Displaying Initialization Parameter Values
Windows NT-specific parameter values can be viewed by using an ASCII editor to 
open the ORACLE_HOME\DATABASE\INITSID.ORA file. To display all 
parameter values (whether set in the INITSID.ORA file or the Oracle8 kernel), enter 
the following command at the Server Manager command prompt:

SVRMGR> SHOW PARAMETER PARAMETER_NAME

where PARAMETER_NAME is the name of a specific initialization parameter.

The value for this parameter, whether defined in the ORACLE_HOME\DATABASE 
\INITSID.ORA file or the Oracle8 kernel, displays on-screen.

Parameter Description

COMPATIBLE_NO_RECOVERY Uses default value set in Oracle8 kernel (no Windows NT-specific value).

CPU_COUNT Oracle8 automatically sets value to number of CPUs available for your 
Oracle instance.

HI_SHARED_MEMORY_ADDRESS Not applicable to Windows NT.

SHARED_MEMORY_ADDRESS Not applicable to Windows NT.

LARGE_POOL_SIZE Uses maximum value of at least 2 GB. 

LOG_BUFFER Starter database uses value set in Oracle8 kernel (no Windows NT-specific 
value). The Custom option of the Oracle Database Assistant enables you to 
customize the value for this parameter.

ORACLE_TRACE_COLLECTION_PATH Uses default value set in Oracle8 kernel (no Windows NT-specific value) 

ORACLE_TRACE_FACILITY_NAME Uses default value set in Oracle8 kernel (no Windows NT-specific value) 

ORACLE_TRACE_FACILITY_PATH Uses default value set in Oracle8 kernel (no Windows NT-specific value) 

SPIN_COUNT Uses default value set in Oracle8 kernel (no Windows NT-specific value) 
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Database Initialization Parameters
Check the following initialization parameters when creating a new database. They 
cannot be modified after you have created the database. See Chapter 7, "Creating a 
Database" for details on creating a new database, including the part of the 
procedure when you modify these parameters. 

  

Calculating Database Limits
Use the size guidelines in the following table to calculate Oracle8 database limits 
using the equations given in Oracle8 Administrator’s Guide.   

Parameter Description

CHARACTER SET1 

1 Not an initialization parameter, but rather a clause in the CREATE DATABASE statement. See 
Chapter 7, "Creating a Database" for an example of using this clause.

Specifies the database National Language Support (NLS) 
character set to use. This parameter can be set only when you 
create the database.

DB_BLOCK_SIZE Specifies the size in bytes of Oracle database blocks.

DB_NAME Specifies the name of the database to be created. The database 
name is a string of eight characters or less. You cannot change 
the name of a database.

Type Size

Maximum block size 16,384 bytes (K)

Maximum blocks per file 4,194,304 million blocks

Maximum possible file size with 16 
K blocks

64 Gigabytes (GB)
(4,194,304 * 16 K) / 1024 / 1024 = 64 GB

Maximum number of files per 
database (depends on block size):

 2 K blocks 20,000 files

 4 K blocks 40,000 files

 8 K blocks 65,536 files

Maximum file size for a FAT file 4 GB

Maximum file size in NTFS 16 Exabytes (EB)
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Calculating Index Size
Use the size guidelines in the following table to calculate the space required by an 
index using the equations given in Oracle8 Administrator’s Guide.   

Setting Resource Costs
You can limit user access to database resources by assigning costs to each resource. 
Define resource costs through user profiles. Oracle limits database usage and 
instance resources to whatever is defined in the user’s profile. Follow the 
information and recommendations in the chapter "Managing Users and Resources" 
of to set resource costs on Windows NT. 

Maximum database size 65,536 * 64 GB equals approximately 4 Petabytes (PB)

Shadow Process Memory:

Release 8.0.5 233 KB

Release 8.0.4 254 KB

Type Size

Fixed header size 113 bytes

Variable transaction header 24*INITRANS value for the index

Entry header 5 bytes

Type Size
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Configuration Parameters and the Registry

The registry stores Oracle configuration parameters. This appendix describes only 
the configuration parameters that apply to. 

Specific topics discussed are:

■ About Configuration Parameters

■ Registry Overview

■ Registry Parameters

■ Modifying a Registry Value

■ Adding a Registry Parameter
istry C-1



Registry Overview
About Configuration Parameters
Oracle8 uses configuration parameters to locate files and specify runtime 
parameters common to all Oracle products. When an Oracle program or application 
requires a translation for a particular configuration variable, Oracle8 consults the 
associated parameter. Oracle parameters are stored in the registry.

Registry Overview
Oracle8 stores its configuration information in a database (the registry) that is 
organized in a tree format. The tree format consists of keys in the registry and 
parameter values for the keys. Keys and parameter values can be viewed and 
modified in the Registry Editor. 

Keys are folders that appear in the left pane of a Registry Editor window. A key 
contains subkeys or parameters.

Parameters in the Registry Editor appear as a string that consists of three 
components:

■ name of the parameter

■ value class or type of entry

■ value itself

For example, parameter ORACLE_SID can have the following entry in the registry:

ORACLE_SID:REG_EXPAND_SZ:ORCL

Value classes for parameters are: 

■ string value with a REG_SZ, REG_EXPAND_SZ (for an expandable string), or 
REG_MULTI_SZ (for multiple strings) prefix to identify a parameter value 
entry as a data string

■ binary value with a REG_DWORD prefix to identify a value entry as a DWORD 
(hexadecimal data) entry

Warning: The Registry Editor allows you to view and modify 
registry keys and parameter values. Normally, you do not need to 
do so, and in fact, are liable to break your system if you make 
incorrect changes. Only advanced users should use the registry!
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Registry Parameters
This section describes the following Oracle8 database registry parameters. Other 
products, such as Oracle Enterprise Manager, have additional keys and parameters 
not described in this appendix. 

■ Parameters for Most Oracle Products

■ Parameters Describing Each Oracle Home Directory on a Computer

■ Parameters for Oracle8 Performance Monitor

■ Parameters for Oracle Services

To modify the registry values described below, see "Modifying a Registry Value" in 
this appendix.

Parameters for Most Oracle Products
This section describes the following parameter types:

■ Product and Installation Parameters

■ Installation Parameters for Computers with One Oracle Home

Parameters for most Oracle products are contained within the HKEY_LOCAL_
MACHINE\SOFTWARE\ORACLE subkey. The exact location of parameters within 
this key depends on the number of Oracle home directories created on your 
computer. For the first installation, two registry subkeys are created for storing 
product and installation parameters. For all additional installations, only one 
registry subkey is created for storing product and installation parameters. 
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The following table describes this process:

For... Parameters are Created in Subkey... This Subkey Contains...

The first Oracle 
home installation

HKEY_LOCAL_MACHINE\SOFTWARE\ 
ORACLE

Product and installation parameters.

See "Product and Installation 
Parameters" for parameter descriptions.

HKEY_LOCAL_MACHINE\SOFTWARE\ 
ORACLE\HOME0

Several parameters specific to Oracle 
Installer. 

See "Installation Parameters for 
Computers with One Oracle Home" for 
parameter descriptions.

The second Oracle 
home installation

HKEY_LOCAL_MACHINE\SOFTWARE\ 
ORACLE\HOME1

Product and installation parameters.

See "Product and Installation 
Parameters" for parameter descriptions

The third Oracle 
home installation

HKEY_LOCAL_MACHINE\SOFTWARE\ 
ORACLE\HOME2

Product and installation parameters.

See "Product and Installation 
Parameters" for parameter descriptions

All additional 
Oracle home 
installations

HKEY_LOCAL_MACHINE\SOFTWARE\ 
ORACLE\HOMEID 

where ID is incremented for each additional 
Oracle home installation.

Product and installation parameters.

See "Product and Installation 
Parameters" for parameter descriptions
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This figure shows the parameter subkeys created with two Oracle home directories 
on the same computer:

Product and Installation Parameters
This section lists the product and installation parameters for most Oracle products. 
See the table in the previous section "Parameters for Most Oracle Products" to 
identify the subkey under which these parameters appear.

      

The first Oracle installation 
on a computer creates 
parameter subkeys 
ORACLE and HOME0.

The second Oracle installation on a 
computer creates parameter subkey 
HOME1. With each installation, 
HOMEID is incremented.
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Parameter Description Default Value Entry

A2OWIZ80 Specifies the location of Oracle Migration Assistant 
for Microsoft Access files.

ORACLE_HOME\A2OWIZ80

API Specifies the location of files for Oracle Installer. ORACLE_HOME\DBS

COMPANY_
NAME

Specifies the name of the company entered during 
the installation process.

company name entered during 
installation

CORE40 Specifies the location of the database message files. ORACLE_HOME\CORE40

EXECUTE_SQL Specifies the executable to spawn SQL*Plus for the 
Oracle Installer.

PLUS80

ID Specifies the HOMEID of the Oracle home 
directory. The first Oracle home is always specified 
as zero.

0

MSHELP Specifies the location from where Windows help is 
invoked.

ORACLE_HOME\MSHELP

MSHELP_TOOLS Specifies the location of the Windows help files. ORACLE_HOME\MSHELP

NET80 Specifies the location of the Net8 directory. ORACLE_HOME\NET80

NLS_LANG Specifies the supported language, territory, and 
character set. This parameter specifies the language 
in which the messages are displayed, the territory 
and its conventions for calculating week and day 
numbers, and the character set displayed. The 
default value causes all messages to be displayed 
in American English.

AMERICAN_AMERICA. 
WE8ISO885981

NLSRTL32 Specifies the location of the Oracle7 NLS message 
files.

ORACLE_HOME\NLSRTL32

NLSRTL33 Specifies the location of the Oracle8 database NLS 
message files.

ORACLE_HOME\ORAINST\NLB

OI_NLS32 Specifies the value of ORA_NLS32 used by Oracle 
Installer during the installation process.

ORACLE_HOME\ORAINST\NLB

ORA_EXTPROC_ 
THREADED

Specifies to use multiple, lightweight threads 
instead of a single dedicated user process when 
using external procedures.

FALSE

ORA_NLS32 Specifies the location of the system boot file and 
NLS loadable data files used by the Oracle7 
NLSRTL.

ORACLE_HOME\NLSRTL32
\DATA

ORA_NLS33 Specifies the location of the system boot file and 
NLS loadable data files used by NLSRTL.

ORACLE_HOME\NLSRTL33
\DATA
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ORA_SID_ PWFILE Specifies the name of the password file containing 
the password for the database instance designated 
by the system identifier (SID).

ORACLE_HOME\DATABASE\ 
PWDSID.ORA

ORA_SID_ 
SHUTDOWN

When set to TRUE, shuts down the Oracle8 
database identified by the SID value when 
OracleServiceSID is stopped.

Note: This registry entry must be manually added.

Not applicable

ORA_SID_
SHUTDOWN_
TIMEOUT

Sets the maximum time to wait for the shutdown 
to complete before the service for a particular SID 
stops.

Note: This registry entry must be manually added.

Not applicable

ORA_SHUTDOWN When set to TRUE, enables the selected Oracle8 
database to be shut down when OracleServiceSID 
is stopped.

FALSE

ORA_
SHUTDOWN_
TIMEOUT

Sets the maximum time to wait for the service to 
stop. 

You may set ORA_SHUTDOWN_TIMEOUT to any 
value greater than 30 seconds; values less than 30 
are ignored. 

Note: This registry entry must be manually added.

Not applicable

ORACLE_GROUP_
NAME

Specifies the name of the group containing icons of 
the Oracle products installed. The parameter is 
added to your registry when you first install Oracle 
products, even if Oracle Installer does not create a 
program group for the Oracle products you have 
installed. (For example, if you have installed only 
Net8 software.)

Oracle for Windows NT

ORACLE_HOME Specifies the Oracle home directory in which 
Oracle products are installed. This directory is the 
top directory in the Oracle directory hierarchy. 

C:\ORANT

ORACLE_HOME_ 
NAME

Specifies the home name of the Oracle home 
directory in which Oracle products are installed. 

DEFAULT_HOME

ORACLE_HOME_ 
SERVICE

Specifies the home name of the Oracle home 
directory. This value appears in Oracle service 
names. Since no home name is required for the first 
Oracle installation, this parameter is not available 
for the first Oracle home installation; only 
subsequent Oracle home installations (for example, 
HOME1, HOME2, and so on) use this parameter.

The name that you specify during 
installation.

Parameter Description Default Value Entry
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ORACLE_
PRIORITY

Determines the Windows NT scheduling priorities 
of the threads within the Oracle ORDBMS or 
DBMS process. The format is:

name1:priority1;name2:priority2 . . .

CLASS:normal; DEF:normal

The name CLASS sets the priority 
class of the Oracle process. 
Threads can be assigned priority 
either collectively or individually. 
The collective name USER 
designates non-background 
(shadow) threads; the collective 
name DEF designates any thread 
type not handled specifically. 
Valid individual background 
thread names are DBWR, LGWR, 
PMON, SMON, ARCH, RECO, 
CKPT, TRWR, and SNP0 through 
SNP9. 

Note: ORACLE_PRIORITY is not 
automatically created for you in 
the registry. When it is not defined 
in the registry, the Windows NT 
default values are used for the 
priorities of the thread. 

ORACLE_SID Specifies the name of the Oracle8 database instance 
on the host machine. The value of this parameter is 
the SID for the instance.

ORCL for the first Oracle product 
installation on a computer. For 
additional Oracle home 
installations, ORCL is incremented 
(for example, ORC1 for a second 
installation, ORC2 for a third 
installation, and so on)

OTRACE73 Specifies the location of the Oracle7 trace files. ORACLE_HOME\OTRACE73

OTRACE80 Specifies the location of the trace files. ORACLE_HOME\OTRACE80

OTT_DFLT Specifies the executable used when OTT80.EXE is 
called. 

OTT80

OTT80 Specifies the location of the Object Type Translator 
(OTT) files.

ORACLE_HOME\OTT80

OWAST Specifies the location of the Oracle Web Publishing 
Assistant files.

ORACLE_HOME\OWAST

PLSQL23 Specifies the directory in which Oracle7 looks for 
PL/SQL message files. 

ORACLE_HOME\PLSQL23

PLSQL80 Specifies the directory in which looks for PL/SQL 
message files. 

ORACLE_HOME\PLSQL80

Parameter Description Default Value Entry
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PLUS_DFLT Specifies the executable used when SQLPLUS.EXE 
is called. 

PLUS80

PLUS80 Specifies the location in which to find the files 
needed to run SQL*Plus.

ORACLE_HOME\PLUS80

PRO18 Specifies the location of Oracle7 Pro*C/C++ files. ORACLE_HOME\PRO18

PRO80 Specifies the location of Pro*C/C++ files. ORACLE_HOME\PRO80

RDBMS73 Specifies the directory Oracle7 Server and the 
Oracle7 Utilities use to locate messages, resource 
files, and SQL scripts. 

ORACLE_HOME\RDBMS73

RDBMS80 Specifies the directory the Oracle8 database and 
the Oracle8 Utilities use to locate messages, 
resource files, and SQL scripts. 

ORACLE_HOME\RDBMS80

RDBMS80_
ARCHIVE

Specifies the location of the backup database files. ORACLE_HOME\DATABASE
\ARCHIVE

RDBMS80_
CONTROL

Specifies the location of the database control files. ORACLE_HOME\DATABASE

SHARED_
ORACLE_HOME

Specifies the Oracle home directory used by Oracle 
Installer.

ORACLE_HOME

SQLPATH Specifies the location of the SQL scripts that 
SQL*Plus uses for searching SQL scripts. 

ORACLE_HOME\DBS

SVRMGR Specifies the location of Server Manager support 
files.

ORACLE_HOME\DBS

Parameter Description Default Value Entry
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Installation Parameters for Computers with One Oracle Home
The HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE\HOME0 subkey only 
contains the following parameters for the first Oracle home directory on a 
computer. This information is largely duplicated in HKEY_LOCAL_MACHINE\ 
SOFTWARE \ORACLE.
 

Parameter Description Default Value Entry

API Specifies the location of files for Oracle Installer. ORACLE_HOME\DBS

COMPANY_
NAME

Specifies the name of the company entered during 
the installation process.

company name entered during 
installation

ID Specifies the HOMEID of the Oracle home. The first 
Oracle home is always specified as zero.

0

NLS_LANG Specifies the language in which the messages are 
displayed, the territory and its conventions for 
calculating week and day numbers, and the 
character set displayed. The default value causes all 
messages to be displayed in American English.

AMERICAN_AMERICA. 
WE8ISO885981

ORACLE_GROUP_
NAME

Specifies the name of the group containing icons of 
the Oracle products installed. The parameter is 
added to your registry when you first install Oracle 
products, even if Oracle Installer does not create a 
program group for the Oracle products you have 
installed. (For example, if you have installed only 
Net8 software.)

Oracle for Windows NT

ORACLE_HOME Specifies the Oracle home directory in which Oracle 
products are installed. This directory is the top 
directory in the Oracle directory hierarchy. 

ORACLE_HOME

ORACLE_HOME_ 
NAME

Specifies the home name of the Oracle home 
directory in which Oracle products are installed. 

DEFAULT_HOME

SHARED_
ORACLE_HOME

Specifies the Oracle home directory used by Oracle 
Installer.

ORACLE_HOME\DATABASE
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Parameters Describing Each Oracle Home Directory on a Computer
The HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE\ALL_HOMES subkey 
provides general information on each Oracle home directory on a computer. This 
subkey contains the following parameters:

■ IDx subkey(s)

■ the following parameters:

IDx
This subkey corresponds to the HOMEID of the same number (for example, 
HOME0 for the first installation, HOME1 for the second installation, and so on). IDx 
contains the following parameters. The values that display are determined by what 
you select during installation in the Oracle Installation Settings dialog box.

Parameter Description Default Value Entry

DEFAULT_HOME Specifies the default Oracle home name (that is, the 
first Oracle home installed on your machine).

DEFAULT_HOME

HOME_COUNTER Specifies the number of installed Oracle homes. 1

LAST_HOME Displays the ID number of the most recently 
installed Oracle home. For example, if HOME1 was 
the most recently installed, the number 1 appears.

1

Parameter Description Default Value Entry

NAME Specifies the home name of the Oracle home for 
IDx. This is the value you specify when prompted 
for an Oracle home name.

DEFAULT_HOME for the first 
Oracle home

NLS_LANG Specifies the supported language, territory, and 
character set for IDx.

AMERICAN_AMERICA. 
WE8ISO885981

PATH Specifies the Oracle home directory for IDx. ORACLE_HOME
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Parameters for Oracle8 Performance Monitor 
Depending on the number of Oracle home directories on your computer, Oracle8 
Performance Monitor parameters appear in one of the following subkeys:
   

  

For Oracle8 Performance Monitor to display information for Oracle8 performance 
objects, it must log onto the database. Modify the following parameters if the 
default information is not applicable or you want to access another database: 

If You Have... Then Parameters Appear in...

One Oracle 
home 

HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet 
\Services\Oracle80\Performance

Additional 
Oracle homes

HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet 
\Services\OracleHOME_NAME80\Performance

where HOME_NAME is the unique Oracle home name you specified 
during installation for each additional Oracle home.

Note: Modify only the Hostname, Password, and Username 
values to point to any database.

Parameter Description Default Value Entry

Password Displays the password for the user name to access the database. MANAGER

Username Displays the user name to access the database. SYSTEM
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The following parameters are needed by the Oracle8 Performance Monitor as entry 
points:  
   

The following parameters specify the Oracle8 Performance Monitor log file and 
object configuration files: 

Hostname Displays a Net8 connect string that allows you to edit the SID (two 
entries labeled SID in this example):1

DESCRIPTION=

  (ADDRESS_LIST=

    (ADDRESS=

      (PROTOCOL=BEQ)

      (PROGRAM=oracle80)

      (ARGV0=oracle80SID)

      (ARGS=’(DESCRIPTION=(LOCAL=YES)(ADDRESS=
(PROTOCOL=beq)))’)

    )

  )

  (CONNECT_DATA=(SID=SID)) 

)

Not applicable

1 The 2:, 2:orcl, and 2:sid connect strings for local connections to  are not supported. Instead, the new default connect string for 
a local connection uses the Bequeath Protocol Adapter.

Parameter Description Default Value Entry

Close Specifies the close entry point for the DLL. CloseOracle8PerformanceData

Collect Specifies the collect entry point for the DLL. CollectOracle8PerformanceData

Open Specifies the open entry point for the DLL. OpenOracle8PerformanceData

Library Specifies the name of the Oracle8 Performance 
Monitor DLL.

OPERF80.DLL

Parameter Description Default Value Entry
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Parameters for Oracle Services
The HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services subkey 
contains subkeys that correspond to each Oracle service.

Each service subkey contains the following parameters: 

Parameter Description Default Value Entry

LOGFILE Specifies the name of the Oracle8 Performance 
Monitor log file. This log file reports any errors, 
such as Oracle8 objects not displaying or database 
access problems.

ORACLE_HOME\DBS
\OPERF80.LOG

PERF__FILE_
NAME

Specifies the location of PERF80.ORA. 
PERF80.ORA contains all the performance objects 
displayed by the Oracle8 Performance Monitor.

ORACLE_HOME\DBS\PERF80.ORA

Parameter Description Default Value Entry

DisplayName Specifies the service name of the instances whose 
SID is SID.

Name of the service. For example, 
OracleServiceORCL, where ORCL is 
the SID.

ImagePath Specifies the fully-qualified path name of the 
executable invoked by the service and any 
command-line arguments passed into the 
executable at runtime. 

Path to the executable file of the 
product. For example, ORACLE_
HOME\BIN
\ORACLE80.EXE, if OracleNames80 
is selected.

ObjectName Specifies the logon user account and machine to 
which the service should log on.

LocalSystem
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Modifying a Registry Value 

To edit the Oracle-related settings:

1. Start the registry in either of two ways:

■ From the command prompt, enter:

C:\> REGEDT32

■ Choose Start > Run, enter REGEDT32 in the Open field, and click OK.

CAUTION: Do not edit your registry unless it is absolutely 
necessary. If there is an error in your registry, Oracle8 Enterprise 
Edition may become nonfunctional. In fact, the registry itself can 
become unstable.
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The Registry Editor window appears:

2. Navigate to the values you want to view or modify by double-clicking keys.

The left-hand side of the window shows the hierarchy of registry keys, and the 
right-hand side of the window shows various values associated with a key.

3. Double-click the parameter to edit.
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An editor dialog box appears:

4. Make any necessary edits.

5. Click OK.

6. Choose Exit from the registry menu.

Adding a Registry Parameter
To add a parameter to the registry:

1. Start the registry in either of two ways:

■ From the MS-DOS command prompt, enter:

C:\> REGEDT32

■ Choose Start > Run, enter REGEDT32 in the Open field, and click OK.

The Registry Editor window appears.

2. Navigate to the key where you want to add the new value.

3. Choose the Add Value option in the Edit menu.

The Add Value dialog box appears:

4. In the Value Name field, enter the name that you want to assign to the currently 
selected key.
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5. In the Data Type box, select the value class that you want to assign to the added 
value:

■ REG_SZ, REG_EXPAND_SZ (for an expandable string), or REG_MULTI_SZ 
(for multiple strings) for a data string

■ binary value with a REG_DWORD prefix to identify a value entry as a 
DWORD (hexadecimal data) entry

6. Click OK.

An editor dialog box appropriate for the data type appears:

7. Enter the value itself for the parameter.

The Registry Editor adds the parameter. 

8. Choose Exit from the Registry menu.

The registry exits.
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Messages and Codes

This appendix lists the error messages, causes, and corrective actions that are 
specific to the installation and operation of Oracle8 Client for Windows NT. 

Specific topics discussed are:

■ Logging Error Messages

■ Oracle Installer Error Messages

■ Codes 09200-09499: Oracle8 Database Messages

■ Codes 04000-04999: Windows NT-Specific Oracle Messages
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Oracle Installer Error Messages
Logging Error Messages 
Keep a log of error messages you receive from the Oracle8 Utilities by redirecting 
the messages to a file. You can record the contents of normal utility messages by 
using the LOGFILE parameter discussed in Oracle8 Utilities. You can separately 
record the error message portion by using standard Windows NT file redirection. 
For example, use the following syntax to redirect the output from the Export utility: 

C:\> EXP80 USERNAME/PASSWORD PARFILE=FILENAME >FILE1.LOG 2>FILE2.ERR

In this command line, FILE1.LOG receives the standard output from Export, while 
FILE2.ERR receives the standard error messages.

Oracle Installer Error Messages
This section lists error messages that can occur while using Oracle Installer. Most 
Oracle Installer error messages are accompanied with corrective information on the 
screen; therefore, they are not listed in this appendix. This appendix lists error 
messages in alphabetical order and provides the probable cause and corrective 
action. 

Error Cause Action

DISK_FULL There is not enough disk space on the 
destination volume to copy the selected 
program.

Create space on the destination 
volume.

DRIVE_LOCKED The device specified in the full error 
message is in use or locked by another 
process.

Terminate or release the other 
process, or wait for it to complete.

FILE_CORRUPTED The file or directory specified in the full 
error message is damaged or not readable.

Try to repair or replace the file or 
repair the directory specified.

FILE_NOT_FOUND It was not possible to locate a file on the 
source or destination media. 

Run a utility program to locate any 
problems with the source or 
destination media; the media could 
be the CD-ROM drive, a network 
drive, or a floppy drive. 

INVALID_FILE_NAME The file or directory name or volume label 
specified in the full message is 
syntactically incorrect.

Specify the file, directory, or volume 
using the correct syntax.

LEXICAL_ERROR An error has been detected in the 
installation scripts.

Call Oracle Support Services.
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LOCKING_VIOLATION A portion of the file specified in the full 
message has been locked by another 
process.

Release or terminate the other 
process, or wait for it to complete.

OS_ERROR There is an unexpected operating system 
error. 

Run a utility program to locate any 
problems with the source or 
destination media; the media could 
be the CD-ROM drive, a network 
drive, or a floppy drive. 

PERMISSION_DENIED The network has denied permission to 
perform the selected action. 

Check with the network 
administrator; make sure you have 
Administrator privileges and can 
perform the selected action. 

READ_ERROR A problem has been detected on the 
source or destination media while 
executing an I/O operation. 

1. If in a networking 
environment, verify that you 
have read permission for the 
networking file.

2. Run a utility program to locate 
any problems with the source 
or destination media; the 
media could be the CD-ROM 
drive, a network drive, or a 
floppy drive.

RECALIBRATION_FAILURE A hardware problem has been detected on 
the hard drive to which you are installing.

Run a utility program to diagnose 
the hard drive.

SHARING_VIOLATION The file specified in the full message has 
been locked by another process. (This 
error is similar to the LOCKING_
VIOLATION message, which relates to a 
portion of a file.)

Release or terminate the other 
process, or wait until it completes.

TOO_MANY_OPEN_FILES Too many files are open on Windows NT. Close some of the open files.

WRITE_ERROR A problem has been detected on the 
destination media while executing an 
input/output (I/O) operation. 

1. If you are in a network 
environment and installing 
onto the network, verify that 
you have permission to write 
to a network directory. 

2. Run a utility program to locate 
any problems with the source 
or destination media; the 
media could be the CD-ROM 
drive, a network drive, or a 
floppy drive.

Error Cause Action
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Codes 09200-09499: Oracle8 Database Messages
This section lists error messages issued by the Oracle8 database. Each one is 
triggered by an operating system-dependent (OSD) message specific to Windows 
NT that specifies the error condition signalled. The OSD messages appear in the 
next section. When you receive one of these messages, look up the accompanying 
OSD message number listed in the section, "Codes 04000-04999: Windows 
NT-Specific Oracle Messages" for an explanation of the error.

 

WRITE_PROTECTED The file or directory specified in the full 
message (in which Oracle software is to be 
installed) is write-protected. 

Remove the write-protection from 
the specified file or directory.

Message Signal

ORA-09200 sfccf: error creating file

ORA-09201 sfcopy: error copying file

ORA-09202 sfifi: error identifying file

ORA-09203 sfofi: error opening file

ORA-09204 sfotf: error opening temporary file

ORA-09205 sfqio: error reading or writing to disk

ORA-09206 sfrfb: error reading from file

ORA-09207 sfsrd: error reading from file

ORA-09208 sftcls: error closing file

ORA-09209 sftget: error reading from file

ORA-09210 sftopn: error opening file

ORA-09211 sfwfb: error writing to file

ORA-09212 sfwfbmt: error writing to file

ORA-09213 slgfn: error fabricating file name

ORA-09214 sfdone: I/O error detected 

ORA-09215 sfqio: error detected in I/O completion routine

ORA-09216 sdnfy: bad value ’%s’ for parameter %s

ORA-09217 sfsfs: failed to resize file

ORA-09218 sfrfs: failed to refresh file size

Error Cause Action
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ORA-09240 smpalo: error allocating PGA memory

ORA-09241 smsalo: error allocating SGA memory

ORA-09242 smscre: error creating SGA

ORA-09243 smsget: error attaching to SGA

ORA-09244 smprset: error setting memory protections

ORA-09245 smcstk: error switching stacks

ORA-09246 sfsmap: unable to map SGA

ORA-09247 smsdes: error destroying the SGA

ORA-09260 sigpidu: error obtaining process id

ORA-09261 spdcr: error creating detached (background) process

ORA-09262 spdde: error terminating detached (background) process

ORA-09263 spini: error initializing process

ORA-09264 sptpa: error flagging process

ORA-09265 spwat: error temporarily suspending process 

ORA-09266 spawn: error starting an Oracle process

ORA-09270 szalloc: error allocating memory for security

ORA-09271 szlon: error verifying user name

ORA-09272 remote OS log on is not allowed

ORA-09273 szrfc: error verifying role name

ORA-09274 szrfc: insufficient role name buffer space

ORA-09280 sllfcf: error closing file

ORA-09281 sllfop: error opening file

ORA-09282 sllfrb: error reading records

ORA-09283 sllfsk: error skipping records

ORA-09290 sksaalo: error allocating memory for archival

ORA-09291 sksachk: invalid device specification for LOG_ARCHIVE_DEST

ORA-09292 sksabln: unable to build file name

ORA-09293 sksasmo: unable to send message to console

ORA-09300 osncon: unable to connect, DPMI not available

ORA-09301 osncon: local kernel only supported in standard mode

ORA-09310 sclgt: error freeing latch

Message Signal
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ORA-09311 slsleep: error temporarily suspending process

ORA-09312 slspool: error spooling file to printer

ORA-09313 slsprom: error prompting user

ORA-09314 sltln: error translating logical name

ORA-09315 sql2tt: two-task error translating ORACLE_EXECUTABLE

ORA-09316 szrpc: unable to verify password for role

ORA-09317 szprv: insufficient privileges

ORA-09318 slkhst: error hosting out to operating system

ORA-09319 slgtd: unable to obtain the current date and time

ORA-09320 szrfc: unable to obtain the list of valid OS roles

ORA-09321 slzdtb: unable to convert zoned decimal to binary

ORA-09322 slpdtb: unable to convert packed decimal to binary

ORA-09330 session terminated internally by Oracle or by an Oracle DBA

ORA-09331 scgcan: unable to process lk_sync_cancel return code

ORA-09332 scgcc: unable to process lk_close return code

ORA-09333 scggc: unable to process lk_open_convert return code

ORA-09334 scggc: unable to process lk_convert return code

ORA-09335 scgcm: unable to process return code in completion procedure

ORA-09340 specified ORACLE_SID is either invalid or too long 

ORA-09341 scumnt: unable to mount database

ORA-09342 Detached process terminated by Oracle during SHUTDOWN ABORT

Message Signal
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Codes 04000-04999: Windows NT-Specific Oracle Messages
The error messages in this section are Oracle operating system-dependent (OSD) 
messages issued in response to an error condition in Windows NT. Each message in 
this section triggers an Oracle8 database error message, listed in the previous 
section, "Codes 09200-09499: Oracle8 Database Messages". 

■ File I/O Errors: OSD-04000 to OSD-04099

■ Memory Errors: OSD-04100 to OSD-04199

■ Process Errors: OSD-04200 to OSD-04299

■ ORADEBUG Errors: OSD-04221 to OSD-04225

■ Loader Errors: OSD-04300 to OSD-04399

■ Semaphore Errors: OSD-04400 to OSD-04499

■ Miscellaneous Errors: OSD-04500 to OSD-04599

File I/O Errors: OSD-04000 to OSD-04099
OSD-04000

Logical block size mismatch
Cause:  The database block size specified in the initialization parameter file 
does not match the block size of the actual database files.

Action:  Use matching logical block sizes.

OSD-04001
Invalid logical block size
Cause:  The logical block size is not a multiple of 512 bytes, or it is too large. 

Action:  Change the value of DB_BLOCK_SIZE in the initialization parameter 
file.

OSD-04002
Unable to open file
Cause:  The specified path or file name is invalid, or the destination device is 
full. This error can also be caused by insufficient Windows NT file handles. 

Action:  Make sure the path and file exist, and the device has free space. If this 
fails, increase the number of Windows NT file handles. 
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OSD-04003
Unable to read file header block
Cause:  The media has been damaged. 

Action:  Recover the file if necessary, and verify that Windows NT is 
functioning correctly. 

OSD-04004
Invalid file header
Cause:  The file is corrupted. 

Action:  Recover the file. 

OSD-04005
SetFilePointer() failure, unable to read from file
Cause:  There was an unexpected return from the Windows NT system service, 
SetFilePointer(). 

Action:  Check the operating system error code and consult the Windows NT 
documentation. 

OSD-04006
ReadFile() failure, unable to read from file
Cause:  There was an unexpected return from the Windows NT system service, 
ReadFile(). 

Action:  Check the operating system error code and consult the Windows NT 
documentation.

OSD-04007
Truncated read
Cause:  The system encountered an unexpected end-of-file, which is due to 
damaged media. 

Action:  Verify that the file is not damaged. 
D-8 Oracle8 Client



Codes 04000-04999: Windows NT-Specific Oracle Messages
OSD-04008
WriteFile() failure, unable to write to file
Cause:  There was an unexpected return from the Windows NT system service, 
WriteFile(). 

Action:  Check the operating system error code and consult the Windows NT 
documentation. 

OSD-04009
Truncated write
Cause:  The destination device is full or the media is damaged.

Action:  Verify that the device has free space and the file is not damaged. 

OSD-04010
<create> option specified, file already exists
Cause:  The file you attempted to create already exists.

Action:  Delete the existing file or use the REUSE option in the SQL statement. 

OSD-04011
GetFileInformationByHandle() failure, unable to obtain file info
Cause:  There was an unexpected return from the Windows NT system service, 
GetFileInformationByHandle().

Action:  Check the operating system error code and consult the Windows NT 
documentation. 

OSD-04012
File size mismatch
Cause:  The file to be re-used is either too large or too small.

Action:  Specify the correct file size or delete the existing file. 

OSD-04013
Unable to read line from file
Cause:  This error is caused by an operating system error or by damaged media. 

Action:  Check the operating system error code (if available) and consult the 
Windows NT documentation. If no operating system error code is presented, 
verify that the media is not damaged. 
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OSD-04014
Unable to close file
Cause:  The media has been damaged. 

Action:  Recover the file, if necessary, and verify that Windows NT is 
functioning correctly. 

OSD-04015
Asynchronous I/O request returned an error
Cause:  There was an unexpected return from the Windows NT system service. 

Action:  Check the operating system error code and consult the Windows NT 
documentation. 

OSD-04016
Error queuing an asynchronous I/O request
Cause:  There was an unexpected return from the Windows NT system service. 

Action:  Check the operating system error code and consult the Windows NT 
documentation. 

OSD-04017
Unable to open the specified RAW device
Cause:  An invalid path or file name was specified or the device is full.

Action:  Make sure the file exists and/or device is not full; verify that the 
operating system is functioning correctly.

OSD-04018
Unable to access the specified directory or device
Cause:  An invalid path name was specified. 

Action:  Make sure the directory or device exists and is accessible. 

OSD-04019
Unable to set file pointer
Cause:  This error is caused by an operating system error or by damaged media. 

Action:  Check the operating system error code (if available) and consult the 
Windows NT documentation. If no operating system error code is presented, 
verify that the media is not damaged. 
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OSD-04020
Unable to set eof file marker
Cause:  This error is caused by an operating system error or by damaged media. 

Action:  Check the operating system error code (if available) and consult the 
Windows NT documentation. If no operating system error code is presented, 
verify that the media is not damaged. 

OSD-04021
Unable to read file
Cause:  This error is caused by an operating system error or by damaged media. 

Action:  Check the operating system error code (if available) and consult the 
Windows NT documentation. If no operating system error code is presented, 
verify that the media is not damaged. 

OSD-04022
Unable to write file
Cause:  This error is caused by an operating system error or by damaged media. 

Action:  Check the operating system error code (if available) and consult the 
Windows NT documentation. If no operating system error code is presented, 
verify that the media is not damaged. 

OSD-04023
SleepEx() failure, unable to Sleep
Cause:  There was an unexpected return from the Windows NT system service. 

Action:  Check the operating system error code and consult the Windows NT 
documentation. 

OSD-04024
Unable to delete file
Cause:  This error is caused by an operating system error or by damaged media. 

Action:  Check the operating system error code (if available) and consult the 
Windows NT documentation. If no operating system error code is presented, 
verify that the media is not damaged. 
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OSD-04025
Invalid question asked
Cause:  This is an internal error, not normally expected to occur.

Action:  Contact Oracle Support Services. 

OSD-04026
Invalid parameter passed
Cause:  This is an internal error, not normally expected to occur. 

Action:  Contact Oracle Support Services. 

Memory Errors: OSD-04100 to OSD-04199
OSD-04100

Malloc() failure, unable to allocate memory
Cause:  The program is out of memory. 

Action:  Shut down all unnecessary processes or install more memory in the 
computer. 

OSD-04101
Invalid SGA: SGA not initialized
Cause:  The System Global Area (SGA) has been allocated but not initialized.

Action:  Wait until the STARTUP has completed before attempting to connect.

OSD-04102
Unable to open/create file for shared memory object
Cause:  There was an unexpected return from the Windows NT system service, 
CreateFile(). 

Action:  Check the operating system error code and consult the Windows NT 
documentation. 

OSD-04103
Unable to attach to SGA: SGA does not exist
Cause:  The SGA does not exist. 

Action:  Start up an Oracle instance.
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OSD-04104
Unable to map shared memory (SGA) into the address space
Cause:  There was an unexpected return from the Windows NT system service, 
MapViewOfFileEx(). 

Action:  Check the operating system error code and consult the Windows NT 
documentation. 

OSD-04105
Shared memory (SGA) mapped to wrong address
Cause:  There was an unexpected return from the Windows NT system service, 
MapViewOfFileEx(). 

Action:  Check the operating system error code and consult the Windows NT 
documentation. 

OSD-04106
Unable to allocate memory with VirtualAlloc
Cause:  The program is out of memory. 

Action:  Shut down all unnecessary processes or install more memory in the 
computer. 

OSD-04107
Unable to deallocate memory with VirtualFree
Cause:  There was an unexpected return from the Windows NT system service, 
VirtualFree(). 

Action:  Check the operating system error code and consult the Windows NT 
documentation. 

OSD-04108
Unable to protect memory with VirtualProtect
Cause:  There was an unexpected return from the Windows NT system service, 
VirtualProtect(). 

Action:  Check the operating system error code and consult the Windows NT 
documentation.
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Process Errors: OSD-04200 to OSD-04299
OSD-04200

Unable to begin another thread
Cause:  The program has run out of system resources. 

Action:  Shut down all unnecessary processes; install more memory in the 
computer.

OSD-04201
No pid structure supplied to spdcr()
Cause:  This is an internal error, not normally expected to occur. 

Action:  Contact Oracle Support Services. 

OSD-04202
DosSetPriority() failure, unable to set process priority
Cause:  There was an unexpected return from the Windows NT system service, 
DosSetPriority(). 

Action:  Check the operating system error code and consult the Windows NT 
documentation. 

OSD-04203
DosKillProcess() failure, unable to kill process
Cause:  There was an unexpected return from the Windows NT system service, 
DosKillProcess(). 

Action:  Check the operating system error code and consult the Windows NT 
documentation. 

OSD-04204
Invalid pid
Cause:  Process ID not recognized by system, process previously terminated.

Action:  Verify that process ID is correct and that process is active. 
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OSD-04205
CreateProcess() failure, unable to spawn process
Cause:  There was an unexpected return from the Windows NT system service, 
CreateProcess().

Action:  Check the operating system error code and consult the Windows NT 
documentation.

OSD-04207
Invalid priority specified in CONFIG parameter ORACLE_PRIORITY
Cause:  The priority specified is invalid or out of range. 

Action:  Specify a valid setting for ORACLE_PRIORITY. 

OSD-04208
OpenProcess() failure, unable to open process handle
Cause:  There was an unexpected return from the Windows NT system service, 
OpenProcess(). 

Action:  Check the operating system error code and consult the Windows NT 
documentation. 

OSD-04209
Incorrect or unknown background image name given to spdcr()
Cause:  There was an unexpected background name given to spdcr(). 

Action:  Contact Oracle Support Services. 

OSD-04210
Timeout waiting for thread semaphore
Cause:  An Oracle8 database thread died holding the semaphore. 

Action:  Restart Oracle8 database instance. 

OSD-04211
Thread information not found
Cause:  An Oracle8 database thread died without deleting its information. 

Action:  Restart Oracle8 database instance. 
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OSD-04212
Maximum number of Oracle threads reached
Cause:  The maximum number of Oracle8 database threads for the instance is 
reached.

Action:  Wait until some connections exit before trying again. 

OSD-04213
Oracle thread unable to DuplicateHandle()
Cause:  This is an internal error, not normally expected to occur. 

Action:  Contact Oracle Support Services. 

OSD-04214
Oracle thread unable to CreateEvent()
Cause:  This is an internal error, not normally expected to occur. 

Action:  Contact Oracle Support Services. 

OSD-04215
Bad function code supplied to ssthreadop
Cause:  This is an internal error, not normally expected to occur. 

Action:  Contact Oracle Support Services. 

OSD-04216
Unable to find file handle for that thread
Cause:  This is an internal error, not normally expected to occur. 

Action:  Contact Oracle Support Services. 

OSD-04217
Unable to retrieve system username for current user
Cause:  This is an internal error, not normally expected to occur. 

Action:  Contact Oracle Support Services. 

OSD-04218
Cannot post thread
Cause:  This is an internal error, not normally expected to occur. 

Action:  Contact Oracle Support Services. 
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OSD-04219
Bad thread list semaphore
Cause:  This is an internal error, not normally expected to occur. 

Action:  Contact Oracle Support Services. 

ORADEBUG Errors: OSD-04221 to OSD-04225
OSD-04221

Target thread is currently busy
Cause:  The target thread is processing an oradebug command.

Action:  Wait and re-issue command.

OSD-04222
Unable to get the threads context
Cause:  Check OS error code.

Action:  Remedy OS error.

OSD-04223
Unable to set the threads context
Cause:  Check OS error code.

Action:  Remedy OS error.

OSD-04224
Unable to suspend the target thread
Cause:  Check OS error code.

Action:  Remedy OS error.

OSD-04225
Unable to resume the target thread
Cause:  Check OS error code.

Action:  Remedy OS error.
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Loader Errors: OSD-04300 to OSD-04399
OSD-04300

Unable to read complete record from data file
Cause:  The data file ended in the middle of a record. This error occurs when 
loading files with a fixed record length. 

Action:  Verify that the data file is of the correct length and contains complete 
records. 

OSD-04301
Record size too large
Cause:  The specified record size is too large to load. 

Action:  Reduce record size and reload the data. 

OSD-04302
Invalid record type and/or load options
Cause:  The control file’s Windows NT file processing options string contains an 
invalid option or keyword. 

Action:  Set the Windows NT file processing options string to an acceptable 
value. 

Semaphore Errors: OSD-04400 to OSD-04499
OSD-04400

Unable to acquire internal semaphore for process
Cause:  Oracle8 database has exceeded the maximum number of connections. 

Action:  Delete any unused connections and try again. 

OSD-04401
WaitForSingleObject() failure, unable to obtain semaphorex
Cause:  There was an unexpected return from the Windows NT system service, 
WaitForSingleObject(). 

Action:  Check the operating system error code and consult the Windows NT 
documentation. 
D-18 Oracle8 Client



Codes 04000-04999: Windows NT-Specific Oracle Messages
Miscellaneous Errors: OSD-04500 to OSD-04599
OSD-04500

Illegal option specified
Cause:  This is an internal error, not normally expected to occur. 

Action:  Contact Oracle Support Services.

OSD-04501
Internal buffer overflow
Cause:  This is an internal error, not normally expected to occur. 

Action:  Contact Oracle Support Services.

OSD-04502
Translations nested too deep
Cause:  The program encountered too many intermediate translations while 
attempting to translate a configuration variable. 

Action:  Simplify the values of configuration parameters to include fewer 
intermediate translations. 

OSD-04503
Text contains no translatable elementsx
Cause:  The program cannot recognize variables in the text to be translated.

Action:  Check and, if necessary, correct the text to be translated. 

OSD-04505
Stdin not responding
Cause:  The system is unable to receive input from the standard input stream.

Action:  Verify that the process has access to an input device. 

OSD-04506
Unable to spawn process via system()
Cause:  The system is out of memory or the executable is invalid. 

Action:  Shut down unnecessary processes; install more memory in the 
computer. Verify the name of the executable. 
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OSD-04507
Password for ’internal’ is incorrect
Cause:  An attempt was made to connect as ’internal’ with an invalid password. 

Action:  Verify that the password is correct and try again. 

OSD-04508
No password given
Cause:  An attempt was made to connect as ’internal’ without a password.

Action:  Enter a valid password when connecting as internal. 

OSD-04509
No password found
Cause:  Oracle was unable to locate and retrieve the password for ’internal’.

Action:  Verify that Oracle is installed and configured correctly. 

OSD-04510
Operating system roles are not supported
Cause:  An attempt was made to use an operating system role. 

Action:  Only use roles that were created ’IDENTIFIED BY PASSWORD’ as 
opposed to ’IDENTIFIED EXTERNALLY’. 

OSD-04511
Unable to get date and time from the operating system
Cause:  There was an unexpected return from GetLocalTime() call. 

Action:  Verify that the system time is correct on the computer. 

OSD-04512
Unable to translate the ’USERNAME’ configuration variable on server
Cause:  The ’USERNAME’ configuration parameter variable on the host is not 
properly set. 

Action:  Verify the ’USERNAME’ variable is set. 

OSD-04513
’REMOTE_OS_AUTHENT’ variable not set to TRUE’
Cause:  For remote operating system log on to function, the ’REMOTE_OS_
AUTHENT’ parameter must be set to TRUE. 

Action:  Shut down and start up the instance with ’REMOTE_OS_AUTHENT = 
TRUE’ in the initialization parameter file. 
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OSD-04514
The Windows NT Group name is too long for internal buffer
Cause:  The Windows NT Group name is too long.

Action:  Use a shorter Windows NT group name.
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National Language Support

This appendix describes National Language Support (NLS).

Specific topics discussed are:

■ NLS_LANG Parameters and Components

■ Default Values for NLS_LANG

■ NLS_LANG Settings in MS-DOS Mode and Batch Mode

■ Installing Additional Languages
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NLS_LANG Parameters and Components
NLS_LANG Parameters and Components
Oracle8 Client for Windows NT provides NLS that enables users to interact with the 
database in their selected language. When you install , you select a language for 
database messages. Oracle Installer supplies a value for the NLS_LANG parameter 
based on the language selected. 

The NLS_LANG parameter uses the following format:

NLS_LANG = LANGUAGE_TERRITORY.CHARACTER_SET 

where: 

The default language at installation is either the operating system language or the 
NLS_LANG setting of the currently selected Oracle home.

The NLS_LANG parameter is stored in the registry under the HKEY_LOCAL_
MACHINE\SOFTWARE\ORACLE\NLS_LANG subkey for the first Oracle home 
on your computer. For subsequent installations to different Oracle homes on the 
same computer, the path is HKEY_LOCAL_MACHINE\ 
SOFTWARE\ORACLE\HOMEID\NLS_LANG, where ID is the unique number 
identifying the Oracle home. See Appendix C, "Configuration Parameters and the 
Registry" for more information on the subkey locations for multiple Oracle homes.
  

LANGUAGE Specifies the language and conventions for displaying 
messages, day name, and month name.

TERRITORY Specifies the territory and conventions for calculating week 
and day numbers.

CHARACTER_SET Controls the character set used for displaying messages.

Additional Information: See Oracle8 Reference for information on 
the NLS_LANG parameter and NLS initialization parameters.
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Default Values for NLS_LANG
The following table lists the default NLS_LANG values if you select any of these 
languages during installation of Oracle8 Client for Windows NT.
 

If You Select... Then the NLS_LANG Value is...

Arabic ARABIC_UNITED ARAB EMIRATES.AR8MSWIN1256

Brazilian Portuguese BRAZILIAN PORTUGUESE_BRAZIL.WE8ISO8859P1

Catalan CATALAN_CATALONIA.WE8ISO8859P1

Croatian CROATIAN_CROATIA.EE8MSWIN1250

Czech CZECH_CZECH REPUBLIC.EE8MSWIN1250

Danish DANISH_DENMARK.WE8ISO8859P1

Dutch DUTCH_THE NETHERLANDS.WE8ISO8859P1

English AMERICAN_AMERICA.WE8ISO8859P1

Finnish FINNISH_FINLAND.WE8ISO8859P1

French FRENCH_FRANCE.WE8ISO8859P1

German GERMAN_GERMANY.WE8ISO8859P1

Greek GREEK_GREECE.EL8MSWIN1253

Hebrew HEBREW_ISRAEL.IW8MSWIN1255

Hungarian HUNGARIAN_HUNGARY.EE8MSWIN1250

Italian ITALIAN_ITALY.WE8ISO8859P1

Japanese JAPANESE_JAPAN.JA16SJIS

Korean KOREAN_KOREA.KO16KSC5601

Latin American Spanish LATIN AMERICAN SPANISH_AMERICA.WE8ISO8859P1

Norwegian NORWEGIAN_NORWAY.WE8ISO8859P1

Polish POLISH_POLAND.EE8MSWIN1250

Portuguese PORTUGUESE_PORTUGAL.WE8ISO8859P1

Romanian ROMANIAN_ROMANIA.EE8MSWIN1250

Russian RUSSIAN_CIS.CL8MSWIN1251

Simplified Chinese SIMPLIFIED CHINESE_CHINA.ZHS16GBK
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NLS_LANG Settings in MS-DOS Mode and Batch Mode
NLS_LANG Settings in MS-DOS Mode and Batch Mode 
When using Oracle utilities such as Server Manager, SQL Loader, SQL*Plus, Import, 
and Export in MS-DOS mode, the character set field of the NLS_LANG parameter 
for the session must first be set to the correct value. This is required because 
MS-DOS mode uses, with a few exceptions, a different code page (OEM Code-page) 
from Windows (ANSI Code-page), and the default Oracle Home NLS_LANG 
parameter in the registry is always set to the appropriate Windows code-page. If the 
NLS_LANG parameter for the MS-DOS mode session is not set appropriately, error 
messages and data can be corrupted due to incorrect character set conversion. The 
following table lists the Oracle character sets that correspond to the OEM Primary 
Code-page in MS-DOS mode for each of the supported languages.
 

Slovak SLOVAK_SLOVAKIA.EE8MSWIN1250

Slovenian SLOVENIAN_SLOVENIA.EE8MSWIN1250

Spanish SPANISH_SPAIN.WE8ISO8859P1

Swedish SWEDISH_SWEDEN.WE8ISO8859P1

Traditional Chinese TRADITIONAL CHINESE_TAIWAN.ZHT16BIG5

Turkish TURKISH_TURKEY.WE8ISO8859P9

Language Character Set

Arabic AR8ASMO8X

Brazilian Portuguese WE8PC850

Catalan WE8PC850

Czech EE8PC852 

Danish WE8PC850 

Dutch WE8PC850 

English US8PC437

Finnish WE8PC850 

French WE8PC850 

German WE8PC850 

Greek EL8PC737 

If You Select... Then the NLS_LANG Value is...
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NLS_LANG Settings in MS-DOS Mode and Batch Mode
For Japanese, Korean, Simplified Chinese, and Traditional Chinese, the OEM 
Code-page is identical to the ANSI Code-page. In this case, there is no need to set 
the NLS_LANG in MS-DOS mode. 

Similarly, in Batch mode, set the correct character set value of the NLS_LANG by 
inserting a SET NLS_LANG command at the start of the batch procedure, according 
to the character set of the files to be processed in the procedure.

Hungarian EE8PC852 

Italian JA16SJIS

Japanese JA16SJIS

Korean KO16KSC5601

Latin American Spanish WE8PC850

Norwegian WE8PC850 

Polish EE8PC852 

Portuguese WE8PC850

Romanian EE8PC852 

Russian RU8PC866 

Simplified Chinese ZHS16CGBK

Slovak EE8PC852 

Slovenian EE8PC852

Spanish WE8PC850 

Swedish WE8PC850 

Traditional Chinese ZHT16BIG5

Turkish TR8PC857

Language Character Set
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Installing Additional Languages
To install an additional language:

1. Run Oracle Installer.

2. Enter the language you want to install in the Oracle Installation Settings dialog 
box.

3. Install the Oracle products again.

This method keeps any language support that was previously installed and adds 
the new language.
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Troubleshooting

This appendix describes how to troubleshoot problems with Oracle8 Client. 

Specific topics discussed are:

■ Database Connection Issues

■ Oracle8 Performance Monitor Issues

■ DOS Compatibility Mode on Windows 95 or Windows 98 Computers

■ Oracle Web Publishing Assistant

■ Oracle Assistants
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Database Connection Issues
Database Connection Issues
This table lists and provides answers to common Oracle8 database connection 
issues: 
 

If You Receive This Error... Ensure Your...

TNS-12203 TNS: unable to connect to 
destination

OracleServiceSID and OracleTNSListener801 
services are started. See section , "Managing 
Oracle Services" in Chapter 7, "Administering a 
Database" and Chapter 10 "Troubleshooting 
Net8" in Net8 Administrator’s Guide.

1 Ensure that OracleHOME_NAMETNSListener is started if you are using an Oracle8 database that has a home name.

ORA-12547 TNS: lost contact OracleServiceSID, OracleStartSID, and 
OracleTNSListener801 services are started. You 
receive this error if you attempt to use any of the 
Oracle8 Utilities, such as Server Manager. See 
section , "Managing Oracle Services" in 
Chapter 7, "Administering a Database" for 
instructions.

Note: This error is analogous to the following 
Oracle7 error: 

ORA-09352: Windows 32-bit Two-Task 
driver unable to spawn new ORACLE 
task

ORA-28575: unable to open RPC connection to 
external procedure agent 
ORA-06512: at "APPLICATIONS.OSEXEC", line 0 
ORA-06512: at "APPLICATIONS.TEST", line 4 
ORA-06512: at line 2 

TNSNAMES.ORA and LISTENER.ORA files 
have been correctly configured to use external 
procedures. See "Configuring External Procedure 
Calls" in Chapter 8 of Net8 Getting Started for 
Windows NT and Windows 95/98.
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Oracle8 Performance Monitor Issues
See "Oracle8 Performance Monitor Troubleshooting Information" in Chapter 9, 
"Monitoring a Database", for information on Oracle8 Performance Monitor 
troubleshooting issues.

Operating System Permission Issues
The permission problem (OS 5 or 3) is typically caused by inadequate configuration 
of the NTFS permissions. By default, the Oracle8 database service runs using the 
SYSTEM account instead of a named Windows NT user such as Administrator. In 
File Manager or Windows NT Explorer, you must grant Full Control on the 
ORACLE_HOME directory and all of its subdirectories to the SYSTEM user. The 
SYSTEM user has the full name The operating system and has an icon of a computer 
chip. For this and other Windows NT problems, consult your Windows NT 
documentation or contact your Windows NT System Administrator. 

After correcting the problem, you must delete any files created as a result of partial 
completion of the CREATE DATABASE command. The files to delete are the:

Then, run the BUILD_DB.SQL script again in Server Manager. 

Command Description

SVRMGR> STARTUP Uses the default INITSID.ORA file located in your 
ORACLE_HOME\DATABASE directory to start the 
Oracle8 database.

SVRMGR> STARTUP 
PFILE=PATH\FILENAME 

Uses an initialization file other than the default to start 
your database. PATH\FILENAME specifies an initialization 
parameter file other than the default, INITSID.ORA. The 
following example starts the database using a file named 
INIT2.ORA. 

SVRMGR> STARTUP PFILE=%ORACLE_
HOME%\RDBMS80\INIT2.ORA
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Oracle Assistants
DOS Compatibility Mode on Windows 95 or Windows 98 Computers
If a Windows 95 or Windows 98 computer is in DOS COMPATIBILITY MODE, then 
it is unable to read the long file name of TRACESVR80 (and directory so named) 
from the CD-ROM. You can determine if a computer is running in compatible mode 
by right-clicking on MY COMPUTER, choosing PROPERTIES, and then selecting 
the PERFORMANCE tab. This will open a window that tells you which drives, if 
any, are running in compatible mode, or if your computer is running a complete 
32-bit FILE System. 

DOS compatible mode may be enabled by the operating system for several reasons:

■ A boot sector virus exists on the computer

■ A realmode device driver exists in the CONFIG.SYS and Windows NT has no 
protectmode driver that can take over for it

■ Too many INT 13 hooks exist

■ An old VxD exists for a controller in the SYSTEM.INI file that has no 
counterpart in Windows 95. 

A list of all ProtectMode drivers, and some bad ones, exists on a Windows 95 
computer in a file called IOS.INI. If a computer is running in compatible mode, then 
a log file should be created called IOS.LOG. This will list the devices that are 
running in compat/realmode and the reason why.

Additionally, if the Windows 95 or Windows 98 computer is on a LAN and can 
connect to a Windows NT computer (or a Windows 95 or Windows 98 computer 
whose CD-ROM drivers can deal with the long file name), place the CD-ROM in the 
Windows NT computer’s CD-ROM drive and install the software on the Windows 
95 or Windows 98 computer over the network. 

Oracle Web Publishing Assistant
Due to French government regulations on encryption, you cannot set your system 
default locale to French (Standard) in the Regional Settings Control Panel of 
Windows NT. 

Oracle Assistants
This section includes known problems, restrictions, and workarounds to the Oracle 
Assistants: 
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Oracle Assistants
■ The Help button of some Assistants is sometimes enabled even though online 
help is not available. 

■ Oracle Net8 Assistant, Oracle Net8 Easy Config, and Oracle INTYPE File 
Assistant require monitors displaying at least 256 colors. 

■ Oracle Assistants have an online help facility that includes the feature to search 
for a text string in the help text. This feature is activated by the Search button. 
When you click the Search button, a dialog box appears. You can then enter a 
text string such as a word or phrase into a text box and press the Find button to 
search for the string in the help text. 

■ Currently, the Find feature cannot find a Japanese text string of more than one 
character. That is, if you enter one Japanese character to search, the search 
feature will work normally; it will find the character, provided it exists in the 
help text. If you enter more than one Japanese character, or one Japanese 
character mixed with other characters such as English characters, the search 
facility will fail to find the string even if it does exist in the help text. Searching 
for English and other European languages text strings does not have this 
limitation. 
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Oracle Database Assistant
■ The Oracle Database Assistant in this release is certified against an Oracle8 

database only. Version 7 databases are not supported.

■ During installation, if you choose to install the starter database or use the 
Oracle Database Assistant, a dialog box appears asking if you want to view the 
documentation. If you choose Yes, a browser appears over the Assistant. To see 
the Assistant, dismiss the browser. 

■ In order to enable the Image Demo for an existing instance (in the Modify route 
of the assistant), the SCOTT/TIGER account must have been created in that 
instance and CONNECT and RESOURCE roles must have been granted; the 
Oracle Database Assistant assumes the account is already created. 

Registering CTXV236.OCX on Windows 95 Clients
When executing Start > Programs > ConText Cartridge Workbench > Viewer 
Example on a Windows 95 client, you can receive an error message stating that 
registration of CTXV236.OCX failed. If you receive this error message: 

1. Register CTXV236.OCX at the MS-DOS command prompt: 

C:\> REGSVR32 CTXV236.OCX

2. Shut down and restart your Windows 95 client.
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Glossary

admin privileges

The authorization to perform certain administrative procedures on a system.

alias

(1) An alternative name for an existing network object, such as a host (server), or a 
set of parameters. (2) In SQL, a temporary name assigned to a table, view, column, 
or value within a SQL statement, used to refer to that item later in the same 
statement or in associated SQL*Plus commands.

application

One or more program modules used to achieve a specific result. Applications can be 
nested within other applications.

authenticate

The process of verifying the identity of a user, device, or other entity in a computer 
system, often as a prerequisite for allowing access to resources in a system.

authorization

Permission given to a user, program, or process to access an Oracle8 database.

call interface

A set of standard software routines used to access an Oracle8 database. Also called 
the Oracle Call Interface (OCI).
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data dictionary

Where the Oracle8 database stores information about the structure of the database; 
describes how the data in the server is organized. Collection of tables and views 
commonly used by the Oracle8 database. Owned by the user SYS. Includes:

■ names of all tables and views in the database

■ names and datatypes of columns in database tables

■ privileges of all Oracle users

DLL

Dynamic Link Libraries. Microsoft Windows operating system-loadable executable 
files.

dynamic data dictionary

An online data dictionary is an integral part of the data source and always reflects 
the current definition of the data source. Data structures can be changed while the 
data source is being accessed. See also data dictionary.

external procedure

Function or procedure written in a third-generation language (3GL) that can be 
called from PL/SQL code. Only C is supported for Oracle8 external procedures.

HOME_NAME

Represents the Oracle home name if you use multiple Oracle homes. This convention 
is not applicable for a single Oracle home.

HOMEID

Represents a unique registry subkey for each Oracle home directory in which you 
install products. A new HOMEID is created and incremented each time you install 
products to a different Oracle home directory on one computer. Each HOMEID 
contains its own configuration parameter settings for installed Oracle products.

initialization parameter file

File that contains information to initialize the database and instance.

instance

Combination of processes and threads that begins each time a database is started. 
Identified with a unique SID. A default SID, ORCx, is installed during installation 
of the Oracle8 database. 
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When you install the Oracle8 database for the first time on a machine, your SID is 
typically ORCL. For each subsequent Oracle8 database installation into a different 
Oracle home on the same computer, ORCL is automatically incremented by one 
(that is, for a second Oracle8 database installation, the SID is ORC1, for a third 
Oracle8 database installation, the SID is ORC2, etc.).

The background threads and memory areas required to access an Oracle8 database. 
A database system requires one instance and one database. Every Oracle8 instance 
has a single system global area (SGA); a multiple-user instance also requires several 
background threads.

instance failure

Failure that occurs when a problem arises that prevents a database instance (SGA 
and background processes) from continuing work. Instance failure can result from a 
hardware problem such as an outage, or a software problem such as an operating 
system crash. When an instance failure occurs, the data in the buffers of the SGA is 
not written to the data files.

instance identifier

A name or ID used to distinguish one instance from another when multiple 
instances exist on one CPU. The identifier is specified in an operating-system 
specific manner.

instance recovery

Recovery of an instance in the event of software or hardware failure, so that the 
database is again available to users. If the instance terminates abnormally, then 
instance recovery automatically occurs at the next instance startup.

listener

The server process that listens for and accepts incoming connection requests from 
client applications. Oracle listener processes start up Oracle database processes to 
handle subsequent communications with the client.

LISTENER.ORA

A configuration file that describes one or more Transparent Network Substrate 
(TNS) listeners on a server.

mount

To associate a database with a started instance, in order to perform maintenance on 
the database, or to open it and make a database accessible to database users.
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mounted database

A database associated with an Oracle instance. The database can be opened or 
closed. A database must be both mounted and opened to be accessed by users. A 
database that has been mounted but not opened can be accessed by DBAs for some 
maintenance purposes.

Net8

The Oracle client/server communication software that offers transparent operation 
to Oracle tools or databases over any type of network protocol and operating 
system.

Network Computing Architecture

Network Computing Architecture is a common set of technologies that enables all 
PCs, network computers, and other client devices to work with all Web servers, 
database servers, and application servers over any network. It is a robust, scalable, 
and open infrastructure that serves as the basis for the next generation of 
distributed computing. 

network listener

A listener on a server that listens for connection requests for one or more databases 
on one or more protocols. See listener.

network service 

In an Oracle application network, a service performs tasks for its service consumers; 
for example, a Names Server provides name resolution services for clients.

NLS

National Language Support. Oracle support of national languages. Data can be 
entered, stored, and displayed in the language of the administrator’s choice.

NULL value

The absence of a value.

ORANT

Default Oracle home directory where Oracle Installer installs the Oracle8 database 
on Windows NT.

ORAWIN95

Default Oracle home directory where Oracle Installer installs Oracle products on 
Windows 95.
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ORAWIN98

Default Oracle home directory where Oracle Installer installs Oracle products on 
Windows 98.

offline redo log

A redo log file that has been archived.

online redo log

Redo log files that have not been archived, but are either available to the instance 
for recording database activity or are filled and waiting to be archived or reused.

online redo log file

File that records all committed changes made to the database. Whenever a 
transaction is committed, the corresponding redo entries temporarily stored in redo 
log buffers of the SGA are written to an online redo log file by the background 
process LGWR. An online redo log file can be individual or mirrored; in the latter 
case, it is an online redo log group, made up of online redo log members.

Oracle Call Interface (OCI)

An optional Oracle product that allows users to embed Oracle calls directly into 
high-level languages. It is the program call interface to an Oracle8 database. See also 
call interface.

Oracle Database

The Oracle8 database is an Object Relational Database Management System 
(ORDBMS). 

Oracle Protocol Adapter

A product that maps the functions of a given network protocol into Oracle 
Transparent Network Substrate (TNS) architecture. This process translates TNS 
function calls into requests to the underlying network protocol. This allows TNS to 
act as an interface among all protocols. Net8 requires protocol adapters.

Oracle service

Created and associated with an Oracle8 database. Similar to Windows NT services.

PL/SQL

The Oracle procedural language extension of SQL. PL/SQL combines the ease and 
flexibility of SQL with the procedural functionality of a structured programming 
language, such as IF...THEN, WHILE, and LOOP. Even when PL/SQL is not stored 
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in the database, applications can send blocks of PL/SQL to the database rather than 
individual SQL statements, thereby reducing network traffic.

precompiler

A tool that enables a user to embed any SQL statement in a third-generation 
language (3GL) (host language) program. The precompiler takes this program as 
input and produces as output another program, in the same 3GL, in which all the 
embedded SQL calls are translated into host language procedure calls. This 
resulting program can be compiled, linked, and executed. Oracle supports 
precompilers for the languages C, FORTRAN, Pascal, PL/I, COBOL, and Ada.

privilege

A right to successfully execute a particular type of SQL statement. Some examples 
of privileges include rights to connect to the database (create a session), create a 
table in your schema, select rows from someone else’s table, and execute someone 
else’s stored procedure. The privileges of an Oracle8 database can be divided into 
two distinct categories: system privileges and object privileges.

process

(1) A thread of control in an operating system; that is, a mechanism in an operating 
system that can execute a series of steps. Some operating systems use the terms job 
or task. A process normally has its own private memory area in which it runs. An 
Oracle8 database has two general types of processes: user processes and Oracle 
processes. (2) A synonym for "user," a single entity performing a set of tasks in an 
operating system environment or a database.

query

A SQL SELECT statement that retrieves data, in any combination, expression, or 
order. Queries are read-only operations; they do not change data, they only retrieve.

quota

A limit on a resource, such as a limit on the amount of database storage used by a 
database user. A DBA can set tablespace quotas for each Oracle user name.

redo log

A sequential log of all changes made to the data. The redo log is written and used in 
the event that a failure caused the changes to not be written to disk; it is used to 
re-apply the changes to disk. The redo log consists of two or more redo log files; one 
is optionally being saved while another is being written to by the Oracle8 database. 
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When the file currently being written fills, the other file is re-used. See also online 
redo log and off-line redo log.

 redo log file 

A file containing records of changes to the databases. These files are used for 
recovery purposes. See also redo log. 

remote computer

A computer on a network other than the local computer.

remote database

A database on a computer other than the local database. Usually a computer on the 
same network, but at a different node (that is, a database that you use through a 
database link).

role

A list of user names that can be granted privileges to use form and/or menu 
modules.

roles

Named groups of related privileges that are granted to users or other roles.

rollback

The second half of the recovery procedure. After the roll forward, any changes that 
were not committed must be undone. After the redo log files have been applied, the 
rollback segments are used to identify and undo transactions that were never 
committed, yet were recorded in the redo log. Oracle completes this step 
automatically.

schema

A collection of table definitions.

schema objects

A collection of related objects. Schema objects are the logical structures that directly 
refer to the database’s data. Schema objects include such structures as tables, views, 
sequences, stored procedures, synonyms, indexes, clusters, and database links. 
There is no relationship between a tablespace and a schema: objects in the same 
schema can be in different tablespaces, and a tablespace can hold objects from 
different schemas.
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server

(1) The provider of services requested by a client.

service

An executable process installed in the Windows NT Registry database and 
administered by Windows NT. Once created and started, it can run even while no 
user is logged on to the Oracle8 database.

service name

The name used by clients to identify a Net8 server. A service name is mapped to a 
port number and protocol.

SID

A unique name for an Oracle database instance. To switch between Oracle 
databases, users must specify the desired SID. The SID is included in the 
CONNECT DATA parts of the connect descriptors in a TNSNAMES.ORA file, and 
in the definition of the network listener in the LISTENER.ORA file. Also known as 
system ID.

snapshot

Information stored in rollback segments to provide transaction recovery and read 
consistency. Rollback segment information can be used to recreate a snapshot of a 
row before an update.

SQL

Structured Query Language—the internationally accepted standard for defining 
and manipulating relational databases.

Starter Database

The starter database is the core of Oracle8. Oracle Corporation recommends that 
you use the starter database and modify it to suit your needs.

static data dictionary

A data dictionary that contains data definitions that are not an integral part of the 
data source. Changes to data structures require the data source to be rebuilt. See 
also dynamic data dictionary.

synonym

An alias for a table, view, sequence, or program unit; a synonym is not actually an 
object itself, it is a direct reference to its base object. Synonyms are used to mask the 
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real name and owner of an object, provide public access to an object, provide 
location transparency for tables, views, or program units of a remote database, and 
simplify the SQL statements for database users. A synonym can be public or 
private.

SYSDBA

A special database administer role that contains all system privileges with the 
ADMIN OPTION, and the SYSOPER system privilege. SYSDBA also permits 
CREATE DATABASE and time–based recovery.

SYSOPER

A special database administer role that permits a database administrator to perform 
STARTUP, SHUTDOWN, ALTER DATABASE OPEN/MOUNT, ALTER DATABASE 
BACKUP, ARCHIVE LOG, and RECOVER, and includes the RESTRICTED 
SESSION privilege.

system ID

A synonym for instance identifier. Often abbreviated to SID.

SYSTEM user name

One of two standard DBA user names automatically created with each database (the 
other is SYS). The Oracle user SYSTEM is created with the password MANAGER. 
The SYSTEM user name is the preferred user name for DBAs to use when 
performing database maintenance.

table

The basic unit of storage in a relational database management system. A table 
represents entities and relationships, and consists of one or more units of 
information (rows), each of which contains the same kinds of values (columns). 

tablespace

A logical portion of an Oracle8 database used to allocate storage for table and index 
data. Each tablespace corresponds to one or more physical database files. Every 
Oracle8 database has a tablespace called SYSTEM and may have additional 
tablespaces. A tablespace is used to group related logical structures together. For 
example, tablespaces commonly group all of an application’s objects to simplify 
certain administrative operations.
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thread

Objects within processes that concurrently execute program instructions. This 
enables one process to use threads to run different parts of its program on different 
processors simultaneously.

TNSNAMES.ORA

A file that contains connect descriptors mapped to service names. The file may be 
maintained centrally or locally, for use by all or individual clients.

trace file

A file created when a problem or exceptional condition is encountered while using a 
software program. Also called a dump file, the file contains information useful in 
diagnosing or locating the problem. 

variable

A named object that can be assigned a value and whose assigned value may change 
over time. SQL*Plus uses substitution, system, and user variables.

variable parameters

(1) Parameters whose value can change or can be reset. (2) The INITSID.ORA 
parameters whose values can vary and affect the performance of a database. DBAs 
may wish to "tune" or experiment with the variable parameter values in order to 
optimize their database’s performance.
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Index

Symbols
"", SQL*Loader parameter, 3-15
"FIX n", SQL*Loader parameter, 3-15
"VAR xxxx", SQL*Loader parameter, 3-15
.SQL scripts

location of, A-4

A
A2OWIZ80 parameter, C-6
Adobe Acrobat Reader, starting, 1-10
Advanced Program-to-Program Communication 

(APPC), defined, 2-11, 2-12
ALL_HOMES, registry subkey for multiple Oracle 

homes, C-11
API

parameter, C-10
value, C-6

APPC architecture, 2-11, 2-12
assistant common files, 2-5
assistants

Oracle INTYPE File Assistant, 2-9
starting, 3-13

audit trail, operating system, 3-19

B
backslash (\), defined, xviii
Backup Manager

capabilities, 4-16
starting, 3-12

block size, maximum, B-7
blocks per file, maximum, B-7

browsers
Java-enabled, 1-10
Microsoft Internet Explorer, 1-8
Netscape Navigator, 1-8

C
C:\>, defined, xviii
C:\ORANT, defined, xix
C:\ORAWIN, defined, xix
C:\ORAWIN95, defined, xix
C:\ORAWIN98, defined, xix
CD-ROMs, order of installation, 2-3
Choose Start >, defined, xviii
code conventions, used in this manual, xviii
COMMIT_POINT_ STRENGTH parameter, B-4
communication daemon, responsibilities, 4-7
COMPANY_NAME parameter, C-6, C-10
COMPATIBLE parameter, B-4
compiling

OCI with Oracle XA, 8-3
Oracle XA Library, 8-1
Pro*C/C++ with Oracle XA, 8-2

composite jobs, Job Scheduling System, 4-10
configuration parameters

defined, C-2
registry, C-1

configuration requirements
for Oracle products, 6-2

configuration responsibilities
Net8, 6-2
Oracle Enterprise Manager, 6-3

configuration tasks
Oracle8 ConText Cartridge Workbench, 6-17
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Oracle8 ConText Cartridge Workbench 
Demos, 6-17

console
features, 4-3
Oracle Enterprise Manager, 4-2
windows, 4-5

contact information
documentation sales, 1-2
Oracle Support Services, vii

Control Panel
defined, 3-16
integration with Oracle8 database, 3-16
starting, 3-9

CONTROL_FILES parameter, B-4
CORE40 parameter, C-6
cross-platform job scripts, 4-10
CTXQUERY demo, 6-17
CTXV236.OCX, registering on Windows 95 

clients, F-6
Customer Support

contacting, vi

D
D*.SQL, downgrading script, 2-2
Data Manager

capabilities, 4-17
starting, 3-12

database administration applications
Backup Manager, 4-16
common features, 4-18
Data Manager, 4-17
Instance Manager, 4-15
Oracle Enterprise Manager, 4-15
Schema Manager, 4-16
Security Manager, 4-16
Software Manager, 4-17
SQL Worksheet, 4-15
Storage Manager, 4-15

database tools
starting, 3-6

databases
maximum size possible, B-8
parameters for a new database, B-4

DB_BLOCK_SIZE parameter, B-4

DB_FILE_MULTIBLOCK_ READ_ COUNT 
parameter, B-4

DB_FILE_SIMULTANEOUS_ WRITES 
parameter, B-4

DB_FILES parameter, B-4
DB_NAME parameter, B-4
DEFAULT_HOME parameter, C-11
directory names, convention used, xviii
directory structure

client, A-2
discovering services, for Oracle Enterprise 

Manager, 6-12
DISK_FULL error message, D-2
DisplayName parameter, C-14
DISTRIBUTED_TRANSACTIONS parameter, B-4
distributing software

Oracle, 7-2
Systems Management Server, 7-3

DML_LOCKS parameter, B-4
documentation

Adobe Acrobat Reader, 1-10
formats supplied, 1-2
generic, 1-3
how to find specific information (online), 1-8
HTML, 1-2
list of included manuals, 1-4
Oracle Information Navigator, 1-2
PDF, 1-2
printed, 1-2

documentation conventions, used in this 
manual, xviii

documentation sales, 1-2
DOS compatibility mode, F-4
downgrading scripts

new names, 2-2
DRIVE_LOCKED error message, D-2

E
error messages

Intercartridge Exchange, 8-8
logging, D-2
ORA-12547, F-2
Oracle Installer, D-2
Oracle8 database, D-4
                                                                       Index-2



OSD-04000 to OSD-04099, D-7
OSD-04100 to OSD-04199, D-12
OSD-04200 to OSD-04299, D-14
OSD-04300 to OSD-04399, D-18
OSD-04400 to OSD-04499, D-18
OSD-04500 to OSD-04599, D-19
resolving, vi

errors
migration, F-3
ORA-23346, F-4

Event Management System
Oracle Enterprise Manager, 4-12
proactive events management, 4-12

Event Management Window, Oracle Enterprise 
Manager, 4-5

event scripts, with Job Scheduling System, 4-12
Event Viewer

defined, 3-18
integration with Oracle8 database, 3-18
logging operating system audit trail, 3-19
overview, 3-18
starting, 3-9

exception conditions, Intercartridge Exchange, 8-8
EXECUTE_SQL parameter, C-6
Export Utility

redirecting output, D-2
starting, 3-8

F
file names, convention used, xviii
file size, maximum possible, B-7
FILE_CORRUPTED error message, D-2
FILE_NOT_FOUND error message, D-2
files

assistant common, 2-5
maximum number per database, B-7
maximum size possible, B-7
sample INIT.ORA, B-3

G
generic documentation references

calculating index size, B-8
configuring Oracle Intelligent Agent, 6-3

install test databases in a separate Oracle 
home, 5-3

location of initialization parameter file, B-2
log archive destination, B-4
log archive format, B-4
LOG parameter use, D-2
Oracle Enterprise Manager setup, 6-3
password file environmental variable, C-7
setting resource costs, B-8
SORT_AREA_SIZE default value, B-5
specifying archive destinations, B-4
starting Server Manager (SVRMGR30), 3-8
Windows NT-specific CONTROL_FILE 

parameter value, B-4
Windows NT-specific DBVERF80 executable 

location, A-2
Windows NT-specific error messages, D-7
Windows NT-specific initialization parameter 

file, B-2
Windows NT-specific location of .SQL 

scripts, A-4
Windows NT-specific LOG_ARCHIVE_BUFFERS 

value, B-4
Windows NT-specific LOG_ARCHIVE_DEST 

format, B-4
Windows NT-specific LOG_ARCHIVE_DEST 

value, B-4
Windows NT-specific 

LOG_ARCHIVE_FORMAT format, B-4
Windows NT-specific NLS_LANG values, E-3
Windows NT-specific NLS_TERRITORY 

values, E-3
Windows NT-specific Oracle Enterprise Manager 

startup, 3-10
Windows NT-specific parameter file name and 

location, B-2
Windows NT-specific parameter file values, B-4
Windows NT-specific Server Manager executable 

location, A-2
XA linking file names

H
HOME_COUNTER parameter, C-11
HOME_NAME, defined, xix
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HOMEID
defined, xix
registry naming convention, C-4

Hostname parameter, C-13

I
ICX. See Intercartridge Exchange
ID parameter, C-6, C-10
ImagePath parameter, C-14
Import Utility

starting, 3-8
index size, calculating, B-8
infowin@us.oracle.com, vi
initialization parameter file

defined, B-2
editing, B-2
location, B-2

initialization parameters
BACKGROUND_DUMP_ DEST, B-4
BACKGROUND_DUMP_DEST, B-4
COMMIT_POINT_ STRENGTH, B-4
COMPATIBLE, B-4
CONTROL_FILES, B-4
DB_BLOCK_SIZE, B-4
DB_FILE_MULTIBLOCK_ READ_ COUNT, B-4
DB_FILE_SIMULTANEOUS_ WRITES, B-4
DB_FILES, B-4
DB_NAME, B-4
DISTRIBUTED_TRANSACTIONS, B-4
DML_LOCKS, B-4
LOG_ARCHIVE_BUFFER_ SIZE, B-4
LOG_ARCHIVE_BUFFERS, B-4
LOG_ARCHIVE_DEST, B-4
LOG_ARCHIVE_FORMAT, B-4
LOG_CHECKPOINT_ INTERVAL, B-4
LOG_FILES, B-4
LOG_SMALL_ENTRY_MAX_ SIZE, B-4
MTS_DISPATCHERS, B-5
MTS_MAX_DISPATCHERS, B-5
MTS_MAX_SERVERS, B-5
MTS_SERVERS, B-5
NLS_LANGUAGE, B-5
NLS_SORT, B-5
NLS_TERRITORY, B-5

OPEN_CURSORS, B-5
OS_AUTHENT_PREFIX, B-5
PROCESSES, B-5
REMOTE_LOGIN_PASSWORDFILE, B-5
SHARED_POOL_SIZE, B-5
SORT_READ_FAC, B-5
SORT_SPACEMAP_SIZES, B-5
TEMPORARY_TABLE_ LOCKS, B-5
TRANSACTIONS_PER_ 

ROLLBACK_SEGMENT, B-5
USER_DUMP_DEST, B-5

Instance Manager
capabilities, 4-15
Oracle Enterprise Manager, 4-15
starting, 3-12

integrated applications, of Oracle Enterprise 
Manager, 4-15

Intercartridge Exchange
accessing web data, 8-3
configuring, 8-4
error messages, 8-8
exception conditions, 8-8
packaged functions, 8-5
stored packages, 8-5
troubleshooting, 8-9
using, 8-5

INVALID_FILE_NAME error message, D-2
italic letters, defined, xviii

J
Java Runtime Environment, 2-5
Java-enabled browsers, 1-10
JDBC. See Java Database Connectivity
Job Scheduling System

composite jobs, 4-10
event scripts, 4-12
lights out management, 4-9
optimized intelligent agent, 4-13
Oracle Enterprise Manager, 4-8
predefined event sets, 4-13
predefined job tasks, 4-9
scalability, 4-11, 4-13
scripts, 4-10
security, 4-11
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storing and forwarding job scheduling, 4-9
unsolicited error detection, 4-12

Job Scheduling Window, Oracle Enterprise Manager 
Console, 4-5

L
LAST_HOME parameter, C-11
LEXICAL_ERROR error message, D-2
lights out management, 4-9
linking

OCI with Oracle XA, 8-3
Oracle XA Library, 8-1
Pro*C/C++ with Oracle XA, 8-2

LOCKING_VIOLATION error message, D-3
LOG parameter

use of, D-2
LOG_ARCHIVE_BUFFER_ SIZE parameter, B-4
LOG_ARCHIVE_BUFFERS parameter, B-4
LOG_ARCHIVE_DEST parameter, B-4
LOG_ARCHIVE_FORMAT parameter, B-4
LOG_CHECKPOINT_ INTERVAL parameter, B-4
LOG_FILES parameter, B-4
LOG_SMALL_ENTRY_MAX_ SIZE parameter, B-4
LOGFILE parameter, C-14
logging error messages, D-2

M
managing jobs, Oracle Enterprise Manager, 4-12
Map Window, Oracle Enterprise Manager, 4-5
MAX_IO_SIZE, B-5
Microsoft Internet Explorer, 1-8
monitoring

Oracle events, 3-18, 3-19
MS_HELP parameter, C-6
MSHELP parameter, C-6
MTS_DISPATCHERS

specifying a value, B-5
MTS_DISPATCHERS parameter, B-5
MTS_MAX_DISPATCHERS parameter, B-5
MTS_MAX_SERVERS parameter, B-5
MTS_SERVERS parameter, B-5
multiple Oracle homes

ALL_HOMES registry subkey, C-11

defined, xix
environment, 5-4
HOMEID registry naming convention, C-4
impact on registry, C-3
Oracle Enterprise Manager, 5-6
overview, 5-2
quitting Oracle Installer, 5-2
registry subkeys, C-4, C-5
working with, 5-7

multi-threaded server
specifying MTS_DISPATCHERS, B-5

N
NAME parameter, C-11
Named Pipes Protocol Adapter

defined, 2-10, 2-12
Navigator Window, 4-5
Net8

configuration responsibilities, 6-2
products, 2-9

NET80 parameter, C-6
Netscape Navigator, 1-8
NLS support, E-2, E-3
NLS_LANG parameter, C-6, C-10, C-11, E-2

default values, E-2
territory and character set defaults, E-3

NLS_LANGUAGE parameter, B-5
NLS_SORT parameter, B-5
NLS_TERRITORY parameter, B-5
NLSRTL32 parameter, C-6
NLSRTL33 parameter, C-6

O
Object Type Translator (OTT), defined, 2-9
ObjectName parameter, C-14
OCI

Oracle XA Library, 8-3
OCI, defined, 2-8
ODBC. See Oracle Open Database Connectivity 

Driver
OI_NLS32 parameter, C-6
Open Systems Interconnect (OSI) model, 2-11, 2-12
OPEN_CURSORS parameter, B-5
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operating systems
audit trail, 3-19
supported, 2-2
troubleshooting, F-3

optimized intelligent agent, Job Scheduling 
System, 4-13

ORA_EXTPROC_THREADED parameter, C-6
ORA_NLS33 parameter, C-6
ORA_SHUTDOWN parameter, C-7
ORA_SHUTDOWN_TIMEOUT parameter, C-7
ORA_SID_PWFILE parameter, C-7
ORA_SID_SHUTDOWN parameter, C-7
ORA_SID_SHUTDOWN_TIMEOUT parameter, C-

7
ORA-12547 error, F-2
Oracle Administrator Toolbar, defined, 2-8
Oracle Assistants

problems and workarounds, F-4
Oracle Biometrics Manager, defined, 2-8
Oracle Call Interface. See OCI
Oracle ConText Option Configuration Manager, 2-

7
Oracle Database Assistant

problems and workarounds, F-6
Oracle Enterprise Manager

Backup Manager, 4-16
common services, 4-6
communication daemon, 4-7
configuration files, 6-12
configuration responsibilities, 6-3
configuration tasks, 6-5
console capabilities, 4-2
console features, 4-3
console windows, 4-5
creating a repository, 6-12
Data Manager, 4-17
database administration applications, 4-15
defined, 2-8
discovering services, 6-12
Event Management System, 4-12
Event Management Window, 4-5
Instance Manager, 4-15
integrated applications, 4-15
Job Scheduling System, 4-8
Job Scheduling Window, 4-5

key components, 4-3
managing jobs, 4-12
Map Window defined, 4-5
multiple Oracle homes installation 

recommendation, 5-6
Navigator Window, 4-5
operating system compatibility, 3-3
Oracle Intelligent Agent, 4-7
overview, 4-2, 6-3
Replication Manager, integrating, 4-18
repository, 4-14
scheduling jobs, 4-8
Schema Manager, 4-16
security, 4-14
Security Manager, 4-16
service discovery, 4-8
setup environments, 6-4
Software Manager, 4-17
SQL Worksheet, 4-15
starting, 3-10
Storage Manager, 4-15
Tcl scripts
User Manager, 6-8

Oracle Enterprise Manager configuration
creating a repository user account, 6-6
creating an NT user account, 6-8
starting Oracle Services, 6-6

Oracle Enterprise Manager SDK, defined, 2-9
Oracle Home Selector, 5-8
Oracle home, See multiple Oracle homes
Oracle Information Navigator, starting, 1-8
Oracle Installer

defined, 2-4
error messages, D-2

Oracle Intelligent Agent
communicating with the console, 4-7
overview, 6-3
responsibilities, 4-7
starting, 6-6

Oracle INTYPE File Assistant, defined, 2-9
Oracle LU6.2 Protocol Adapter, defined, 2-11, 2-12
Oracle Named Pipes Protocol Adapter, defined, 2-

10, 2-12
Oracle Net8 Assistant

starting, 3-13
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Oracle Net8 Easy Config, 6-2
starting, 3-13

Oracle Objects for OLE, defined, 2-8
Oracle Open Database Connectivity Driver, 2-7
Oracle products

configuration guidelines, 6-2
for Windows 3.1, 2-4
package definition files, 7-2
Systems Management Server support, 7-2

Oracle Replication Manager, defined, 2-9
Oracle Services

for Oracle8 database, 3-17
viewing in the Control Panel, 3-16

Oracle SPX Protocol Adapter, defined, 2-10, 2-12
Oracle Support Services

contact information, vii
Oracle TCP/IP Protocol Adapter, defined, 2-10, 2-

11
Oracle WebServer Manager, defined, 2-8
Oracle WebServer, installation sequence, 2-3
Oracle XA Library

additional documentation, 8-3
compiling and linking a Pro*C/C++ 

program, 8-2
compiling and linking an OCI program, 8-3
functions, 8-1
overview, 8-1

ORACLE_GROUP_NAME parameter, C-7, C-10
ORACLE_HOME parameter, C-7, C-10
ORACLE_HOME, explained, xix
ORACLE_HOME_NAME parameter, C-7, C-10
ORACLE_HOME_SERVICE parameter, C-7
ORACLE_PRIORITY parameter, C-8
ORACLE_SID parameter, C-8
Oracle7 ConText Option

defined, 2-7
Oracle7 ConText Option I/O Utility, defined, 2-6
Oracle7 ConText Option System Administration, 

defined, 2-6
Oracle7 ConText Option Viewer

defined, 2-6
Oracle7 ConText Option Viewer, defined, 2-6
Oracle7 ConText Option Workbench

defined, 2-6
Oracle7 Utilities

defined, 2-6
Oracle8

installable products, 2-3
new features, 2-2
new products, 2-2

Oracle8 ConText Cartridge
upgrading Oracle8 ConText Cartridge 

Workbench, 6-17
Oracle8 ConText Cartridge, configuration 

guidelines, 6-2
Oracle8 database

available Oracle Services, 3-17
error messages, D-4
operating system permission problems, F-3
specifications, B-7
transaction processing monitor, 8-1
using Control Panel, 3-16
using Event Viewer, 3-18
using Performance Monitor, 3-19
using User Manager, 3-23

Oracle8 Utilities
operating system compatibility, 3-2

ORACLE80 parameter, C-8
OracleAgent

starting, 6-6
ORADIM80

using, 3-15
OraTcl, using with database commands, 4-10
OS_AUTHENT_PREFIX parameter, B-5
OS_ERROR error message, D-3
OSD-04000 to OSD-04099 error codes, D-7
OSD-04100 to OSD-04199 error codes, D-12, D-14
OSD-04300 to OSD-04399 error codes, D-18
OSD-04400 to OSD-04499 error codes, D-18
OSD-04500 to OSD-04599 error codes, D-19
OTRACE73 parameter, C-8
OTT_DFLT parameter, C-8
OTT80 parameter, C-8
overview

managing and distributing Oracle software, 7-2
Oracle Enterprise Manager, 4-2

OWAST parameter, C-8
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P
package definition files, Oracle products, 7-2
packaged functions

Intercartridge Exchange, 8-5
UTL_HTTP.REQUEST, 8-5
UTL_HTTP.REQUEST_PIECES, 8-6

parameters
defined, C-2
registry, C-1

PARFILE, using, D-2
password file

registry variable, C-7
Password parameter, C-12
PATH, 5-7
PATH parameter, C-11
PERF_FILE_NAME parameter, C-14
PERFORMANCE key, C-12
Performance Monitor

defined, 3-19
integration with Oracle8 database, 3-19
monitoring specific Oracle events, 3-19
starting, 3-9

PERMISSION_DENIED error message, D-3
PLSQL23 parameter, C-8
PLSQL80 parameter, C-8
PLUS_DFLT parameter, C-9
PLUS80 parameter, C-9
PRAGMA RESTRICT_REFERENCES, with 

Intercartridge Exchange, 8-8
predefined event sets

with Job Scheduling System, 4-13
Pro*C/C++, compiling and linking, 8-2
PRO18 parameter, C-9
PRO80 parameter, C-9
proactive events management

Event Management System, 4-12
PROCESSES parameter, B-5

R
RDBMS73 parameter, C-9
RDBMS80 parameter, C-9
RDBMS80_ARCHIVE parameter, C-9
RDBMS80_CONTROL parameter, C-9

READ_ERROR error message, D-3
RECALIBRATION_FAILURE error message, D-3
registry

A2OWIZ80, C-6
adding parameters, C-17
ALL_HOMES subkey, C-11
API, C-6
API parameter, C-10
COMPANY_NAME, C-6, C-10
configuration parameters, C-1
CORE40, C-6
DEFAULT_HOME, C-11
DisplayName, C-14
EXECUTE_SQL, C-6
HOME_COUNTER, C-11
HOMEID naming convention, C-4
Hostname, C-13
ID, C-6, C-10
ImagePath, C-14
impact of multiple Oracle homes, C-3, C-4, C-5
keys, C-2
LAST_HOME, C-11
LOGFILE, C-14
modifying values, C-15
MS_HELP, C-6
MSHELP, C-6
NAME, C-11
NET80, C-6
NLS_LANG, C-6, C-10, C-11
NLSRTL32, C-6
NLSRTL33, C-6
ObjectName, C-14
OI_NLS32, C-6
ORA_EXTPROC_THREADED, C-6
ORA_NLS32, C-6
ORA_NLS33, C-6
ORA_SHUTDOWN, C-7
ORA_SHUTDOWN_TIMEOUT, C-7
ORA_SID_ SHUTDOWN, C-7
ORA_SID_PWFILE, C-7
ORA_SID_SHUTDOWN_TIMEOUT, C-7
ORACLE_GROUP_NAME, C-7, C-10
ORACLE_HOME, C-7, C-10
ORACLE_HOME_NAME, C-7, C-10
ORACLE_HOME_SERVICE, C-7
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ORACLE_PRIORITY, C-8
ORACLE_SID, C-8
ORACLE80, C-8
OTRACE73, C-8
OTT_DFLT, C-8
OTT80, C-8
OWAST, C-8
parameter values, C-2
Password, C-12
PATH, C-11
PERF_FILE_NAME, C-14
PERFORMANCE key, C-12
PLSQL23, C-8
PLSQL80, C-8
PLUS_DFLT, C-9
PLUS80, C-9
PRO18, C-9
PRO80, C-9
RDBMS73, C-9
RDBMS80, C-9
RDBMS80_ARCHIVE, C-9
RDBMS80_CONTROL, C-9
REG_DWORD, C-2, C-18
REG_EXPAND_SZ, C-2, C-18
REG_MULTI_SZ, C-2, C-18
REG_SZ, C-2, C-18
REGEDT32, C-15, C-17
SHARED_ORACLE_HOME, C-9, C-10
SQLPATH, C-9
starting, 3-10
SVRMGR, C-9
Username, C-12

Registry Editor, C-2
REMOTE_LOGIN_PASSWORDFILE parameter, B-

5
Replication Manager

ORA-23346 error, F-4
repository database

Oracle Enterprise Manager, 4-14
overview, 6-3
user account, 6-6

Required Support Files
version 7.3, 2-4
version 7.x, 2-5

resource costs

setting, B-8

S
scalability

Job Scheduling System, 4-11
with Job Scheduling System, 4-13

scheduling jobs, Oracle Enterprise Manager, 4-8
Schema Manager

capabilities, 4-16
starting, 3-12

scripts
location of, A-4

security
of Oracle Enterprise Manager, 4-14
with Job Scheduling System, 4-11
with Oracle Enterprise Manager, 4-14

Security Manager, 4-16
starting, 3-12

Server Manager
starting, 3-8

service discovery, Oracle Enterprise Manager, 4-8
services

available with Oracle8 database, 3-17
viewing in the Control Panel, 3-16

SHARED_ORACLE_HOME parameter, C-9, C-10
SHARED_POOL_SIZE parameter, B-5
SHARING_VIOLATION error message, D-3
SMS. See Systems Management Server
SNA, 2-11, 2-12
Software Manager, capabilities, 4-17
SORT_READ_FAC parameter, B-5
SORT_SPACEMAP_SIZES parameter, B-5
SQL scripts

location of, A-4
SQL Worksheet

capabilities, 4-15
starting, 3-12

SQL*Loader
control file conventions, 3-16
direct path option, 3-15
starting, 3-9
using, 3-15

SQL*Net
products, 2-11
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SQL*Net Client, defined, 2-11
SQL*Plus

defined, 2-8
operating system compatibility, 3-3
starting, 3-14

SQLPATH parameter, C-9
square brackets, defined, xviii
STARTUP command

using, F-3
Storage Manager, capabilities, 4-15
stored packages, Intercartridge Exchange, 8-5
SVRMGR parameter, C-9
symbols, list of, xx
System Network Architecture (SNA), 2-11, 2-12
Systems Management Server

capabilities
defined
distributing software, 7-3
Oracle product support, 7-2
package definition files, 7-2
products available for installation, 7-3

T
Tcl

including database commands, 4-10
scripts

TEMPORARY_TABLE_ LOCKS parameter, B-5
TKPROF

starting, 3-9
TOO_MANY_OPEN_FILES error message, D-3
Tool Command Language. See Tcl
transaction processing monitor

additional documentation, 8-3
interacting with Oracle8 database, 8-1
types, 8-1

TRANSACTIONS_PER_ ROLLBACK_ SEGMENT 
parameter, B-5

troubleshooting, vi
Intercartridge Exchange, 8-9
operating system permission problems, F-3
ORA-12203 error, F-2
ORA-12547 error, F-2
ORA-28575 error, F-2

U
U*.SQL, upgrading script, 2-2
unsolicited error detection, Job Scheduling 

System, 4-12
upgrading scripts

new names, 2-2
User Manager

defined, 3-23
for Oracle Enterprise Manager, 6-8
integration with Oracle8 database, 3-23
starting, 3-10

USER_DUMP_DEST parameter, B-5
Username parameter, C-12
UTL_HTTP.REQUEST, Intercartridge Exchange, 8-

5
UTL_HTTP.REQUEST_PIECES, Intercartridge 

Exchange, 8-6

V
variables, convention used, xviii
vsa@us.oracle.com, viii

W
web data, Intercartridge Exchange
Windows 95

DOS compatability mode, F-4
Windows NT

tools, 3-3
user account, 6-8

wizards
operating system compatibility, 3-3

WRITE_ERROR error message, D-3
WRITE_PROTECTED error message, D-4

X
XA. See Oracle XA Library
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